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Troubleshooting Appeon Install Appeon® for PowerBuilder® 2013 R2

1 Troubleshooting Appeon Install

This section contains information about general troubleshooting issues that might be
encountered when installing Appeon for PowerBuilder. If you cannot resolve your problem
with this troubleshooting guide, please contact technical support at http://www.appeon.com/

support.

1.1 InstallShield Errors

1.1.1 Error 1607 or 1628

On the Appeon installation menu, when clicking a component installation link that will
launch Install Shield, the following error may occur: "1607: Unable to install Install Shield
Scripting Runtime" or "1628: Failed to complete installation”.

Cause A: Thiserror often occursif you click "Install Appeon for PowerBuilder" on the
Appeon installation menu twice when the Appeon component installation program is already
running.

Solution A: Follow the steps below to fix the problem.

Step 1: Check how many installation processes are running. To do this, press Ctrl+Alt+Del
and select Task Manager. Go to the Processes tab in Windows Task Manager. Check whether
setup.exe is running and how many setup.exe processes are running.

Step 2: End all setup.exe processes and restart setup.exe. Do not run the Appeon component
installation program when the component installation program is already running.

Cause B: Thiserror may also occur if previously the Setup program has exited with
exception.

Solution B: Restart your computer and attempt to install again.

For more causes and solutions, please refer to http://consumer.installshield.com.

1.1.2 Error 1155
During Setup, the error 1155 occurs, "1155: File ..\Appeon\appeon5.0 not found".

Cause: Thiserror occurs because Appeon Setup failed to detect the 1SScript8.msi filethat is
used to install the Install Script engine.

Solution: Find the ISScript8.msi file in the directory \Install\AppeonComponent\ (for
example, \InstalN\ADT\) and double-click it to run the Install Script engine installer.

1.1.3 #DLL function call crashed# error when launching an Appeon setup
program

Cause: Thiserror is not caused by an Appeon installation program. It is often system-related.

Solution: Please go to the following Website and search for the error message. Detailed
information and solutions are provided: http://consumer.installshield.com/default.asp.
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1.2 Install Appeon Server to .NET IIS

1.2.1 1IS configuration

The I1S configuration may affect Appeon Server. Verify the |1S settings according to the 1S

version that Appeon Server isinstalled.

121.11S700r7.5

If Appeon Server isrunning on 11S7.0 or 7.5, verify the NET Trust Levelsis set to Full
(internal) for AEM, Appeon, and Servlet views respectively in [1S Manager. Following is an
example of how to verify the NET Trust Levelsfor AEM view, you can follow the similar

steps to verify for Appeon view and Servlet view.

Step 1: Open |1S Manager, click Web Sites > DefaultWebSite > AEM, and double click

.NET Trust Levels.

Figure1.1: .NET Trust Levels
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Step 2: Verify that Full (internal) is selected.
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Figure 1.2: Full (internal)
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1.2.1.211S 6.0

If Appeon Server isrunning on 11S 6.0, verify the following I1S settings after the Appeon
Server installation:

Step 1: Verify that the running mode of 11S is Worker Process | solation Mode.
* Open IS Manager, right click Web Sites and select Properties.

* Inthe Web Sites Properties window, select the Service tab, and make sure the "Run
WWW servicein 11S 5.0 isolation mode" option is not selected.
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Figure 1.3: Service
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Step 2: In Web Service Extensions, verify that ASP.NET v4.0.30319 is set to Allowed.
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Figure 1.4: Web Service Extensions

W Internet Information Services (IIS) Manager M= E|
¥9 Fle aAction Wew indow Help | =] |

5 | anFRE 22| =0

P_J Internet Information Services
E| I TESTWINL13 {local computer)

----- _| Web Service Extensions

@ Web Service Extensions

I prohibit all web service extensions

_..J FTR .Site.s £ I ‘Web Service Extension | Skatus |
El-—J Tﬂlplpllcatlon Pools “@ Al Unknown I Extensions Allowed
B D{?:Faultfnp::Poolr ] Al " All Unknown ISAPT Extensions llawed
v‘f’ Default Application — [38 Active Server Pages Allcwed
7‘{" AEM Prohibit U p— alloved
et by Sepylet - et . —
) Wel;g:tes Properties @ Internet Data Connector Allowed
Eg Defaulk Web Site % Ser;er Side Includes n::owej
Ll WebDal Al
[#] ‘f’ AEM Tasks
-4 Servlet
[ __| appeon
E_J appean_code_examplesAX | I add 5 new Web service extension...
(- ) aspnet_client
Bl ph9 1 allow ll vweb service extensions for a
(- sales_application_demods specific application...

@ Dpen Help

Extended A Standard /

Step 3: Verify that the ASP.NET version of the AEM, Servlet, and Appeon virtual directories
is4.0.

The Appeon virtual directory is automatically configured during the Appeon Server
installation.

Follow instructions below to check the ASP.NET version of the Servlet virtual directory. The
steps to check the AEM virtual directory are similar.

* Right click Servlet under the Web site and select Properties.

* Intheservlet Properties window, select the ASP.NET tab and check the ASP.NET
version setting.
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Figure 1.5: ASP.NET

servlet Properties EHE |
Wirtual Directory I Dacuments I Directory Security |
HTTP Headers I Custom Errars ASP.MET

AP NET versn: foo W
Yirtual path: I,l'servlel:

File location: IF:'I,P.EM'I,WEI::.::DnFig
File creation date; |2EIIIIEu-Eu-22 14:08:;08
File last modified: |e005-7-24 11:43:26

Edit Configuration. .. |

(o] 4 I Cancel | apply | Help |

Step 4: Verify the application pool settings of AppeonA ppPool for Appeon Server. By
default, AppeonAppPool is automatically configured during the Appeon Server installation.
It is not recommended to change the default settings.

During the runtime of an application, information such as user sessions and database
transaction will be stored in the memory. If Appeon Server is restarted, the information will
be lost, which resultsin the failure of the application. Besides that, in order to guarantee the
completeness of the information, Appeon Server cannot be run in multiple processes. Follow
steps below to configure the application pool for Appeon Server:

* Right click AppeonAppPool and select Properties.

* Inthe AppeonAppPool Properties window, make sure the following settings are not
selected in the Recycling tab.
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Figure 1.6: Recycling

AppeonAppPool Properties |

Recycling IF‘erFDrmance I Health I Idenkity I

[ Recycle worker processes (in minukes): - 120
[ Recydle worker process (number of requests): E 35000

[~ Recvele worker processes at the Follawing kimes:

fdd. .,
Eemaove, ..

Edit. ..

il

- Memory recyoling
Recycle warker process after consuming koo much memaorys

™ Maximum wirtual memaory (in megabytes): B =00

™ Maximum used memaory {in megabytes): 19z

Ik I Zancel Apply | Help |

» Select the Performance tab. Verify that the Idle timeout setting is not selected, and the
Web garden valueis set to 1.
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Figure 1.7: Performance

AppeonAppPool Properties |

Recycing Performance IHeaIth I Identity I

Idle timeout
r Shutdown worker processes after being idle Far

ikirne in minutes):

20

—Request queue limit
[ Limit the kernel request queue fnumber of requestsi:

E, 2000

—I Enable CPU monitoring

Maxirmum CPU use (percentage):

Refresh CPU usage numbers (in minukes);

Action performed when CPU usage exceeds maximum CPU use;

IND ackian

—Web garden

Maxirurm number of worker processes:

=y

Ik I Zancel Apply

Help

» Select the Health tab. Verify that the Enable pinging and Enable rapid-fail protection

settings are not selected.
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Figure 1.8: Health

AppeonAppPool Properties |

Recyclingl Performance  Health |I|:|entit';.f I

Ping worker process every (frequency in seconds):

—I " Enable rapid-Fail protection

Failures within a specified time period,

Eailures;

Time petiod (time in minutes):

Disable the application pool if there are a certain number of worker process

1]

—Startup kime limit

Wi'orker process must starkup within (hime in seconds);

Q0

— Shutdown kime limit

‘i'orker process must shukdown within (time in seconds):

Q0

I

Zancel

Apply

Step 5: Verify the Web site properties.

» Right click the Web site where Appeon Server isinstalled, and select Properties.

* Inthe Web site properties window, select the Home Directory tab. Verify that the
Execute permissionsis set to " Scripts only" or "None" (not " Scripts and Executables”).
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Figure 1.9: Home directory

Default Web Site Properties [ 2] |

Direckary Securiky I HTTP Headers I Zuskorn Errors

wehsite | Performance | ISAPIFikers | Home Directory ||  Documents

The content For this resource should come From:
{* 4 directory located on this computer
" 4 share located on another computer
" A redirection to a URL

ASP.MET

[ Script source access ¥ Log visits
v pead [¥ Indesx this resource
[ write

[T Directory browsing

Local path: Ic:'l,inetpul:u'l,wwwru:u:ut Browse. .. |

Application setkings

Execute permissions: IScripts anly j

Application name: IDeFauIt application Remove |
Skarking poink: <Defaulk Web Sike =

Configuration. , . |
Application pool: IDeFault.ﬁ.ppF'DDI - I Unload |

kK, I Zancel | Spply

Help |

1.2.2 Full access rights to IS Web root

Follow steps below to check if 11S_ITUSRS account is granted with full controlsto the I1S

Web root folder:

Step 1: Right click C:\Inetpub\wwwroot and select Properties from the popup menu.

Step 2: On the Security tab, select IS USRS in the Group or user names list box, and
then check if Allow is selected for Full control inthe Permissionsfor 1S TUSRSlist box.
If not, click the Edit button and follow Step 3 to grant full control.
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Figure 1.10: Security

P

| - wwwroot Properties

| General | Sharing | Securty | Previous Versions I Custurnize|

Object name:  Clinetpubswwwroot

Group or user nameas:
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-

To change pemissions, click Edit.
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Full control

Modify

Read & execute
List folder contents
Read

Write

LSRN N N A

For special pemissions or advanced settings,

click Advanced. fchvea

Leam about access control and pemissions

I 1 m | »

| ok || Ccancel |

Apply

Step 3: Select 11S_IUSRS in the Group or user names list box, and then select the Allow
check box for Full control. Click OK to save the settings.
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Figure 1.11: Grant full control

*

. Permissions for wwwroot @

Security

Object name:  Clinetpubswwwroot

Group or user nameas:
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52 5YSTEM
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[ OK J[ Cancel ] Apply

1.2.3 Enable 32-bit .NET framework on 64-bit Windows

If you have installed a 32-bit Appeon Server on a 64-bit Windows operating system, and
Appeon Server is not working properly, it is probably the 32-bit .NET framework is not
configured successfully by the Appeon Server setup program. Y ou may need to manually do
the following configuration to enable it.

123.11IS7.00r 7.5

Step 1: Launch 11S Manager, expand the local computer, click Application Poolsin the left
pane, right-click Application Poolsin the right pane, and then click Advanced Settings....
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Figure 1.12: Application pools
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Step 2: In the Advanced Settings window, set the Enable 32-Bit Applicationsto True.

Click OK.
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Figure 1.13: Advanced settings

i =
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operating systern, the worker process(es) serving the application poal will
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]4 ‘ I Cancel

1.23.211S6.0

Step 1: In the command prompt, go to the installation path of the .NET Framework where
Appeon Server installs, for example C:\WINDOWS\Microsoft. NET\Framework\v4.0.30319.

Step 2: Execute the following command. The 32-bit Application pool is successfully enabled
if the Enable32BitAppOnWin64 is shown as True.

cscript.exe C:./inetpub/Adm nScri pts/adsutil.vbs set
WBSVC/ AppPool s/ Enabl e32Bi t AppOnW n64 "true"
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Figure 1.14: Execute the command
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Step 3: Type the following command to install the version of ASP.NET and to install the
script maps at the 11S root and under:

YUSYSTEMROOT% M cr osof t . NET\ Fr anewor k\ v4. 0. 30319\ aspnet _regiis. exe -i

Step 4: Make sure the status of ASP.NET version v4.0.30319 (32-hit) is set to Allowed in the
Web service extension list in 1S Manager. For details, refer to 11S 6.0 configuration.

1.3 Install Appeon Server to EAServer

1.3.1 EAServer cannot be started after Appeon Server install

Cause: There are two sets of EAServer 6.1/6.2 installed; one EAServer wasinstalled
independently in the normal installation path, and the other was silently installed with
Appeon Server installation.

Solution: It is recommended that you use the EAServer that was silently installed with
Appeon Server.

Step 1: Open the setenv.bat file in the bin folder under the EAServer installation directory in
atext editor and make sure JAGUAR_HOST_NAME in thefile is the same as the computer
name.

Step 2: Verify that EAServer isnot started as a Service. If it is started as a service, stop it and
change the starting mode to "Manual”.

Step 3: If EAServer runs on Windows, start EAServer from Windows Start > Programs >
Appeon for Power Builder 2013 R2 > Appeon Server > InstanceName. If EAServer runs
on UNIX, run the appeonserverstart.sh script in the $JAGUAR/appeon/bin directory.
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1.4 Install Appeon File Server

1.4.1 Appeon File Server Installation Incomplete

Cause: The Appeon File Server installer was interrupted before Appeon File Server could be
installed, as shown in the following figure.

Figure 1.15: Installation incomplete

iz Appeon File Server

Installation Incomplete

The inztaller waz interrupted before Appeon File Server could be installed. “'ou need to restart the
inztaller bo top again.

Click "Cloze'"" to exit.

Solution A: Restart the installer and try again.
Solution B: Configure I1S 6 Management Compatibility.

Goto Control Panel > Administrator Tools> Server Manager > Roles>Web Server.
Expand the Role Service node in the right pane, and then select 11S 6 M anagement
Compatibility.

Note: Solution B is based on Windows 2008 R2 Standard operation system in this
troubleshooting guide. Path may differ from different versions of operation system.

1.5 Install Appeon Server Web Component

1.5.1 Third-party Web Server problems with the SAP Sybase redirector plug-in

If you use athird-party Web server such as Apache or 11S, you may find that the SAP Sybase
redirector plug-in does not work for the Web server.

Cause: It isvery likely that a step has been omitted during the configuration of the third-
party Web server or the plug-in.

Solution: Follow the troubleshooting instructions provided by SAP Sybase at http://
www.Ssybase.com/detail 21d=1024955 or refer to the EAServer System Administration Guide.

1.6 Upgrade Installation

1.6.1 #Bad interpreter: No such file or directory# error

When you execute install.sh or upgrade.sh on a Unix/Linux system, the error "Bad
interpreter: No such file or directory” comes up.

Cause A: Theinstallation package is uploaded to the Unix/Linux system in the non-binary
transfer type.

Solution A: Select to transfer the installation package to the Unix/Linux machine in Binary
transfer type.
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Cause B: The SH file was edited and saved on a Windows machine.

Solution B: Execute the command dos2unix install.sh/upgrade.sh on the Unix/Linux system,
which can convert the file type so as to make it work on the Unix/Linux system.

1.6.2 Error 14004 #The license file is missing#
Error 14004 saying "The license fileismissing" occurs when upgrading the Appeon Server.

Cause: Thisissue only existsin Appeon 6.5.1 for .NET or earlier versions. When there are
server instances installed before, the server instances will not be upgraded during the upgrade
process.

Solution: Use the Appeon Server Instance Configuration Wizard to delete all installed
instances from the Appeon Server and then re-install these instances. See Appeon Installation
Guide for detailed instructions.

1.7 Frequently Asked Questions

1.7.1 How to install Appeon Server to multiple EAServer instances?

During the Appeon Server installation, you can only install Appeon Server to one EA Server
instance. However, after the installation, you can manually install Appeon Server to other
instances using EA Server Manager:

1. Under EAServer Manager, select Servers> server instance (for example, "server2") >
Installed Applications, right click it and select I nstall Application from the popup menu.
The Application Wizard launches.

2. Click Install an Existing Application.

3. Onthelnstall Applicationsdialog, select "AppeonServer" and click OK.

1.7.2 How to bind server instance to CPU?

Appeon Server installation program will not bind the instance to CPU. Y ou must manually
bind it with the following steps:

Open Windows Task Manager, select the Processes tab, select the server process, such as
jagsrv.exe, right click it and select Set Affinity from the popup menu to bind the processto
one or more CPU.

Or you can use the Appeon Server Status Monitor to automatically bind the server instance to
CPU using the "com.appeon.server.monitor.instance.cpus' setting. For detailed instructions,
refer to the Section 3.2, “Configuring Status Monitor” in Appeon Server Configuration Guide
for J2EE.

1.7.3 How to create EAServer instances?

For detailed instructions, refer to the EAServer document at http://infocenter.sybase.com/
help/index.jsp. Select EAServer 5.3 > System Administration Guide > Creating and
Configuring Servers.

Below are the general steps:
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1. Under EAServer Manager, select Servers, right click it and select New Server from the
popup menu. The New Server dialog opens.

2. Input the server name, for example, server2, and click Create New Server. Click OK to
close the Server Properties window.

3. Create HTTP and 11 OP listener for the new instance: Select Servers> server instance (for
example, "server2") > Listener, right click it and select New Listener. Input the listener
name, and click Create New Listener. Specify the protocol, port and host for the new
listener.

1.7.4 How to start the server instance?
Use the following command: serverstart.bat -jdk14 -jvmtype server -servername

For detailed instructions, refer to the EA Server document at http://infocenter.sybase.com/
help/index.jsp. Select EAServer 5.3 > System Administration Guide > Creating and
Configuring Servers> Starting the server.

1.7.5 How much better is the performance when multiple instances are used?

Multi-instance scenario supports concurrent users by multiple times when the number of
serversis the same and provides much better performance when the number of concurrent
usersisthe same. Our tests on a customer project with 100 concurrent users show that the
average response time for two instances binding to two CPUs is eight times faster than that
for single instance binding to single CPU.
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2 Troubleshooting Appeon Developer

This section deals with troubleshooting issues in Appeon Developer. If you cannot resolve
your problem with this troubleshooting guide, contact technical support. For technical
support information, visit http://www.appeon.com/support.

2.1 Operating Appeon Developer toolbar

2.1.1 Appeon Developer toolbar does not respond when run by a non-
administrator

When UAC ison, if you run PowerBuilder under a non-administrator login account the first
time after you install Appeon Developer or register the Appeon Developer toolbar (by using
the ADT Register tool), the Appeon Developer toolbar does not respond when you click it in
PowerBuilder. And when you exit PowerBuilder, you will be prompted with the following
dialog box, and then when you open PowerBuilder again, the Appeon Developer toolbar
works normally.

Figure 2.1: Program Compatibility Assistant

[+-| Program C_u_::m patibility Assistant

Windows detected that this program did not run
correctly

o
R

To try and fix the problem, Windows has applied compatibility
settings to this program. Windows will use these settings the next
time you run the program.

If you noticed that this program didn't run correctly, try running
the program again.

= Prograrm: Sybase PowerBuilder 11.5
B Publisher: Sybase Inc.
' Location: D:Program Files\Sybase\Pow.. \PB115.EXE

Close

.{j. What settings are applied?

Solution A: Run PowerBuilder in the "Run as administrator” mode. After the first time, you
can run PowerBuilder in the normal mode.

Solution B: Choose Windows Start > All Programs > Appeon for Power Builder 2013 R2
> Appeon Developer > Appeon T ool set.

Solution C: Exit PowerBuilder and run it again. The Appeon Developer toolbar works
normally except for the first time. Note that this solution does not work on Windows 8.

2.1.2 #ADT is already running# error

If you immediately click an Appeon Developer toolbar icon after canceling the processing of
the deployment wizard, an "ADT isaready running" error message pops up.
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Cause: The Appeon Developer execution program EonADT50.exe is not promptly killed
when the Cancel button is clicked.

Solution: Wait a minute, and then click the toolbar icon.

2.1.3 Exiting Appeon Developer completely after an error

When an error occurs during an operation in Appeon Developer, you may want to exit
Appeon Developer completely before restarting the operation.

Solution: Kill al of the following execution filesin the task manager: EonADT61.exe,
EonCI S60.exe, EonADeploy60.exe, EonDWSQL 80J.exe (or EonDWSQL 90J.exe, or
EonDWSQL 100J.exe, orEonDWSQL 110J.exe), EonDWSQL 80.exe (or EonDWSQL 90.exe,
or EonDWSQL 100.exe, or EonDWSQL 110.exe), EonPerReport60.exe, Eoninfomng60.exe,
EonJsL og60.exe, screnc.exe and EonUFAT ool 60.exe.

2.1.4 Windows XP SP2 critical update makes Appeon Developer not start

Appeon Developer may not start after you install security update 925902 (M S07-017) and
security update 928843 (M S07-008) on a computer that is running Microsoft Windows XP
with Service Pack 2 (SP2). Additionally, you may receive an error message that resembles
the following:

application_executable_name - Illegal System DLL Relocation

The system DLL user32.dll was relocated in memory. The application will not run properly.
The relocation occurred because the DLL C:\Windows\System32\Hhctrl.ocx occupied an
address range reserved for Windows system DLLs. The vendor supplying the DLL should be
contacted for anew DLL.

Cause: Windows X P SP2 auto-update changes some system DLLs, which causes many
software products, including Appeon Developer, failed to run.

Solution: To solve this problem, please follow the next steps which are provided on
Microsoft Web site.

1. Install al important updates from the following Microsoft Web site: http://
update.microsoft.com/microsoftupdate/.

2. Try to run the program that did not start again. If the program starts and if you do not
receive the error message in the " Symptoms of the problem™ section, you are finished. If the
error continues, follow steps 3 through 5.

3. Visit the following Microsoft Web site: _http://www.microsoft.com/downloads/
details.aspx?familyid=74AD4188-3131-429C-8FCB-F7B3B0OFD3D86& displaylang=en.

4. Click Download, and then click Run. If the Download button is not available, you must
first click Validate to validate your copy of Windows.

5. Follow the instructions that appear on the screen to install update 935448.
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2.2 Appeon Developer Configuration

2.2.1 Testing connection fails during DB Type Profile configuration

In Appeon Developer Configuration, when creating or modifying a DB Type profile

after specifying an Oracle database as the data source for the DB Type profile, testing the
connection will fail for the profile. However, the data source can be successfully connected in
the ODBC Data Source Administrator.

Cause: The ODBC driver used for the data source is not a dedicated driver for connecting to
an Oracle database.

Solution: Use either of these drivers for connecting to an Oracle database: Oraclein
OraHome920 or Microsoft ODBC for Oracle.

2.2.2 #Error launching LoadConfig#

The "Error launching LoadConfig" message is displayed when the user changes the settings
in Appeon Developer Configuration or performs Task 2 of Appeon Deployment Wizard.

Cause & Solution: Refer to "Error launching LoadConfig".

2.3 Feature Analysis

2.3.1 #The XML page cannot be displayed# when opening a UFA report

When a UFA report is opened in Internet Explorer, the page displays an error message "the
XML page cannot be displayed”. The page also gives the following description in bold
"Microsoft JScript runtime error Automation server cannot create object”.

Cause A: The Internet Explorer used to open the UFA report isversion 5.5 or earlier.
Solution A: Upgrade to the Appeon-certified Internet Explorer version: Internet Explorer 6.0.

Cause B: The version of Internet Explorer is 6.0 SP2, which by default does not allow active
content to run.

Solution B: Go to Internet Options > Security in Internet Explorer, make sure the option
"Allow active content to run in files on My Computer” is enabled.

2.3.2 #Error loading ADTODbjectList.xml#

After Feature Analysis starts, it hangs and the following error message is displayed in the
analysis status window: "Error loading ADTODbjectList.xml". However, upon verification,
the ADTObjectList.xml file exists in the folder: \Appeon\Devel oper2013R2\Project
\ApplicationName (indicating the application profile name)\Debug (or Release).

Solution: Delete the entire folder. Run the Feature Analysis again.

2.3.3 #Error loading command string#

While running Features Analysis, or Appeon Deployment, an error message box pops up and
displays "Error loading command string".
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Cause: Thiserror typically occurs when the DataWindow syntax is not in the expected
PowerBuilder 9 or later format.

» The application has not been built or upgraded with PowerBuilder 9 or later.

» When the application is upgraded with a higher PowerBuilder version, some "old" syntax
may still be included. Thisis because PowerBuilder provides backwards compatibility, but
Appeon may not support the "old" syntax.

Solution A: Follow the steps below to fix the problem.

Step 1: Verify that no unsupported identifiers are used in the application.

Step 2: Remove or modify the problematic object(s) that contains "old" syntax from the
PowerBuilder application by following the instructions in How to |ocate problematic objects
in an application.

Step 3: Terminate Appeon Developer. Terminate the EONADT62.exe process if they are still
running in the Windows Task Manager.

Step 4: Run Feature Analysis/Appeon Deployment again.
Solution B: Try the following stepsiif the problem is not resolved using Solution A.
Step 1: Delete the application profile in Appeon Developer Configuration.

Step 2: Delete the entire application folder under the Appeon Developer installation
directory: \Appeon\Devel oper2013R2\Project \A pplicationName (indicating the application
profile name).

Step 3: Terminate the EonNADT62.exe processes if they are still running in Windows Task
Manager.

Step 4: Recreate the application profile in Appeon Developer Configuration.

Step 5: Perform the desired Appeon function (Feature Analysis/Appeon Deployment) on the
application profile again.
Solution C: If the problem is not resolved with Solution B, try the following steps.

Step 1: Uninstall Appeon Developer from Windows Control Panel > Add/Remove programs,
or run the Uninstall program.

Step 2: Delete the entire Appeon Devel oper folder where Appeon Developer isinstalled, for
example, C:\Program Files\A ppeon\Devel oper2013R2.

Step 3: Reinstall Appeon Developer and reconfigure Appeon Developer's settings in Appeon
Developer Configuration, such as the application profiles, server profiles and deployment
profiles.

Step 4: Set the transaction object mapping to the correct data sources for the application in
AEM > Application > Transactions > Transaction Objects.

Step 5: Verify that Appeon Server (EA Server extended with Appeon Server components) is
running and accepting connections.

Step 6: Perform the desired Appeon function (Feature Analysis/ Appeon Deployment) on the
application profile again.
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2.3.4 Feature analysis or deployment comes to a standstill

During Unsupported Feature Analysis or Task 2 of the Appeon Deployment Wizard, the
user can see the "Start searching for related objects..." message normally displayed in the
status window. However, the program does not proceed. The EonADT50.exe processis still
running in the Windows Task Manager.

Cause: One or more of the Appeon Developer configuration files may have become corrupt.
Solution: Follow the steps below to fix the problem.

Step 1: End the EonADT50.exe process using Windows Task Manager.

Step 2: Delete all Appeon-generated application files on both the Appeon Developer machine
and the Web Server.

* On the Appeon Developer machine, delete all filesin the directory: \Appeon
\Devel oper2013R2\Project\ApplicationName.

* Onthe Web Server, delete adl filesin the application's deployment path (specified
in Appeon Developer Configuration > Application Profiles > ApplicationName >
Application Profile Configuration > Basic Settings).

Step 3: Configure the Transaction Objects for the application in AEM Console >
Application > Transactions > Transaction Objects.
Step 4: Run Feature Analysis or Appeon Deployment again.

2.3.5 #This application has requested the Runtime to terminate it in an unusual
way# error, when you deploy or analyze an application

When deploying or analyzing an application, you will receive a system runtime error message
"this application has requested the Runtime to terminate it in an unusual way".

Cause: Thisis often caused by limited hard drive space.
Solution: Clean up the hard drive space to successfully run Appeon.

2.3.6 #Error opening DLL Library adtxml.dll for external function# Error

The application analysis stops and an error occurs. The error message displayed is "Error
opening DLL Library adtxml.dll for external function”

Cause: Selecting the native interface option when you configure the DB type profile in
Appeon Application configuration window.

Solution: To solve the problem, reinstall the Appeon Developer.

2.4 Appeon Debugger
Solutions for the following Appeon Debugger problems:

o "Script Debugger Component Not Found" error

* "Component Not Registered" error

» "Script Debugger Disabled" error
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2.4.1 #Script Debugger Component Not Found# error

When clicking the Appeon Debugger button on the Appeon Developer toolbar, the " Script
Debugger Component Not Found" error occurs.

Cause: Appeon Debugger requires Microsoft script debugger to be installed, but no
Microsoft script debugger isinstalled on the computer.

Solution: Verify that script debugger isinstalled. If you do not have any script debugger
installed, choose an appropriate one at Microsoft Website.

2.4.2 #Component Not Registered# error

When clicking the Appeon Debugger button on the Appeon Developer toolbar, the
"Component Not Registered" error occurs.

Cause: Appeon Debugger needs to use Microsoft script debugger. However, although
Microsoft script debugger has been installed, the required components are not registered.

Solution: Reinstall the Microsoft script debugger.

2.4.3 #Script Debugger Disabled# error

When clicking the Appeon Debugger button on the Appeon Developer toolbar, the " Script
Debugger Disabled" error occurs.

Cause: Appeon Debugger needs to use Microsoft script debugger. However, although
Microsoft script debugger is available to use, script debugging is disabled in Internet
Explorer.

Solution: Enable script debugging in Internet Explorer: Go to I nternet Options > Advanced
in Internet Explorer, de-select the option under Browsing: "Disable script debugging” in
Windows 2000 and 2003, or "Disable Script Debugging (Internet Explorer)" in Windows XP.
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3 Troubleshooting Web Deployment

This section contains information about general troubleshooting issues related to Appeon
Web application deployment. If you cannot resolve the problem with this troubleshooting
guide, please contact technical support at http://www.appeon.com/support.

3.1 Deployment Performance

3.1.1 Unusual deployment duration

In some cases, you may find that the deployment of an application takes longer than you
expected.

Cause: The application has not been fully built in PowerBuilder before Web deployment.

Solution: Perform a"full build" for the application, and then deploy it using the Appeon
Deployment Wizard.

3.2 Failed to deploy applications

Y ou may encounter a deployment failure and an error occurred saying Failed to generate
DWSQL in the Log of Deployment Wizard, as shown in the figure below.

Figure 3.1: Failed to deploy applications

o Favoritos (& The Log of Deployment Wizerd | | -8

# Pars ayudar & proteger su segunidad, Internet Explorer impidid que esta paging web ejecutans sopts o controles ActiveX que podrian cbitener 8cceso 8l equipo. Hagh dic Squl pars viEr OpGones. ..

The Log of Deployment Wizard

Application Name: tesoreria_desarrollo

Log Option: Summary mode

Log Startup Time: 2012-06-20 10:03:11

Log File Location: C:\Program Files\Appeon\Developert.3\Projectitesoreria_desarrollo\release\L 0G\DeployWizardLog_20120620100311.xml

Time Content

€@ 10:03:25 Failedto generate DWSQL

Cause: Thisis probably caused by using an earlier PowerBuilder version.
Solution:

Step 1: Upgrade your PowerBuilder to the latest PowerBuilder version. For example, if you
are using a PowerBuilder 10.5, then upgrade it to the latest PowerBuilder 10.5 version.

Step 2: Test to ensure that the Database Connection in Appeon Developer Configuration >
DB Type Profilesis successful.

Step 3: (Recommended) Full build your PowerBuilder application.

Step 4: Go to \%Devel oper%\Project\your_application\rel ease or debug\dwsgl\dwsgl.log to
get the last record, empty compiled this Datawindow in PowerBuilder (Add a character and
delete this character in the edit source of PB).

Step 5: Deploy your application again.
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3.3 Failed to deploy applications in server console

When deploying an application (such as the Appeon Web application or Appeon file service)
in the server console (such as WebL ogic, WebSphere, JEUS etc.), sometimes you receive an
error message, similar to the message below thrown by WebSphere 7 console:

Messages
The EAR file could be corrupt and/or inconplete. Make sure that the application is
at a conpatible Java(TM
Platform Enterprise Edition (Java EE) |evel for the current version of
WebSpher e(R)
Application Server.
com i bm webspher e. managenent . appl i cati on. cli ent. AppDepl oynent Excepti on:
[ Root exception
is org.eclipse.jst.j2ee.compnarchi vecore.internal.exception. SaveFai |l ureExcepti on:
appl i cation. ht nj

Cause: the WAR/EAR/JAR file compressed via one tool cannot be successfully de-
compressed by the other tool during deployment process in the server console.

Solution A: Use Winzip or WinRAR to compress the files again if Winzip or WinRAR is
installed. Detailed steps are below:

Step 1: Go to the Web root path that you specified in Web Server Profile Configuration
windows in Appeon Developer Config tool.

Step 2: Find the WAR file of the Web application, for example, appeondemo.war.
Step 3: Extract the WAR file to any folder, for example, to C:\appeondemo.

Step 4: Compress al the filesin the folder to a WAR file again with the same WAR name
(appeondemo.war). Compression tools such as Winzip and WinRAR are recommended,
please use the tool and zip the files with default settings. Tools such as 7-Zip are not
supported, please do not use the tool.

Step 5: Manually deploy the WAR filein the server console again.

Solution B: Use JDK to compress the filesagain if JDK isinstalled. Detailed steps are
below:

Step 1: Go to the Web root path that you specified in Web Server Profile Configuration
windows in Appeon Developer Config tool.

Step 2: Find the WAR file of the Web application, for example, appeondemo.war.
Step 3: Extract the WAR file to any folder, for example, to C:\appeondemo.

Step 4: Compress al thefilesin the folder to a WAR file again with the same name
(appeondemo.war) by using the following commands:

cd C \appeondeno
C.\Program Fi | es\Java\j dkl.5.0_15\j ava. exe jar —cvf appeondeno.war *.*

Step 5: Manually deploy the WAR file in the server console again.
Solution C:

If you are deploying the Appeon Web application (not the Appeon file service), then you
could also use an Appeon Developer feature to compressfiles via JDK (prerequisiteis that
JDK isinstalled on the Appeon Devel oper machine):
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Step 1: Open the Web Server Profile Configuration window from the Appeon Devel oper
Config tool, in the File Compression Settings for War/Jar group box, select "JDK
Compression” and specify the JDK path. Thiswill enable Appeon Deploy tool to compress
files by using JDK on the Appeon Devel oper machine.

Step 2: Deploy the application via the Appeon Deploy tool. The WAR/EAR/JAR file
compressed via JDK on the devel oper machine should be successfully de-compressed by
JDK on the server machine.

3.4 Failed to deploy Web applications in 64-bit JEUS server

A file parsing error occurs in 64-bit JEUS server console when deploying the Appeon6.5-
deployed-Web applications.

Cause: The application configuration file web.xml cannot be parsed by JEUS.

Solution: Step 1: Go to the Web root path that you specified in Web Server Profile
Configuration windows in Appeon Developer Config tool.

Step 2: Find the WAR file of the Web application, find the folder "WEB-INF" and extract
web.xml.

Step 3: Modify the following line in web.xml:

<web- app version="2.4" xm ns="http://java. sun. com xni / ns/ j 2ee" >

To

<web- app version="2.5" xm ns="http://]java.sun. con xn / ns/j avaee" >

Step 4: Use the modified web.xml file to replace the old one under "WEB-INF" folder.
Step 5: Manually or automatically deploy the WAR filein JEUS console again.

3.5 Task 1: Application Source Code Export

3.5.1 Source Code Export process aborts with a fatal error

Task 1 (Application Source Code Export) is aborted with afatal error "The memory cannot
be"read"", or "Failurein exporting XML file".

Cause: Thefatal error occurs when the PowerBuilder source code contains corrupt
object(s) that cannot be opened in PowerBuilder, or object(s) that are not fully upgraded to
PowerBuilder 9 or later format.

Solution: Remove or modify the problematic object(s) from the PowerBuilder application
by following the instructions in How to |ocate problematic objects in an application, and
perform the Application Source Code Export again.

3.5.2 How to locate problematic objects in an application

When trying to locate problematic objectsin an application, the key isto find which PBL
contains the problematic object(s), and then check the objectsin the PBL.

Step 1: In Appeon Developer application profile settings, specify the PBL that contains the
Application object in the application PBL list, and then perform Application Source Code
Export.
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Note: Only one PBL is specified in the PBL list in this step.

If Source Code Export produces afatal error, it means that the PBL specified contains
problematic object(s). Go to Step 3 for checking the objectsin the PBL.

If the Source Code Export is successful, go to Step 2.

Step 2: In the Appeon Developer application profile settings, add one PBL to the PBL ligt,
and perform Application Source Code Export.

If the Source Code Export produces afatal error, it means that the PBL that was newly added
contains problematic object(s). Go to Step 3 for checking the objectsin the PBL.

If the Source Code Export is successful, repeat Step 2 until the PBL that contains problematic
object(s) is found.

Step 3: (Supposing the PBL that contains problematic object(s) isPBL A) In the
PowerBuilder application, back up PBL A. The backup PBL is PBL B.

Step 4: Remove all the objects from PBL A.

Step 5: Add one of the objectsin PBL B to PBL A. Perform the Application Source Code
Export.

If the Source Code Export produces afatal error, it means that the object that was newly
added is problematic.

If the Source Code Export is successful, repeat Step 5 till the problematic object is found.

3.5.3 #Error: Failure in exporting XML file#

Task 1 (Application Source Code Export) is aborted when the error “Failure in exporting
XML file" occurs.

Figure 3.2: Failurein exporting XML files

=i Appeon Weh Application Deployment Wizard - appeon_acl_denma

Deployment Task Status

Deployment Task Statuz Time
Tazk 1: Application Source Code Export Abaoit

Task & Wweb File Generstion

Tazk 3 Wwieb Deployment

— Impotant Infomstion
Flease do not modity the appicabon PEL: during tazk 1.

Time | Application Expoit Status |
120114 Ewpetliveg =ML files...
120114 Geling list of abjects fom PEL filss...
120116 Updating hle ADT_ObectList xml
120118 Begn expoting M1 fike used by spofication
120198 INGile exported successhdly,
120118 Wou need to configurs the OB connechion frst betone deployng the application,
120118 Eron Failre in exporting #ML fie.

OBLELEt

View Log !
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Cause A: Thiserror will occur when no database profiles for this application has been
configured in Appeon Developer Configuration > Application Profiles > ApplicationName
> Application Profile Configuration >DB Type.

Solution A: Follow the instructionsin Appeon Developer User Guide to configure the
database type profiles and perform “Full Deployment” on the application with the Appeon
Deployment Wizard.

Cause B & Solution B: Refer to Source Code Export process aborts with afatal error.

3.5.4 Warning 61537

During Task 1 (Application Source Code Export), awarning message is displayed in the
status box, "61537: Unable to get object [object name]'s PB source code...".

Check whether this object existsin the PBL of the PowerBuilder application. If the object
does not exist, refer to Cause A and Solution A; if the object exists, refer to Solution B.

Cause A: Thisissue may occur if the object and any references to the object are not removed
completely in the PowerBuilder application. When Appeon Developer searches the object
list, some references can still be found.

Solution A: Follow the steps below to fix the problem.

Step 1: Create an object with the same object name in the PBL where the object was
removed.

Step 2 : Incrementally build the application.

Step 3: Delete the created object.

Step 4 : Try Appeon Deployment again.

Solution B: If for any other reason the issue still occurs, try the steps below.
Step 1: Export and import the object in PowerBuilder.

Step 2: Full build the application.

Step 3: Try Appeon Deployment again.

3.6 Task 2: Application File Generation

3.6.1 Failure in Incremental Deployment

After the user upgrades PowerBuilder to a different build, errors may occur during an
incremental deployment process.

Cause & Solution: Refer to Upgrading to a different Build of PowerBuilder.

3.6.2 #Error launching LoadConfig#

The "Error launching LoadConfig" message is displayed when the user changes the settings
in Appeon Developer Configuration or performs Task 2 of the Deploy Wizard.

Cause: Thereis one of two possibilities that can occur.

1. The EonADT50.exe cannot be loaded. This can happen when the developer machine does
not meet the minimum hardware requirements specified in the Appeon Installation Guide.
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2. The EonADT50.exeis loaded but failsto read the .DAT files.

Solution A: Follow the steps below to fix the problem.

Step 1: End the EonADT50.exe process in the Windows Task Manager
Step 2: Delete the application profile in Appeon Developer Configuration

Step 3: Recreate the application profile and run Appeon Application Deployment/Appeon
Developer Configuration.

Solution B: If the problem persists, follow these steps to rectify it.
Step 1: Delete the application profile in Appeon Developer Configuration.

Step 2: Delete the application folder in the Appeon Developer install directory: \Appeon
\Devel oper2013R2\Project\ApplicationName.

Step 3. Recreate the application profile and run Appeon Application Deployment/Appeon
Developer Configuration.

3.6.3 #Failed to transfer command#
Web file generation cannot proceed if the error "Failed to transfer command" occurs.
Cause: EonADT50.exefailsto read the .DAT files.

Solution A: Verify that the EonADT50.exe process is running in the Windows Task
Manager. Try the deployment again.

Solution B: If the problem persists, try the following steps.

Step 1: Terminate the EonADT50.exe process in the Windows Task Manager.
Step 2: Delete the application profile in Appeon Developer Configuration.

Step 3: Recreate the application profile and run Appeon Deployment again.
Solution C: If Solution B is unsuccessful, the following actions should rectify it.
Step 1: Delete the application's profile in Appeon Developer Configuration.

Step 2: Delete the entire application folder in the Appeon Developer install directory:
\A ppeon\Devel oper2013R2\Project\ApplicationName.

Step 3: Recreate the Application Profile and run Appeon Deployment again.

3.6.4 #Exception at: CString CparseEngine...#

Web file generation cannot proceed when an error message box pops up and displays
"Exception at: Cstring CparseEngine”.

Cause: One of the possible causesis that the Application Profile does not contain all the
necessary PBLS, or some referenced objects in the application cannot be found in the
application PBLS.

Solution: Verify that the application can be compiled (Full Build) successfully, and that all
PBLsfor the target have been added into the Application Profile. Run Appeon Deployment

again.
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3.6.5 #Error loading command string#

During Web file generation the following error might be displayed "Error loading command
string”.

Cause & Solution: See "Error loading command string".

3.6.6 Feature Analysis and deployment freezes

During unsupported Feature Analysis or Task 2 of the Appeon Deployment Wizard, the
user can see the "Start searching for related objects...” message, displaying normally in the
status window. However, the program does not proceed. The EonADT50.exe processis still
running in the Windows Task Manager.

Cause & Solution: See Feature analysis or deployment comes to a standstill.

3.6.7 #Fail to analyze application# and #Fail to analyze Menu Object A in the B
application# Errors

Appeon Developer stops the analysis or deployment of the application and reports the "Fail to
analyze menu object A in B." and "Fail to analyze application" errorsin thelog file.

Cause: There are some unsupported features in the Menu object.
Solution: Y ou can take the following steps to solve the problem.
Step 1: Full build the application without reporting any errors.

Step 2: Check the menu name with understanding the following naming rules:
» Can be reserved words in JavaScript, apart from the word "Object".
» Can have up to 40 characters but no spaces

* Must start with aletter or an _ (underscore) and can include any combination of the
following letters and numbers, and these special characters. Underscore (' ') character, 0-9,
&z, A-Z, Double-byte characters or characters with Unicode > 255

Step 3: Redeploy the application.

3.6.8 Error #Could not read object#

Appeon deployment may occasionally result in an error stating that it could not read an
object.

Cause: The error can occur if aPBL has not been optimized. The PowerBuilder IDE allows a
PBL to be optimized by eliminating unused objects and space.

Solution: Optimize the application PBLs by right clicking on the PBL and selecting
Optimize. Deploy the application again.
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3.7 Task 3: Application Deployment

3.7.1 #Error: Failure in adding an application to [Server Name]#

The application deployment has not completed successfully if you receive an "Error: Failure
in adding an application to Local Appeon Server" message. Thistypically occurs during Task
3: application deployment.

Cause A: Appeon Server is either not running or cannot be found by Appeon Developer.
Solution A: Restart Appeon Server and click Retry to re-deploy the application.

Cause B: You did not specify correct deployment username and password in the Appeon
Server profile.

Solution B: Check with the AEM admin whether the deployment security is on for the
Appeon Server, and what are the accounts allowed to deploy applications to the Appeon
Server. Specify an authorized deployment username and password in the Appeon Server
profile, and make sure "Test Appeon Server Settings' is successful.

3.7.2 Unable to write to FTP Server: #Error: Unable to find the destination
directory#

When accessing the FTP server to upload Web files the following error will be displayed
"Error: Unable to find the destination directory”.

Cause: The Web files cannot be uploaded to the FTP server because the user specified in the
Web Server profile is not authorized to write to the FTP server.

Solution: If an 1S FTP server is being used, follow the instructions detailed below. If another
type of FTP server is being used, the following instructions will also give you a general idea
of what changes need to be made to the configuration on the FTP server:

Open Administrative Tools > Internet Services Manager, and check the Properties for the
Default FTP Site folder:
* Verify that the Write property is selected in the Home Directory tab.

» Verify that the Granted Access option is selected in the Directory Security tab.

3.7.3 Web application deployment to remote servers does not work
When deploying to both local and remote servers simultaneously, the process fails.

Cause: Appeon does not support simultaneous deployment to both the local and remote
Appeon Server(s). In addition, although you may not be deploying to alocal Appeon Server,
problems may occur occasionally when deploying to remote Appeon Server(s) when the local
Appeon Server isrunning.

Solution: Stand by the following rules when performing a deployment.
 Shut down the local Appeon Server when performing a remote deployment.

» The remote deployment profile(s) should not include alocal Appeon Server. Verify that
the deployment contains only one remote Appeon Server or one cluster of remote Appeon
Servers that have been configured in AEM.
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3.7.4 #Error: Unable to upload INI file#

Task 3 (Web Deployment) cannot proceed when the error message "Unable to upload INI
file" isdisplayed in the status window.

Cause: Failureto upload an INI file can result from one of two causes: Appeon Server

has not been started or the appeondb data source is not running. Appeon Developer will
upload an empty INI file to AppeonDB on the Appeon Server if no INI files are selected for
deployment.

Solution: Follow the steps below to fix the problem.
Step 1: Verify that Appeon Server has been started.

Step 2: Connect to Appeon Server in Sybase Central (EAServer Manager). Right-click
appeondb in the data source folder, and select "Ping”. If pinging the appeondb data source
fails, refer to Fail to ping appeondb data source

Step 3: Restart Appeon Server and deploy the application again.

3.7.5 #Unable to cast object of type 'System.String' to type 'System.Byte[]'#

Failed to deploy an application to Appeon Server for .NET which runsin an uncertified-
Appeon-language-environment, for example, Turkish environment. The "Unable to

cast object of type 'System.String' to type 'System.Byte[]™ error is reported in Appeon
Deployment log.

Solution:

Step 1: Find the following command line in the web.config file at C:\Inetpub\wwwroot
\appeon\AEM and then add the "culture="n-US"™" attribute.

<gl obal i zati on request Encodi ng="utf-8" responseEncodi ng="utf - 8"
ui Cul ture="auto" cul ture="n-Us"/>

Step 2: Save the file changes and restart 11S to make the modification take effect.
Step 3: Deploy the application again.
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4 Troubleshooting Web Applications

This section contains information about general troubleshooting issues when running Web
applications deployed with Appeon for PowerBuilder. If you cannot resolve the problem
using this troubleshooting guide, please contact technical support at http://www.appeon.com/

support.

4.1 Launch Web applications

4.1.1 IE shows #done# status and then stays blank

When trying to launch the Web application, the | E page shows a"done" status on the lower
left hand corner and then it stays blank. The ActiveX has been correctly downloaded and the
"run now, or run after download" screen also successfully displayed, after this screen, all the
files seemed to download but the application login screen never appeared.

Cause: By default, the Web server running on Windows Server 2008 R2 +I1S 7 does not
allow the following two types of files to be downloaded to a browser:

1. Fileswith file extension, but not specified in 11S

2. Fileswithout file extension

Therefore, you would need to explicitly define these file typesin I1S.
Solution:

Step 1: Find out what files of the Web application cannot be downloaded from Windows
Server 2008 R2 + 11S7.

1. Goto AEM > Application > Client Features > Application name, and then set Allow
user to select run modeto Yes.

Figure4.1: Set start and exit

Start & Exit (Web Only)

Specifies the Web application start and exit behaviors. Please note that the ‘Run after cownload™ will result in the entire Web application to be downloaded info cache, which increases
the initial download time.

Allow user to select run mode No
Default run mode: @ Bun now Run after download
ExitMode: Close browser Closetab @ Redirectto  about:blank

2. On the same AEM page, find out where local Web files are stored. For example: C:\Users
\appeon\A ppData\Roaming\appeon.

Figure 4.2: Client storage location

Client Storage Location (Web Only)
Specifies where to cache the Web application files.

& ~ o I Stores the Web application files in the user profile folder as determined by the Windows OS. The application will remain cached
DefaultUser Profile Locatior regardless the Browser Cache Folder is cleared, which ensures fastest application startup
Stores the Web application files in the Browser Cache Folder, for example, the Temporary InternetFiles Foloer of Internet Explorer. If the

Browser Cache Folder Browser Cache Folder is cleared the Web files must be redownloaded

Stores the Web application files in the location specified below. The application will remain cached regardless the Browser Cache Folder
s cleared, ich ensures fastest application startup. Please specify an absolute path (e.g. C:\Appeon\) or utilize one of the following

cp

m% cenotes Win :
suserocation®s oenotes v ws user profile path (e.g. C:Documents and Settings\AdministratorApplication Data):
“salluser_ocation®t denotes windows configuration directory for all users (e.g. CDocuments and Settings'All UsenApplication Data);
“asystemDrive®: denotes the system drive oot (e.g. C:).

ayn

Customized Location
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3. Delete the local directory for the Web files. The folder is named after the Web application,
for example, C:\Users\appeon\A ppData\Roaming\appeon\localhost_Dotnet_<application-
name>.

4. Accessthe Web application in IE, and select Run After Download.

Figure 4.3: Select run mode

Mode
. HunN-:uws Far high speed network. The application runz immediately and
files are downloaded only when needed. B ecommended for
broadband connection, such az «DSL.
¥ Fun After For low zpeed network. all filez will be downloaded befare the
Dawnload ot :
------------------------ application runz. B ecammended far narowband connection,

such az mader ar [SOM.

5. In the Download Info window, make note of the type of files that cannot be downloaded,
as you will then need to specify them in IS explicitly.

Figure 4.4: Download info

- Download [nfo

Finizhed downloading all the files! The following files failed
[®] &ppeon System Files  to be downloaded. Pleaze run the application again to
re-download them.

dw_irventary_detail_gen.win ﬂ
dw_ac_planning_gny_7day_forecast dat i
dw_corversion_datawindow_544_fields dat
dw_enhagineering.dat

dw_engineering_rey.dat _';]
i.

Retmy l Ignare I

fpplication DLLAOCK

[®] Application Files

Step 2: Set up the MIME types for files with file extension that cannot be downloaded.

1. Open 11S Manager. Expand the Web Site hosting the Web application, expand the Web
application folder, then click the sub-folder which contains the files that cannot be
downloaded.

The following table lists the sub-folder and what types of application files they contain, so
you can easily determine which folder you will need to configure.

Table4.1: Filetype and folder name

* dat Located in the meta/mer ge folder.
*.win, *.udo Located in the ole folder.

*.dll, *.ocx Located in the plugin folder.
*.bmp, *.jpg, *.ico Located in the image folder.
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Filetype Folder name
f* Located in the mer ge folder.

Suppose the *.win file cannot be downloaded, then click the "ole" folder.

The following steps take the file extension .win as an example to show you how to create
the MIME type for thisfile type. Y ou may need to create multiple MIME typesif there
were more than one type of file extension listed from step 1.

2. In FeaturesView, double-click MIME Types, then in the Actions pane, click Add,
and then in the Add MIME Type dialog box, set the File name extension to, in this
example, .win, and set the MIME type to application/octet-stream, and click OK.

Figure4.5: Add MIME type
[ Add MIME Type [ B

File name extension:

win

MIME type:

application/octet-streamn

0K ] I Cancel

e

Step 3: Set up both MIME type and Handler Mapping for files without file extension that
cannot be downloaded.

1. OpenthellS Manager. Expand the Web Site hosting the Web application, expand the Web
application folder, then click the "merge" folder.

2. In FeaturesView, double-click MIME Types, then in the Actions pane, click Add, and
then in the Add MIME Type dialog box, set the File name extension to * and set the
MIME type to application/octet-stream. Click OK.

Figure4.6: Add MIME type
" Add MIME Type B |

File name extension:

£

MIME type:

application/octet-strear|

| ok || Cconcel

[
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3. Click the "merge" folder again and then double click Handler Mapping in Features
View.

The following steps take the file name f### (where “###” is a number) as an example to
show you how to create the mappings for this file group. Y ou may need to create multiple
mappings if there were more than one group of these files listed from step 1.

4. Click Add Module M apping in the Actions pane, and then in the Add Module M apping
dialog box, fill in the fields with the following values:

* Request path: f* (or whatever the names were of the objects that were listed in the
“Download info” screen from the first step above.)

* Module: StaticFileM odule, DefaultDocumentM odule, DirectoryListingM odule

» Name: v (you can put whatever name you want here, aslong asit does not conflict with
an already existing mapping.)

Figure4.7: Add module mapping
rﬁn:ld Maodule Mapping Iili_hj

Request path:
.F*
Example: *.bas, wsvc.axd

Module:
StaticFileModule, DefaultDocurmentModule, DirectorylistingModule -

L]

Executable (optional):

Mame:

W

Request Restrictions...

Ok l I Cancel

o

5. Then click the “Request Restrictions ...” button; in the Mapping tab, check the box and
select “File or folder”, and in the Access tab, select "Read".
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Figure 4.8: Request restrictions
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6. Click the OK button to complete the setup, the mapping will be listed as shown below.

Figure 4.9: Web service handler factory

WebServiceHandlerFactory-Int... *.asmx Enabled Unspecified Sy

WebServiceHandlerFactory-I5..  *.asmx Enabled Unspecified Isz
v = Enabled File or Folder Sti _

4.1.2 IE 8 crashes under Windows XP

When you run the Appeon Web application for the first timein Internet Explorer 8 on
Windows XP, the following error occurs and | E crashes.

Figure4.10: |1E 8 crashes

IEXPLORE. EXE - Application Error H

@ The instruckion at "0x065a0068" referenced memary at "0x065a0068", The memary could not be "writken",

Click an OF to kerminate the program
Click an CANCEL to debug the pragram

(0] 4 | Cancel

Cause: The |E security option “Download signed ActiveX control” is set to Prompt or
Disable.

Solution: Please follow the steps to set the security of IE 8:
Step 1: Open |IE 8 and click Tools > Internet Options.

Step 2: Click the Security tab, select the appropriate zone on the Select a Web content zone
to specify its security settings, and then click the Custom Level... button.

Step 3: Set "Download signed ActiveX control” to Enable in the Settings box and then click
OK.
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4.1.3 IE 7 reports #Internet Explorer cannot open the Internet site. Operation
aborted.# Error

On some machines with Vistaand Internet Explorer 7 installed, the "Internet Explorer cannot
open the Internet site http://<Web Site>. Operation aborted." error may occur and cause the
Web application to fail to run.

Figure4.11: Operation aborted

& http://server2254:-8180/sales_application_deme/ - Windows Internet Explorer

F e e j ¢ |l Livie 50

s & http://server2254:8180/sales_application_demo i | 4y | se |l Live See

W R | @ httpy//server2254:8180/sales_application_demcy/ e~ B8 -~
Windows Internet Explorer @

: Internet Explorer cannet open the Internet site
http:/192.0.2.254:8180/sales_application_demo.

Operation aborted

Cause: Thisisabug of Internet Explorer 7 (http://support.microsoft.com/kb/927917).

Solution: Right click the Internet Explorer icon on desktop, choose Run asadministrator;
after the Web application runs successfully, restart the Internet Explorer in the normal way.

4.1.4 #Failed to get resource from Appeon Server# error

When you run the Appeon Web application, the "Failed to get resource from Appeon Server"
error occurs, as shown in figure below.
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Figure 4.12: Fail toe get resource
File Edit View Favortes Tools Help
Favontes | 33 B e v B =
& Failed to lcad Web application v B -0 mm o+ Pagew Safetyv Toolsw |

I Intranet settings are now turned off by default, Intranet settings are less secure than Intermet settings. Click for options..,

eFailed to get resource from Appeon Server,

Most likely causes
8 Cause A Intemet

& Cause B: F

® Cause C: Nebwork access nights are

Cause A: If you run the Appeon Web application under the administrator group member (not
administrator), the administrator group member will not have sufficient rights to download
the Appeon ActiveX plug-in.

Solution A-1: Add the URL of Appeon Web application to the Trusted Sites zone in Internet
Explorer, because the default security settings of this zone are appropriate for downloading
and installing the Appeon ActiveX plug-in. The following are detailed steps.

Step 1: Click Tools > Internet Options menuin Internet Explorer.

Step 2: Select the Security tab in the Internet Options window. Then click the Trusted sites
icon, and click the Sites button.

Step 3: In the Trusted sites window, input the URL of the Web application to the Add this
website to the zonefield. Click Add, and then click Close.

Step 4: Re-open Internet Explorer then run the Web application.

Solution A-2: Right click the I nternet Explorer icon on desktop, choose Run as
administrator; after the Web application runs successfully, restart the Internet Explorer in
the normal way.

Cause B: The Enable Protected Mode of Internet Explorer causes this runtime error.

Solution B: Uncheck the Enable Protected M ode option for the appropriate zone under the
Security tab of the Internet Options window.
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Figure 4.13: Enable Protected M ode

I )

Internet Opticns @

General Securty | Privacy | Cortent | Connections | Programs | Advanced |

Select a zone to view or change security settings.

@ & v O

= w

Intemet Local intranet Restricted
sites

Trusted sites

? This zone cortains websites that you
A trust not to damage your computer or
your files.
You have websites in this zone.

Sites

Securty level for this zone
Allowed levels for this zone: All

- Medium

- - Prompts before downloading potentialy unsafe content
i, L - Unsigned ActiveX controls will not be downloaded

Custom level... |

Reset all zones to default level |

0K | Cancel | |

4.1.5 #Unable to validate current license file. Please reinstall Appeon Server#

Web application cannot load in Internet Explorer. The pop up error message is displayed
"Unable to validate current license file. Please reinstall Appeon Server".

Cause: Validation of appeon.licensefile in AppeonServer.db file may fail if abnormal
operations are performed. Y ou will continue to see the error message if Appeon Server is not
reinstalled.

Solution: Reinstall Appeon Server. Avoid such operationsin Appeon Server:
1. Modify the information in appeon.license file
2. Copy components to Appeon Server instead of deploying them.

4.1.6 Failed to install the Download Center plug-in

When you try to manually install ActiveX plug-in, you prompted with this error "Failed to
install the Download Center plug-in"

Cause: Appeon plug-inisfailed to manually install since the system DLL, atl.dll, is never
registered on this machine.
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Solution: Login to the computer as Administrator account, open any prompt window and
then follow instructions below:

1. Navigate to the directory C:\WINDOWS\system32 or C:\WINNT\system32;
2. Run the command: Regsev32 atl.dll.

4.1.7 Failed to manually download Appeon ActiveX

Failed to manually download Appeon ActiveX control and encounter the following web
page:

Figure 4.14: Fail to download Appeon ActiveX
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specified, the Progld column becomes a version independent prog id. ValueThe Program
Tdentifier. Primary key.Classhppld The CLSID of an OLE factory corresponding to the
Progld. ArgumentA unique string GUID representing this patch.Localized description for the
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containing the patch package. Component_Component?, N, & ontextPrimary key, sequence with
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creation/deletion Description of service. Size of patch in bytes (long integer).Optional
foreign key into the Icon Table, specifying the icon file associated with this Progld

Will be written under the Defaultlcon key. Base action to determine insert =
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Cause: The problem isonly found in EAServer 5.x and WebL ogic for Unix. One of the
possible causesisthe MSI extension is not mapping to a correct MIME type.

Solution: Map the M S| extension to application/octet-stream MIME Type in EAServer 5.x
manager console or WebL ogic

Taking EAServer 5.x as an example, you can add the MIME mapping:
1. Go to Servers > Jaguar >Installed Web Applications
2. Right click the EADefault and click the Property item
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3. Add or Edit the MIME Type for MSI extension.

Figure4.15: Add or edit MIME type
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4.1.8 Failed to initialize Appeon Weblibrary Component

Appeon Web applications cannot be correctly started and you are prompted with the error
message that "Failed to initialize Appeon Weblibrary Component”.

Cause: When you access the web application from a computer at the first time, the Web
application is accessed from the application.html page but index.html. It is not aregular way
to access Web application since in Appeon it is designed to start the web application from
the index.html page which is aiming to download and initialize the Appeon ActiveX. If the
application starts from the application.html, the ActiveX cannot be correctly installed on this
machine and will result the failure of running the Web application.

Solution: Run the web application with correct URL which ends with the index.html page,
for example, http://appeonserver:8000/index.html.

4.1.9 Demo Web applications do not load in Internet Explorer

The index.html page cannot be displayed when launching the demo Web application in the
Internet Explorer browser.

Cause: The URL in the browser's address bar is incorrect.
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Solution: Verify that the hostname and port number in the URL are the same as the settings
in the appeonserverhttp listener.

4.1.10 Web applications do not load in Internet Explorer

Web applications can be loaded and run properly previously. After being deployed with a
newer Appeon version, the Web applications can no longer be loaded.

Cause: Previously loaded Web application files are cached in the browser, and prevent the
browser from downloading the latest Web files.

Solution: (1) Manually delete the temporary Internet files: go to Tools | Internet Options,
click the Delete Files button. (2) In the Temporary Internet Files Settings dialog, click the
View Objects button, and clear al the objects in the popup folder, which should be \WINNT
\Downloaded Program Files (Windows 2000) or \WINDOWS\Downloaded Program Files
(Windows XP or 2003).

An aternative solution is to check the "Empty Temporary Internet Files folder when browser
isclosed" option (under the Security section of the Advanced tab of Internet Options)

to ensure that no cached files remain whenever Internet Explorer is restarted. But thisis
recommended for use only during the development stage. During development, it is best

to have the latest Web application loaded in the browser to avoid any problems caused by
cached files. When your Web application is ready for production deployment, this setting
can be disabled (unchecked) so that the Web application can be cached at each Client PC for
better scalability and Client-side performance.

4.1.11 IE browser fails to open Web applications

The Web application failsto load into the browser, but no error messages are displayed. The
screen is blank as shown in the following figure.

Cause: The application index.html page cannot be opened because of the high security level
setting of Internet Explorer on the Client PC.

Solution: Follow the steps below to fix the problem.

Step 1: Close the blank browser window. Right-click the I nternet Explorer icon and select
Propertiesin the popup menu.

Step 2: Delete the temporary Internet files and cookies from the General tab. Select Delete
all offline content when deleting temporary Internet files.

Step 3: On the Security tab, set the security level to default - Medium for the Internet or a
Local intranet, depending on where the application is deployed.

Step 4: Apply the changed settings to Internet Explorer.

Step 5: Verify that the Internet Explorer on the client is configured using the instructions
described in the Internet Explorer Configuration section of the Appeon Installation Guide.
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Figure4.16: | E browser failsto open Web applications
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4.1.12 Error #Connect EAServer failed# when loading Appeon demo
applications

Failure to run the Appeon n-Tier NVO demos (e.g., Appeon Code Examples) both on the
Web and in PowerBuilder. The "Connect EA Server failed" message is displayed.

Cause: For Appeon Server connection settings, the host name is set to "localhost” by default,
and the port number is set to "9989" by default. If the actual host name and port number

are different from the default settings, the "Connect EA Server failed” error will occur when
attempting to run the demo application on the Web or in PowerBuilder.

Solution: Here AppeonCodeExamples is used to demonstrate the solution to this problem.

Step 1: Load AppeonDemo.pbw in the PowerBuilder IDE. In the system TreeView, open
appeon_code_examples > ace windowl1.pbl > w_distributed DW.

Step 2: Find the following script in the Open event of thew_distributed DW object. Verify
that it matches the actual Appeon Server settings enabling the demo application to work
properly with PowerBuilder.

i_conn.driver = "jaguar"

i _conn. application = "AppeonCodeExanpl es”
i_conn.|ocation = "l ocal host: 9989"
i_conn. Userl D = "jagadmi n"

i _conn. Password = ""

Step 3: Follow the instructions provided in Error "Create instance failed" when loading n-
Tier NVO Web applications to verify that the demo applications can work properly on the
Web.

4.1.13 Error #Create instance failed# when loading n-Tier NVO Web
applications

When loading a deployed Web application that uses n-Tier NV Os the following error might
be displayed " Create instance failed".
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Cause: If the Web application relieson n-Tier NV Os that are deployed to Appeon Server,
the Web application will not be able to load if the instance of the NV O cannot be created
successfully. A "create instance failed" error caused by the EAServer package being
incorrectly installed will be displayed.

Solution: Follow the steps below to fix the problem (taking Appeon Code Examples as an
example).

Step 1: In EAServer Manager, check whether the A ppeonCodeExamples package existsin
the Packages folder.

Step 2: In the PowerBuilder IDE, navigate to p_appeon_code_examples_server_deploy in
appeon_code_examples server.pbl. View Properties of the EA Server Component Generator
Project.

Figure4.17: p_appeon_code_example server_deploy
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b %: SagpromNy

;. O _appecn_code exarnples

zerver_deploy

Step 3: Verify that the EAServer connection settings in the Properties dialog for the
p_appeon_code examples server_deploy object reflects the settings of the EAServer where
you will deploy the n-Tier NV Os.

Step 4: Select Deploy ( 8 ) to deploy the EA Server package.

Step 5: In EAServer Manager, right click the EAServer package AppeonCodeExamples,
and select "Generate Stubs/Skeletons' to generate Stubs and Skeletons for the NV O. Select
Generate Java Files, Compile Java Stubs, and Compile Java Skeletons, and leave the
other options at their default values.

Step 6: The Stub/Skeleton files generation progressis displayed. When it completes
successfully, click OK to close the Code Generation status window.

4.1.14 #Create Session failed#

If you receive a"Create Session failed" error message and find a" SystemException:
NO_PERMISSION" exception in the Jaguar.log, first read Cause A and Solution A which
should rectify the problem; if not, please go to Cause B and Solution B.

Cause A: The error may occur if the OS authentication setting in EAServer isincorrect.
Solution A: Follow the steps below to fix the problem.

Step 1: Run EAServer and start EAServer Manager.

Step 2: Go to the Properties for the server in EAServer Manager.

Step 3: Set the property "com.sybase.jaguar.server.authservice" to false.

Step 4: Restart EAServer.
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We suggest either keeping the property authentication disabled or correcting the OS
authentication setting (referring to Getting Started in EAServer System Administration

Guide).

Cause B: Theerror is caused by either an Internet Explorer/Client configuration problem or
an Appeon Server configuration problem.

Solution B: Verify you are using a minimum of Internet Explorer 6.0 SP1. Upgrade to the
latest version if necessary.

* Internet Explorer/Client configuration

The possible causes and solutions are listed in the following table. The most common
cause for the Internet Explorer/Client configuration issue is item #1.

Table4.2: Internet Explorer configuration

\[e} Possible Causes Solutions
1 Internet Explorer security Go to Internet Options > Security in Internet
level is set too high. Explorer, change the security level to
the medium default-level for the Internet
or Local intranet zone or Trusted Site,
depending on where the Appeon Web
application is deployed.
2 Advanced Internet Options | Go to Internet Options > Advanced in
setting incompatibility. Internet Explorer, and click the Restore
Defaults button to restore the default
settings for the Advanced options.
Note: Selecting Default Settings will
remove the check from "Use HTTP 1.1
through proxy connections'. This setting is
required when the application is accessed
through a proxy server.
3 Some Client-side software, | Disable suspected software and try again.
such as anti-virus software
or apersonal firewall, is
preventing the required Web
files from downloading.

* The most common causes for the Appeon Server configuration issue are items#1 and #2 in
the following table.

Table 4.3: Other configurations

\[o} Possible Causes Solutions

1 EAServer serviceneedsto | Reinstall the EAServer service using this
be reinstalled. command: serverstart.bat -removeandinstall

2 EAServerisbeing runin Do not run EAServer in debug mode.
debug mode.
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\[e} Possible Causes Solutions
3 AEM configuration files are | Please make sure the following files
corrupt. at %0 JAGUARY0\appeon\repository\

%instancename¥o\config (Windows)

or $JAGUA R/appeon/repository/
$instancename$/config (UNIX) have
not been corrupted. If any fileis corrupt,
reinstall Appeon Server to replace them.

» aem-config.xml
» aem-mapping.xmi

« applications-config.xml

» mapping.xmi
 server-config.xml
4 Software like an anti-virus | Uninstall Appeon Server. Verify al the
program has interfered prerequisites for Appeon Server installation
with the Appeon Server (aslisted in the Appeon Installation Guide)
installation process. have been satisfied. Disable any software

that may interfere with the installation.
Reinstall Appeon Server.

4.1.15 #Load application failed#
When loading the Web application, the error message "L oad application failed" is displayed.
Cause & Solution: Refer to the cause and solution in " Create Session failed".

4.1.16 #Failed to invoke remote procedure# error

When running an Appeon application that is deployed to |1S Web server, the browser only
pops up a"Failed to invoke remote procedure” error message.

Cause: The llS server requires Scripts and Executables permissions on the applications.
Solution:

Step 1: Open the Internet Information Service in the Administrative Toolsin the 11S Web
server.

Step 2: Go to Default Web Site Properties > Home Directory, and change the Execute
Permissions to " Scripts and Executables”.
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Figure 4.18: Home Directory
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4.1.17 #Automation server could not create object# error on some clients

Web application fails to run on the client that does not have Appeon Developer. The pop up
error message "Automation server could not create object” is displayed.

Cause: Web application is deployed with the "Generate Web Report™ option enabled in
Appeon Developer. If the option is enabled, the deployed application shall rely onaDLL in
the Appeon Developer installation folder for generating the Web report.

Solution: Redeploy the application without enabling the " Generate Web Report” option in
the Appeon Developer.

4.1.18 #0bject doesn't support this property or method# Error

The "Object doesn't support this property or method" error message displays when you access
to the Web application.

Cause: There are two possible causes: 1) The Internet Explorer version may not be compliant
to the Appeon's requirements. 2) The configurations of the Internet Explorer are incorrect.

Solution: Upgrade the Internet Explorer to Appeon certified version. Configure Internet
Explorer settings according to the Internet Explorer Configurations section and the System
Language Settings section in the Appeon Installation Guide. Then follow the steps below:

Step 1: Manually delete the Temporary files and cookies: go to Tools > Internet Options,
click the Delete Cookies button.
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Step 2: Click the Delete Files button and check the Delete all offline content box in the pop
up window. Then click the OK button to ensure that all temporary files are del eted.

Step 3: Click the Settings button and the View Objectsin the Temporary Internet Files,
clear all objectsin the pop up folder.

Step 4: On the Security tab page, set the security level to default - Medium for the Internet or
aLocal intranet. Please ensure that you can download and install the ActiveX.

Step 5: On the Advanced page, click the Restor e Defaults button and check the Use
HTTP1.1 through proxy connections item. Then click the OK button to save the settings.

4.2 Display errors

4.2.1 Distributed DataWindows are not displayed

A distributed Datawindow does not display on the Web when deployed with Appeon 6.x.
However, it isdisplayed in PowerBuilder and previously displayed with Appeon 5.0/5.1
without any problems.

Cause: Appeon versions apply different workaround PBLs and DLLs. When the user
upgrades the PowerBuilder distributed application from using Appeon 5.0/5.1 to using
Appeon 6.x, the workarounds PBL and two related DL L s should be updated.

Solution: Follow the steps detailed below to fix the problem.

Step 1: Remove the appeon_workarounds.pbl file from the Library Search Path of the target
PowerBuilder application.

Step 2: Remove EonAXNVO.dlIl and EonEmfPic.dll from the folder containing the
PowerBuilder application PBL.

Step 3: Add the appeon_workarounds_ax.pbl to the Library Search Path of the
target PowerBuilder application. The fileis located in the directory:\Appeon
\Developer2013R2\appeon_workarounds.

Step 4: Copy the two files EonAXNVO.dIl and EonEmfPic.dll from the \Appeon
\Devel oper2013R2\appeon_workarounds directory to the folder holding the PowerBuilder
application PBL.

Step 5: Full deploy the application again with Appeon for PowerBuilder.

4.2.2 Corrupt Chinese characters are displayed in a DataWindow

Chinese characters can be entered into a DataWindow and updated to a Sybase ASA/SQL
Anywhere database, however, after DataWindow re-retrieve, the characters displayed are
corrupt.

Cause: Chinese characters cannot be displayed correctly if the application uses a JDBC-
ODBC driver for connecting to a Sybase ASA/SQL Anywhere database, and the database
field that contains Chinese charactersis Long VarChar type.

Solution: Y ou can use either of the two solutions below.

Change the data type of the database field from Long VarChar into VarChar.
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Make sure the character set used in the operating system that runs Appeon Server is the same
asthat of the Sybase ASA/SQL Anywhere database computer.

4.2.3 Text does not display or text is grayed out

When the application is deployed to the web, some of the text in the Ul does not display or
thetext is grayed out.

Cause: Thisissue could be caused by the enabled property of static text.

Solution: In the PowerBuilder painter, the affected static text control might have the enabled
property set to false, so text will be grayed out when the application is deployed. Make sure
you select the enabled property of the affected static text control and incrementally deploy
your application with Appeon Developer.

4.2.4 DropDownListBox does not display completely
When selecting a DropDownL istBox object, its content may be hidden.

Cause: When a DropDownListBox/Datawindow is pulled down but the window container is
not large enough, it will automatically shift to display the major content.

Solution: Click the Tab key to recover normal display of the window.

4.2.5 Nested reports over five pages do not display

Nested reports longer than five pages cannot be viewed in the DataWindow of the Web
application.

Cause & Solution: Refer to Nested reports over five pages do not display.

4.2.6 Nested reports over 50 rows do not display

When retrieving data from a nested report that has more than 50 rows, an error message
displaysthat "Failed to create SQL Statement due to java.sgl.SQL Exception: [ Sybase]
[ODBC Driver][Adaptive Server Anywhere] General error: Resource governor for prepared
statements exceeded".

Cause: Thiserror only occurs to the Sybase ASA/SQL Anywhere database. The ResultSet
value that Appeon Server returned exceeds the maximum cursor value that is default in the
Sybase SQL Anywhere database.

Solution:
Run the following commands to set the cursor count and statement count to no limit:
Set option public.max_cursor_count = 0
Set option public. max_statenent_count = 0
4.2.7 MDI windows do not display in full
Some large sheets do not display fully on the Web.

Cause: The MDIClient object in PowerBuilder can open alarger visible scope than on the
Web.
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Solution: Set the V ScrollBar property for the MDI window to TRUE.

4.2.8 Truncated display of data or controls in a DataWindow or Window
Controls or datais not displayed correctly in Datawindows or Windows.

Cause: In some cases, text or controls in the Datawindow or Window may not be completely
visible. Thisis because the PowerBuilder units used to size the Ul of the application, such as
the DataWindow rows and columns, the Window object, etc. These cannot be converted to
the Web units (pixels) perfectly.

Solution: For the affected DataWindow, resize the Ul layout in PowerBuilder to allow
slightly more space for the items that are not fully displaying.

4.2.9 Extra space or padding between MDI client area and toolbar

Extra space or padding appears between the MDI client area and the application toolbar in the
Web application.

Cause: Incorrect calculation of the MDI client area size during the application deployment
will cause extra spaces or add padding between the MDI client area and the application
toolbar in the Web application.

Solution: Modify the X, Y and Height property for the MDI window and the controlsin the
MDI window by following the steps bel ow:

Step 1: Estimate the height in PowerBuilder units, for example, 400 PowerBuilder units.
Step 2: Add the following script in the resize event:

String Isl, |s2

Long Il _rate
Setnul I (1s1)
Setnul I (1s2)
If sl =1s2 then //1n JavaScript, Isl equals to |s2
Il _rate = 400
else |l _rate = 0 //1n PowerScript, |sl does not equal to |s2
end if

Step 3: Edit additional scriptsin the resize event to:

* Subtract thell_rate value from the Y property of the MDI window.

» Addthell_rate valueto the Height property of the MDI window.

* Subtract thell_rate value from the Y property of the controlsin the MDI window.

» Assign the Height property of the MDI window to the controls that will have the same
height as the MDI.

Long Il _rate
Il _rate =Y
Il _rate = |l _rate + height

wi ndow acti vesheet
activesheet = GetActiveSheet ( )
activesheet.y = |l _rate
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4.2.10 Text displays in large size and is cut off

All the text in the application displays in an unusualy large size, so some text cannot be fully
displayed in its container and gets cut off.

Cause: Microsoft Windows display font sizeis set to large; this often happens when the
screen resolution is set high (for example, 1600* 1200). Appeon Web applications use the
small font size as defaullt.

Solution: Go to the Windows Display Properties of the client, in the Settingstab, click the
Advanced button, and set the font size to use "Small fonts".

4.2.11 Unable to display the double-byte characters

Double-byte characters such as Chinese, Korean and Japanese cannot be displayed on the
Web.

Cause: The character set of the system mismatches the character set of the database.

Solution: Goto AEM > Application > Data Transfer > Charset > [Your Application].
Add the corresponding charset for the application. For detailed adding steps, refer to
Section 5.4.7.1, “ Charset” in Appeon Server Configuration Guide for .NET or in Appeon
Server Configuration Guide for J2EE.

4.3 Runtime issues
4.3.1 Error 10999 - Keyword not supported: 'dsn’

Data source failed and an error (error 10999) box pops up saying Keyword not supported:
'dsn’ as shown in the figure below.

Figure4.19: Error 10999

Error 10999 X

@ kKewword nok supported: 'dsn

Acepkar

Cause: The "keyword not supported: dsn" issue is a known issue for using ODBC driver.

Solution: To resolve this, go to AEM, and then change the ODBC driver to the Native Driver
for SQL Server 2000/2005 in Appeon Server.

4.3.2 Cannot update Transaction Objects for WebLogic servers

When you try to configure Transaction Objects for WebLogic Serversin AEM, the Data
Source column in Configure Transaction Object is empty , and a message appears saying
L oad application server data source failed, as shown in the following figure.
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Figure 4.20: Transaction objectsin AEM
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Cause: WebL ogic 8.15 and later do not alow anonymous users to query JNDI.

Solution: Y ou can refer to Section 4.3.1.2, “ Setting up data source for WebLogic 11g” in
Appeon Server Configuration Guide for J2EE to solve thisissue.

WebL ogic 8 allows anonymous users to query and get INDI DataSource, but WebL ogic 8.15
and later do not allow anonymous users to query JNDI. In the WebL ogic's console, select
the "Anonymous Admin Lookup Enabled” to alow anonymous users to manipulate JNDI,
otherwise the Data Source drop-down box will not have values in Transaction Objectsin
AEM.

4.3.3 Error 404 - File or directory not found

Y ou may encounter a404 - File or directory not found error, when you start to run an
application.

Cause: The Appeon folder isnot in the application-related |1S home directory (For example:
your Appeon Server Web Component might be installed in c:\Program Files (x86)\Appeon
\WebComponent2013R2 by default, if you did not change the path when installing it).

Solution: Copy the Appeon folder to the application-related 11S home directory (for example:
C:\inetpub\wwwroot) to solve thisissue.

4.3.4 Http 404 not found error occurs when using WebSphere as the
Application Server

The webpage cannot be found, when you try to run an application, as shown in the figure
below.
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Figure 4.21: Thewebpage cannot be found
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Solution: For WebSphere applications, we recommend you use the JDK Compression (Path)
as the File Compression Settings for War/Jar property on the Appeon Developer Web Server
Profile Configuration page, as shown in the figure below.

Figure 4.22: Web server profile configuration in Appeon Developer
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4.3.5 #Stack overflow error#

The following error displays during application runtime: " Stack overflow error”. Click OK.
The message box will close and the Web application will run.

Cause: The application is deployed in Debug mode (Debug mode is specified in the
Application Profile Configuration of Appeon Developer).

Solution: If you deploy your application in Encrypted mode (specified in the application
profile of Appeon Developer), the error message will not be displayed.

4.3.6 #Could not Initialize JavaVM!#

During Web application runtime the following error displays: "Could not initialize
JavavM!".

Cause: This problem is possibly caused by an incorrect version of the PBVM.

Solution: Update the PBVM in EAServer to the version required by Appeon. Run the Web
application again.

4.3.7 #Failed to get DataWindow syntax from Appeon Server#

During Web application runtime the following error is displayed: "Failed to get DataWindow
syntax from Appeon Server".

Cause: Before application deployment, DB Type profile is not configured correctly in
Appeon Developer for the application profile.

Solution: Open the Appeon Developer Configuration window, and go to the DB Type
Profiles tab page in the "Application Profile Configuration”. It is required that for each
database type that the application runs against, a DB type profile should be configured.

Before you set up the DB type profile, be aware of the following:

1. The purpose of the DB type profile configuration isto convert the SQL statements into the
correct type of database syntax.

2. Specify an ODBC data source or native driver in the DB Type profile for connecting the
correct database type. It is unnecessary for the data source to connect to the actual database
that the application uses. But the database type must be correct, and the specified version
of the database is the same as the database version specified in AEM > Application >
Transactions > Transaction Objects.

3. Make sure the DB type profile connection testing is successful.
Refer to the Appeon Developer User Guide for instructions on configuring DB type profiles.

After the DB type profile configuration, re-deploy the application with the Appeon
Deployment Wizard using the Full Application Deployment mode.

4.3.8 Window loses focus of I-beam cursor

If awindow has a group box control with tab order numbers, when you press tab, the
windows lose the focus of the I-beam cursor.

Cause: Incorrect configuration of the group box's tab order.
Solution: Change the group box's tab order to zero.
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4.3.9 Receiving #Server busy# error
A "Server busy " error message pops up when running a Web application.

Cause: Itislikely that the client is running some other program(s) besides the Web
application, which are taking up large CPU or memory resources.

Solution: When running alarge Web application (for example, more than 40 MB), do not run
other resource intensive programs.

4.3.10 #Error occurred while creating an object instance# on the status box

During application runtime the following error may occur: "Error occurred while creating an
object instance".

Cause: Usualy, thistype of error does not affect running of the Web application. It aways
occurs when partial script in the application references an object, which is unsupported and
commented out.

Solution: Remove or work around the unsupported object, and make changes accordingly.

4.3.11 #Are you sure you want to navigate away from this page?# warning
message

When you try to exit a Web application by clicking the Close button in Internet Explorer, a
warning message will be displayed "Are you sure you want to navigate away from this page".
After clicking Cancel in the warning message box and further running the application, if you
click the Close button in the browser again, Internet Explorer crashes.

Cause: Some add-on program such as Snagit from TechSmith Corporation has been installed
to Internet Explorer.

Solution: Right-click on the Internet Explorer toolbar and disable the add-on program from
the popup menu.

4.3.12 DropDownDataWindow value incorrectly selected

When the user makes a selection in the DropDownDatawWindow, the value in the first row
will always be automatically selected. However, after this has happened, the Datawindow
will proceed to function properly.

Cause: The DropDownDatawWindow has not been assigned an initial value.

Solution: Either of these two solutions will rectify the problem.

» Try to select the value for a second time and the value displayed will be the value you
specified.

* Assign aninitia value to the DropDownDatawWindow in the PowerBuilder application.

4.3.13 #Predefined error_message pfc_dwdberror#

The error "Predefined error_message pfc_dwdberror" pops up during the running of a Web
ACF application.

Cause: Several tables are missing in the application. The tables are: messages, security _apps,
security_groupings, security _template, security _users. In PowerBuilder, if the above tables
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are missing but the services related with the tables are not used, the application works fine.
Appeon Web application, however, requires importing al the tables to the application
database.

Solution: Export the above-mentioned tables from pfc.db to the application database.

4.3.14 Demo Web application fails to call EJB component

In the Appeon Code Examples demo, the “EJB Component Lookup failed" error message
displays when the NV O calls function of EJB component.

Cause: The environmental variableistoo long.
Solution: Reinstall Appeon Server.

Before the installation, be sure to shorten the path for the environmental variable. Another
option is moving some driver files from the %EA Server%\javallib folder, and moving them
back after the installation.

4.3.15 Error occurs when running Distributed DataWindow in Appeon Code
Examples Demo

The following error occurs when running Distribute DataWindow in Appeon Code Examples
Demo after Appeon for PowerBuilder isinstalled.

Figure 4.23: Execute component failed
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This example applies only to Appeon Server versions which support NYO.
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Cause: EAServer 6.x uses new password mechanism, so Appeon setup program is unable to
set the password of appeonsample and appeonsample2 data sources during Appeon Server
installation.

Solution: Log into EA Server Web Administration Console and modify the password of
appeonsample and appeonsample? data sources to "sqgl”.
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4.3.16 #EonToolset60 Load resource failed#

An EonToolset60 Load resource failed error occurred, when you try to run an application.
And a message pops up saying EonToolset has stopped working - a problem caused the
program to stop working correctly. Windows will close the program and notify if asolutionis
available.

Cause: Appeon Developer might not be installed successfully.

Solutions: Make sure that you install Appeon Developer successfully by checking if there
are"multi_language _en.dll", "multi_language GB.dII", and "multi_language jp.dll" in
the C:\Program Files (x86)\A ppeon\Devel oper2013R2\language folder. If not, or if there
isany error when you are installing Appeon Developer, you need to re-install the Appeon
Developer.

4.3.17 The SQL statement cannot perform correctly when the Web server is
installed on a VMWare

The SQL statement cannot perform correctly when the Web server isinstalled on aVMWare,
separating from the Appeon Server.

Cause: The Network connection Bridged: Connected directly to the physical network
option is by default checked in Virtual M achines Settings.

Solution: Change the network connection from Bridged: Connected directly to the
physical network to NAT: Used to sharethe host's | P addressin Virtual Machine
Settings, as shown below.
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Figure 4.24: SQL cannot perform correctly
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4.4 Data operation

4.4.1 Retrieved data does not display in DataWindows
While retrieving records for a Datawindow, items are not displayed on the Web.

Cause A: Appeon does not support overlapping controlsin a DataWindow. Retrieved datain
the DataWindow column might be covered by a control (for example, the Text control) even
if this control is placed under the datafield in PowerBuilder.

Solution A: Remove all controls overlapping the data field. Work around the original
functionality with properties or functions.

Cause B: Appeon Server compresses the data file (.xml) to improve Web performance. Data
in the Datawindow is not displayed if the compressed .xml fileis not extracted successfully
on the Client.

Solution B: Verify that the following property exists in %JAGUAR%Y%\Repository\Server
\Jaguar.props (Windows) or $JAGUAR/Repository/Server/Jaguar.props (UNIX):

com.sybase.jaguar.server.filter-mapping=(url-pattern=/gzip/* ,description=adescription of
Test,filter-name=CustomA ddHeadersFilter)
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If the required property does not exist, the user needs to manually add it in Jaguar.props and
restart EAServer.

4.4.2 Unable to retrieve data from database
No datais retrieved into the Datawindow when running the Web application.

Cause A: If you are using the Sybase ASA/SQL Anywhere database, a possible reason is that
the Sybase ASA/SQL Anywhere version specified in the Transaction object is different from
what is specified in the data source. The application cannot find DataWindow objects and
failsto retrieve any data from the database.

Solution A: For Sybase ASA/SQL Anywhere, version 7.xx, 8.xx, and 9.xx are supported.
Appeon 6.x supports both dynamically mapping the Transaction object to the data source
in scripts, and statically specifying the data source in AEM. The user has to set the correct
Sybase ASA/SQL Anywhere version in DBParm or select the correct Sybase SQL ASA/
Anywhere version in AEM.

Cause B: If you are using the A SE database and find the following information in the
Appeon log, "Failed to retrieve datastore... Produced the following error: Select error: Stored
procedure'..." may be run only in unchained transaction mode. The 'SET CHAINED OFF
command will cause the current session to use unchained transaction mode.", alikely causeis
that the connection mode (chained or unchained) set up by the JDBC driver is not the same as
the mode of the stored procedure (chained or unchained).

Solution B: Y ou can modify the PowerBuilder source code using any of the following
workarounds to fix the problem.

* Execute"SET CHAINED OFF" before running stored procedures

» Execute "connection.setAutoCommit(true)" before running stored procedures

» Change the AutoCommit property to true before running each stored procedure

» Usethe"sp_procxmode <procname>, anymode" command to set the stored procedure to
run in chained or unchained mode.

Cause C: There are various factors that may cause this problem. Some examples include;
running an incompatible PowerBuilder version with Appeon, data sources, not running or
incorrectly configured, and missing INI files.

Solution C-1: If the application uses an INI file, verify the INI file is added to the Appeon
Developer application profile before deployment. Add the necessary INI file and redeploy the
application.

Solution C-2: If the problem is occurring with an Appeon provided demo application:

» Verify that the PowerBuilder version meets the requirements specified in the Appeon
Installation Guide.

» Verify that appeondb is running - a SQL Anywhere icon with the hover text " Appeondb”
displaysin the Windows Task Bar.

* Verify that EAServer has been started.
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» Loginto EAServer using EAServer Manager and verify that you can ping both the
"appeondb” and "appeonsample” data sources successfully. If the data sources cannot
be pinged successfully, refer to Fail to ping appeondb data source and Fail to ping
appeonsampl e data source for troubleshooting tips.

* Verify that "<data-cache>appeondb</data-cache>" exists in %JA GUARY\appeon
\repository\%instancenameYo\config\server-config.xml (Windows) or $JAGUA R/appeon/
repository/$instancename®/config/server-config.xml (UNIX).

Solution C-3: If the problem is occurring with all applications except the Appeon demo
applications, check the following:

» Verify that the PowerBuilder version meets the requirements specified in the Appeon
Installation Guide.

» Verify that the database used for your application is running correctly.
* Verify that EAServer isrunning.

* Login EAServer using EAServer Manager and verify that pinging the data source is
successful. If pinging the data source fails, perform the following steps (see Appeon Server
Configuration Guide for J2EE for detailed instructions):

» Verify the data source properties are correctly configured especially the server name,
username and password used to connect to the database.

* Make sure the JDBC radio button is checked in the Driver tab of the Data Source
Properties

» Make sure that the driver string is entered correctly. The string is case sensitive.
» Make sure that the "enable cache-by-name access' option is checked in the Cache tab.

» For an Oracle database, you may need to add the data source property
com.sybase.jaguar.conncache.check and have it set to select 1 from dual.

* |f using a data source with the iAnywhere JDBC driver, refer to Section 4.3.7.1, “Data
source parameters for SAP Sybase ASA/SQL Anywhere” in Appeon Server Configuration
Guide for J2EE and double-check the settings created.

* Verify the Transaction Object settings in Appeon Enterprise Manager are correct. For
detailed instructions on setting up AEM, refer to Appeon Server Configuration Guide
for .NET or Appeon Server Configuration Guide for J2EE.

» Make sure that the application has been added into the application list displayed in AEM
Console > Application > Transactions > Transaction Objects.

» Make sure that the application has the correct transaction object name(s) listed, and the
correct transaction object name(s) mapped to the correct data source(s). The transaction
object name is case sensitive.

4.4.3 Database lock
Tables in the database are aways locked.
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Cause: Because of the inherited features with Web architecture, the chances of the database
locking are indeed increased compared to client/server architecture. For example, on the web:
If there istoo much time from the beginning of Data base operations to Commit, a transaction
will consume database resources and increase the chances of the database locking.

Solution:
1. Placethe transactionsin server NV Os or database procedures for execution.

2. Break the transaction into smaller transactions. Commit each database operations so a
transaction does not take too much to Commit.

Refer to the following coding as an example:

W ndow open() ;

/I Profile appeonsanpl e

SQLCA. DBMs = " ODBC"

SQLCA. Aut oCommit = "Fal se"

SQLCA. DBPar m = " Connect String = ??DSN=AppeonSanpl e; U D=dba; PWD=sql "
CONNECT;

Commrand Button ch_1:

String Is_enplid, |Is_enplnane

Ls_enmplid = sle_1.text

DELETE enpl oyee WHERE s_enplid = :ls_enplid;
COW T;

DECLARE cur _enpl CURSOR FOR SELECT s_enplid, s_enplnane from enpl oyee; ;
OPEN cur _enpl ;
FETCH cur_enpl INTO :ls_enplid, :|s_enplnane;
DO WHI LE sql ca. sqgl code=0
Ddlb_1.additem("["+l s_enplic+"]"+l s_enpl nane)
FETCH cur_enpl INTO :|ls_enplid, :|s_enplnane;

LooP

CLCSE cur _enpl ;

Ddl b_1. sel ectiten(1)

Ddl b_1.triggerevent ("eventchanged")

COW T;
4.4.4 Data missing in some DataWindows
Data is missing from some DataWindows.

Cause: There areretrieval arguments used in DataWindow expressions, which are not
supported by Appeon.

Solution: Use Stored Procedure as the DataWindow data source, and put the expression in
the Stored Procedure.

4.4.5 DataWindows do not respond
During Web application runtime, DataWindows stop functioning.
Cause: The session has timed out.

Solution: Close the current Internet Explorer browser, open a new Internet Explorer browser
and run the demo again. Y ou may want to delay the session timeout or disable session
timeout, if the user session times-out frequently.
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4.4.6 Manipulation on BLOB files for ASE and SQL Anywhere
4.4.6.1 Manipulation on BLOB files for Adaptive Server Enterprise (ASE)

4.4.6.1.1 Blob size
To download BLOB data with a data size greater than 32 KB (the default), do the following:

* On Windows, set Text Size on the Advanced page of the Adaptive Server Enterprise
ODBC Driver Configuration window to be greater than the largest expected BLOB.

* On Linux, set the Text Size entry in the obdc.ini file to be greater than the largest expected
BLOB.

4.4.6.1.2 ASE ODBC settings

If your DB is ASE, then you can change the ASE ODBC settings for blob sizing. See the
following for more details:

http://dcx.sybase.com/1101/en/miserver enl11l/ml-basics-ase-5159304.html.

4.4.6.2 Manipulation on BLOB files for SQL Anywhere

When working against the SQL Anywhere database, Appeon Server has problemsin
handling the blob files or retrieving datain CrossTab Datawindow.

Cause: if your DB is Sybase SQL Anywhere 12 and you have installed Sybase SQL
Anywhere 12 on the machine, then when installing Appeon Server, Appeon will use the
Sybase SQL Anywhere 12 driver to connect to the SQL Anywhere 10/11/12 by defauilt.

Solution: you can use the following ways to switch the driver to the SQL Anywhere 11
database to connect to the SQL Anywhere 10/11/12, or you can uninstall the Appeon Server,
install the SQL Anywhere 11, and then install the Appeon Server with selecting SQL
Anywhere 11 driver engine.

Step 1: Backup and delete the files below in C:\inetpub\wwwr oot\appeon\AEM\bin.
* iIAnywhere.Data.SQL Anywhere.dl

* Server.dll

» code.key

Step 2: Make a copy of the files below in C:\inetpub\wwwr oot\appeon\AEM\Server DIl and
save the copies

* iAnywhere.Data. SQLAnywhere 11.dll

e Server _asall.dll

» code asall.key

as the following files below respectively into C:\inetpub\wwwroot\appeon\AEM\bin.

* iAnywhere.Data.SQL Anywhere.dl|
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o Server.dll

» code.key

4.4.6.3 Blob data cannot be correctly manipulated if it is over 4MB
The blob data cannot be correctly manipulated (update/get) if it islarger than 4MB.

Cause: By default, the maximum size of the to-be-manipulated blob datais 4096k, so you
cannot manipulate Blob data over 4MB with default settings.

Solution:

Step 1: Go to C:\Inetpub\wwwroot\appeon\AEM, and add the following highlighted codesin
the web.config XML file. By default, the value of the Execution Timeout is 100 seconds, and
the value of the Max Request Length is 4096K. Y ou can use larger value for the Execution
Timeout and the Max Request Length properties according to the specific needs.

<system.web>

<htt pRunti me executionTi neout =" 300" maxRequestLength = "10240" />

<httpHandlers>

Step 2: Restart the I1S server to make this change take effect.

4.4.7 Fail to parse the result meta of the Select statement

Retrieving datain Crosstab DataWindow fails with an error similar to "Failed to parse the
result meta of the Select statement, due to This column'’s data type cust_id requires the use of
an embedded SQL statement.”

Cause & Solution: refer to Manipulation on BLOB filesfor ASA/SQL Anywhere.

4.4.8 Fail to update data

Datain a Datawindow object isretrieved correctly but cannot be updated.

Cause: An older version of Internet Explorer is used on the Client PC.

Solution: Upgrade Internet Explorer to Internet Explorer 6.0 SP1 (6.0.2800 or above).

4.4.9 Fail to update dynamically generated DatawWindow

Dynamically generated DatawWindow cannot be updated.

Cause: Uses the former version of Microsoft SQL 2005 SP1 with MSFT JDBC Driver.
Solution:

Step 1: Replace the former version of Microsoft SQL 2005 SP1 with MSFT JDBC Driver
with the latest one, which can be downloaded at the Microsoft Website.

Step 2: Execute stores procedure SQL statement install_appeon_syntaxfromsgl_ MSSQL.sql
in SQL 2005 Database server in Appeon installation path %0AppeonHomeY/sql/dynamicsgl.

Step 3: Restart the Application Server.
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4.4.10 Update error #Failed to update database due to java.sql.SQLException...
cannot insert the value NULL...#

Updating data fails with an error similar to "Failed to update database due to
java.sgl.SQL Exception... cannot insert the value NULL j column does not allow nulls..."

Cause: The number of rowsthat atrigger in the database counts differs from the number of
the rows that the Update operation sends to the JDBC driver.

Solution: For SQL Server and A SE database with JIDBC driver, use the "SET NOCOUNT
ON" statement before executing SQL statements when you create a trigger object.

For example:

CREATE TRI GGER tri gger _name
ON { table | view}

[ WTH ENCRYPTI ON ]

{

{ { FOR| AFTER | INSTEAD OF } { [ INSERT ] [ , ] [ UPDATE ] }

[ WTH APPEND ] [ NOT FOR REPLI CATI ON ]

AS

set nocount on

[ { I'F SELECT ( colum )[ { AND | OR} UPDATE ( colum ) ][ ...n ]
| I'F ( COLUWNS UPDATED ( ) { bitw se_operator } updated_bitmask )
{ conparison_operator } colum_bitmask [ ...n ]} ]

Xsqgl _statement [ ...n ]

}
}
4.4.11 #Error converting data type A to B#

Executing a certain stored procedure is successful in PowerBuilder but gives an "Error
converting datatype A to B" error message on the Web, where A and B stands for different
datatypes.

Cause: The procedure contains an output parameter that is A, but the corresponding variable
used to call the procedureisaB. JDBC driver may handle such a case differently from the
ODBC driver or native driver used in PowerBuilder.

Solution: Make sure the type of the calling variable is exactly the same as the type of the
output parameter.

4.4.12 Fail to update DataWindows with newly entered Korean characters

After Korean characters have been entered into a DataWindow the update is not successful.
The following error message is displayed "Failed to update primary buffer".

Cause: The length of the Korean characters that are inputted is longer than the length
specified for the field in the database table.

Solution: Specify alarger value for the length of the field in the database table.

4.4.13 SelectBlob and UpdateBlob have different results for non-binary fields

The SelectBlob and UpdateBlob functions have different results on the Web from using
PowerBuilder, when some non-binary fields are manipul ated.
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Cause: In some conditions, PowerBuilder automatically removes the spaces before and after
the non-binary characters when using SelectBlob and UpdateBlob. However, such operation
does not occur to the Web, which leads to different results.

Solution: Appeon recommends you to directly use Select and Update functions to manipulate
Blob type fields.

4.4.14 How to solve the messy code issue when retrieving data in Oracle

If you run into the messy code issue when retrieving data in Oracle, please try the solutions
below:

Step 1: Set the NLS LANG (equal to the database server) on the machine where the Appeon
Server isinstalled.

Step 2: Go to the Register on both Oracle Server and the Server on which Appeon Server is
installed to check whether the NLS_LANG isthe same in the directory of:

HKEY_LOCAL_MACHINE>SOFTWARE _ORACLE.
Step 3: Try to use the following solution to check whether the Web application can solve the
Hebrew data issue.

1. Locate Web.config under C:\Intetpub\wwwroot\appeon\AEM on the machine with
Appeon Server installed.
2. Open Web.config with notepad and modify in the "globalization" line as shown below.

<gl obal i zati on request Encodi ng="utf-8" responseEncodi ng="utf-8"
ui Cul ture="auto" cul ture="auto"/>

3. Savethe changesto thefile.

4. Restart 11S.

4.5 Others

4.5.1 Appeon Performance Analyzer continually popping up

The Performance Analyzer window keeps prompting, saying "Installation Complete. Please
Start the Web application”, when starting the Appeon Performance Analyzer.

Cause: The enable third-party browser extensions* option of the Internet Optionsis
unavailable.

Solution: To solve this, go to I nternet Explorer > Tools > Internet Options > Advanced,
check the Enablethird-party browser extensions* check box under Settings, and then
click Apply or OK to save the settings, as shown in the figure below.
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Figure 4.25: Internet options

’Internet Dpticns @

I
| General | Security | F'rivel(\? | Content | Connections | Programs | Advanced [

Settings

Automatically recover from page layout errors with Compe
[ Close unused folders in History and Favorites*

Disable script debugging (Internet Explorer)

Disable script debugging (Other)

[] Display a notification about every script errar

Display Accelerator button on selection

Enable automatic crash recovery ™

Enable FTP folder view (outside of Internet Explorer)
Enable page transitions™

[ Enahle Suggested Sites

| Enable third-party browser extensions ™

[] Enable visual styles on buttons and controls in webpages
[T] Enable websites to use the search pane®

[] Force offscreen compositing even under Terminal Server
{ | [} 3

»

[ m

= v

*Takes effect after vou restart Internet Explorer

Restore advanced settings ]

Reset Internet Explorer settings

Resets Internet Explorer's settings to their default
condition,

You shaould anly use this if vour browser is in an unusable state,

It is selected by default; however check to make sure that it is selected before you start the
Appeon Performance Analyzer.

45.2 ASE Chained mode issue

A PowerBuilder application can execute A SE stored procedures successfully. However, when
the PowerBuilder application is converted to the Web, the following error may occur:

"Select error: Stored procedure 'dbo.up_edw001_001" may be run only in unchained
transaction mode. The 'SET CHAINED OFF command will cause the current session to use
unchained transaction mode".

Cause: There are three ASE stored procedure (SP) modes: chained, unchained and anymode.
There are two A SE transaction modes: chained and unchained. For Web applications:

1) If the transaction mode is chained, the SP running mode must be chained or anymode.
2) If the transaction mode is unchained, the SP running mode must be unchained or anymode.

3) If the transaction mode and SP mode do not match the requirementsin 1) or 2), the error
OCCuUrs.
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Solution: Appeon provides two stored procedures that help modify the modes of ASE
stored procedures to ensure that the stored procedures meet the requirementsin 1) or 2).
The following files are located in the "\sgl\asechain_sql" folder under the Appeon Server
installation directory.

» readme.txt
* install_appeon_rebuildchainmode.sql: modifies the modes of ASE stored procedures

 uninstall_appeon_rebuildchainmode.sql: restores the original modes of ASE stored
procedures

Follow the instructions in the "readme.txt" for the method of modifying the stored procedure
modes with the two SQL files.

4.5.3 Windows open relatively slow
While accessing the Web application, Windows open slowly.
Cause: The hardware does not meet the minimum requirements needed to install Appeon.

Solution: Verify that the hardware configuration meets the minimum requirements stated in
Installation Requirements in Appeon Installation Guide.

4.5.4 Web application is very slow if use SQL Anywhere 10 and Appeon Server
for .NET

When using Appeon Server for .NET, SQL Anywhere 10 users will encounter performance
difficulty in data manipulation.

Cause: The problem is caused by ADO.NET driver.

Solution: To resolve the performance issue you need to enable ODBC connection pooling in
ODBC DataSource Administrator with the instructions below:

Step 1: GO to Control Panel > Administrative Tools > ODBC DataSource Administrator
and Select the Connection Pooling tab page.

Step 2: Select SQL Anywhere 10 and click the Enable option in the PerfMon frame.
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Figure 4.26: Connection Pooling
£ 10DBC Data Source Administrator EE3 |

Idzer DSH I Syztern DSH I File DSM I Driversl Tracing Connection Pocling |.-i'-.l:u:-ut I
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ODBC Drivers:  Enable
I arne | ﬂ
Microgzaft QDBC for Oracle .
Microsoft Parados Driver [*.db | ' Disable
Microzoft Parados-Treiber [*.db ]
Microzoft Tewt Diriver [ bt *cev)
Microzaft Test-Treiber [t * cav]
Micrazoft Visual FosPro Driver — Betry Wwait Time——
ticrozaft Vizual FoxPro-Treiber
SUL Arywhere 10
SOL Server = 120
4| | 3

Caonnection poaling allows an application ta reuse open connection
handles, which saves round-trips to the zerver.

(] I Cancel | Apply | Help |

Step 3: Click the Apply button to make this configuration take effort.

Step 4: Double click the SQL Anywhere 10 and Enable Pool Connection for this driver as
shown below.

Figure 4.27: Set Connection Pooling Attributes

Set Connection Pooling Attributes Ed |

— SOL Arywhere 10
" Don't pool connections to this driver
' Pool Connections to this driver ﬂl

Time that unused connections remain in the pool

it zeconds: ||3|:|

4.5.5 ASA/SQL Anywhere engine crashes when you insert data into AppeonDB
ASA/SQL Anywhere engine crashes when you try to insert datato AppeonDB.
Cause: It may be caused by an SQL Anywhere bug.

Solution: Upgrade your ASA/SQL Anywhere 10 to the build 3835 or above, which you can
find at http://downl oads.sybase.com.

4.5.6 Server NVO cannot be activated when the Web application is running

The server NV O can be successfully activated when it runsin PowerBuilder. However, when
the application is converted to the Web, the server NV O cannot be successfully activated.
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Cause: This often occurs when the server NV O is being deployed and the Allow NULL
values in method parameter option is selected.

Solution: Please follow the steps below:
Step 1: Double click the componentobject and open the Properties pages.

Step 2: In the General tab page, unselect the "Allow NULL values in method parameter”
option and redeploy the NVO.

Step 3: Open the EA Server Manager, generate the stub and skeleton for the deployed NV O.
Step 4: Restart the EA Server and rerun the Web application.
Note: Refer to the Migration Guidelines for Appeon Web to deploy the server NVO.

4.5.7 An item which usually requires one click must be clicked twice to be
selected

When running a Web application, you need to click twice to successfully select an item,
such as, selecting aradio button on the download page, which normally should require only
one click. This problem occurs only at the first selection and in the following environment:
Windows XP or Windows 2003, and Internet Explorer SP2.

Cause: This problem exists with patch kb912945 and patch kb912812 of Internet Explorer
SP2.

Solution: Currently there is no better solution than uninstalling patch kb912945 and patch
kb912812.

4.5.8 Special characters in URL cause missing parameters when being
redirected

If special characters (+, /, #, ?, %, &, etc.) are contained in the URL, parameters after the
special character will be lost when the URL is being redirected.

Cause: This problem occursif index.html is used as the entry of application.
Solution: There are two solutions:

» Useindex.htm instead of index.html as the entry of the application. For example, http://url/
index.htm?parameter. Do not use http://url/index.html?parameter, or http://url/?parameter.

» Use MSDN to convert the special characters when inputting the URL.

4.5.9 Weblibrary and cedownloadcenter DLLs cannot be updated

After the Appeon EBF 1045 patch is applied to the Appeon Server, for some users, when
the Appeon Web application is accessed, the Weblibrary and cedownloadcenter DLL files
in the "C:\Windows\Dowloaded Program Files" directory are not updated to the Appeon for
PowerBuilder 6.5.1045.0 version.

Cause: The application URL must be started by the entry page (index.html or index.htm or /),
otherwise, the Appeon plug-in cannot be initialized properly.

Solutions. The problem can be solved by removing 'x32_application.htm' from the URL.
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5 Troubleshooting Appeon Server

This section contains general information regarding troubleshooting problems related to
Appeon Server and AEM - the Appeon Server Manager. |f you cannot resolve the problem
using the troubleshooting guide, please contact technical support at http://www.appeon.com/

support.

5.1 Loading AEM

5.1.1 AEM Web page cannot display or cannot display correctly in IE 9

When IE 9 isrunning in Compatibility View, AEM Web page displays correctly, but when
|E 9isnot running in Compatibility View, AEM Web page cannot display (returning a 406
error) or cannot display correctly.

Cause: The MIME type requested by |E 9 does not match with the MIME type specified
in the Web site. For example, in Windows 2003, the default MIME type for 11Sis".*
application/octet-stream”; when IE 9 isrunning in Compatibility View, it requested the
MIME type "*/*" when visiting the Web site, so it can successfully displays the Web page,
but when IE 9 is not running in Compatibility View, it requested the MIME type "text/css",
while thistypeis not specified in the Web site, so visits to file of this type are rejected.

Solution: Add aMIME type".csstext/css' in the Web site. Detailed steps are: open the l1S
Manager, right click the default Web site, select Properties from the popup menu, then click
the HTTP Header stab, and then click the MIME Types button to add aMIME type.

5.1.2 Cannot log into AEM in IE 10

When IE 10.0 is running in Compatibility View, AEM Web page displays correctly, but
when IE 10.0 is not running in Compatibility View, AEM Web page cannot display correctly
after you logged in with the correct user name and password.

Cause: An |E limitation.

Solution A: Run the IE 10 in Compatibility View to log into AEM.
Solution B: Install the following hotfix patch and then try again.
Click here to download and install the hotfix patch.

5.1.3 Server Error in '/Servlet' Application

AEM does not show up when accessing AEM in Appeon Server, and errors like " Server
Error in'/Servlet’ Application™ occur saying "The file '/servlet/logon.aspx’ has not been pre-
compiled, and cannot be requested.” or "Error occurred when loading c:\inetpub\wwwroot
\A ppeon\A EM\config\common.comfig file!", as shown in the following figures.
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Figure5.1: Server Error in'/Servlet' Application 1

i Favorites | @ Appeon Enterprise Manager (AEM) i v B ~ ) d® v Pagev Safety+ Tools+

Server Error in '/Servlet' Application.

The file ‘/serviet/Logon.aspx’ has not been pre-compiled, and cannot be requested.

Description: An unhandled exception occurred during the execution of the current web request. Please review the stack trace for more information about the error and where it originated in the code.
Exception Details: System.Web HttpException: The file Yserviet/Logon.aspx’ has not been pre-compied, and cannot be requested.

Source Error:

Zn unhandled exception was generated during the execution of the current web request.

Information regarding the origin and location of the exception can
be identified using the exception stack trace below.

Stack Trace:

[HttpException (0x80004005): The file "/servlet/Logon.aspx’ has not been pre-compiled, and cannot be requested.]
System. Web. Compilation. BuildManager. GetVPathBui1dResultInternal (VirtualPath virtualPath, Boolean noBuild, Boolean allowCrossApp, Boolean allowBuildInPrecompile) +826
System. Web.Compilation. Buildvanager. GetVPathBuildResultwithNoAssert(HttpContext context, VirtualPath virtualPath, Boolean noBuild, Boolean allonCrossApp, Boolean allowSuildInPre
System. Web.Compilation. BuildManager. GetVirtualPathObjectFactory(virtualPath virtualPath, HttpContext context, Boolean allowCrossApp, Boolean noAssert) +175
System. Web.Compilation. Buildvanager. CreateInstanceFromVirtualPath(virtualPath virtualPath, Type requiredBaseType, HttpContext context, Boolean allowCrossApp, Boolean noAssert) -+
System. Web. UL.PageHandlerFactory. GetHandlerHelper (HttpContext context, String requestType, VirtualPath virtualPath, String physicalPath) +50
System. Web. HttpApplication.MapHttpHandler (HttpContext context, String requestType, VirtualPath path, String pathTranslated, Boolean useAppConfig) +503
System. Web.MapHandlerExecutionStep. Systen. Web. HttpApplication. IExecutionStep. Execute() +142
System. Web. HttpApplication. ExecuteStep(IExecutionStep step, Booleand completedSynchronously) +263

Version Information: Microsoft NET Framework Version:2.0.50727.5456; ASP.NET Version:2.0.50727.5456

Figure5.2: Server Error in'/Servlet' Application 2
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Server Error in '/Servlet' Application.

Error occurred when loading C:\inetpub\wwwroot\Appeon\AEM\config\common.config file!

Description: An unhandied exception occurred during the execution of the current web request. Please review the stack trace fer more information about the error and where & originated in the code.

Exception Details: Appeon AEM.UtLAppeonConfiginiException: Error occurred when loading C \pp . config fie!

Source Error:

An unhandled exception was generated during the execution of the current web request. Information regarding the origin and location of the exception can be
identified uaing the exception stack trace below.

Stack Trace:

[AppeonConfigInitException: Error oceurred when Toading €:\inetpub\wwwroot)\Appeon\ABM\config\common. config File!]
Appeon, AEM, U1, ABMUti 15, LoadConfig(String path) +226
Appeon. ABM. Conf'ig. CommonConifg. get_Default() +132
Appeon, AEM, Globals. . cctor () +356

[TypelnitializationException: The type initializer for 'Appeon.AEM.Globals' threw an exception.]
Appeon. AEM. Config. ServerConfig. get_Default() +64
Appeon. Server, SessionManage. SessionChecker. .cctor () +20
[TypelnitializationException: The type initializer for 'Appeon.S:rvékstssiDnﬂ&nd@z.sess\'unchecker' threw an exception.]

Appeon. Server. SessionManage. SessionChecker. GetInstance() +0
AEM,Global.Application_Start(Object sender, EventArgs &) +33

Version Information: Microsoft NET Framework Version2 0.50727 3603; ASP NET Version:2.0 50727.3601

Figure5.3: Server Error in'/Servlet' Application 3

Server Error in '/Servlet' Application.

The file /serviet/Logon.aspx’ has not been pre-compiled, and cannot be requested.

Description: An unhandied exception occurred during the execution of the current web request. Please review the stack trace for more information about the error and where it originated in the code.
Exception Details: System Web.HttpException: The file UservietLogon.aspx’ has not been pre-compled, and cannot be requested.

Source Error:

Zn unhandled exception was generated during the execution of the current web request.

Information regarding the origin and location of the exception can be
identified using the exception stack trace belew.

Stack Trace:

[HttpException (0xB0004005): The file '/servlet/Logon.aspx’ has not been pre-compiled, and cannot be requested.]
System. Web. Compilation. Bui ldManager. GetVPathBuildResultInternal (VirtualPath virtualPath, Boolean noBuild, Boolean allowCrossApp, Boolean allowBuildInPrecompile) +8784254
System. Web. Compi lation. Bui ldManager . GetVPathBuildResultiithNoAssert (HttpContext context, VirtualPath virtualPath, Boolean noBuild, Boolean allowCrossApp, Boolean allowBuildInPrecor
System. web. Compilation. BuildManager. GetvirtualPathobjectFactory(VirtualPath virtualPath, HttpContext context, Boolean allowCrossApp, Boolean noAssert) +126
System. Web. Compilation. BuildManager. CreateInstanceFronVirtualPath(VirtualPath virtualPath, Type requiredBaseType, HttpContext context, Boolean allowCrossApp, Boolean noAssert) +62

System.Web.UI. PageHandlerFactory. GethandlerHelper (HttpContext context, String requestType, VirtualPath virtualPath, String physicalPath) +33
System.Web.UI. PageHandlerFactory. System. Web. IHttpHandlerFactory2. GetHandler (HttpContext context, String requestType, VirtualPath wirtualPath, String physicalPath) +40
System.Web. HttpaApplication.MaphttpHand]er (HttpContext context, String requestType, VirtualPath path, String pathTranslated, Boolean useAppConfig) +160

System. Web.MapHand] erExecutionStep. System. Web. HttpApplication. IExecutionStep. Execute() +93
System. Web. HttpAppTication. ExecuteStep(IExecutionStep step, Boolean& completedSynchronously) +155

Version Informati:

Microsoft NET Framework Version:2.0.50727.5456; ASP.NET Version:2.0.50727 5456
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Figure5.4: Server Error in'/Servlet' Application (configuration error)

& Appeon Enterprise Manager (AEM) - Windows Tniemet Explore T e R
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Il Server Error in '/Servlet' Application.

Configuration Error

juring the processi lease review the specific error details below and modify your configuration file appropriately.

Line 119: Set the compilation Debug mode to true will insert the debugging symbols (.PDB information) to the to-be-compiled pages, which will make the pages become big and result in slow performance, therefor|
Line 120: -

Line 121: <compilation defaultlanguage="c#" debug="false" targetFramework="4,0">

Line 1223 <compilerss

Line 123: <compiler language="c#" type="Microsoft.Csharp.CSharpCodeProvider, System, Version=2.0.0.0, Culture=neutral, PublicKeyToken=B77ASC561934E089" extension=".cs" compiler0ptions="/d:DEBUG;T|

Source File: ClawebalappeoniAEweb config ~ Line: 121

Version Information: Wicrosoft NET Framework Version:2.0.50727 5420; ASP.NET Version:2.0.50727.5420

Done J/ Trusted sites | Protected Mode: Off Gv ®woox v |

Cause A: The user does not have enough permission.

Solution A:

Step 1: Grant proper rightsto .Net Framework with the two commands in the CMD window.
1. Navigate to C:\WINDOWS\Microsoft. NET\Framework\v2.0.* ***

2. Execute the command line "aspnet_regiis -ga users’.

3. Execute the command line "aspnet_regiis-i".

4. Restart the 11S (resetiis.exe).

Step 2: Grant Internet Guest Account and 1S Process Account proper rights to manipulate the
Web Root folder.

1. Go to the C:\Inetpub folder, then right click the wwwroot folder, and then select the
Security tab under the Propertiesitem.

2. Add IIS_WPG group, if it isnot listed in the "Group or user names" box.
3. Allow the IIS_WPG group to get the Full Control permission.

4. Restart the 1S

Step 3: If these errors still occur, please re-install the Appeon Server.

Cause B: The Identity of Process Model of AppeonAppPool in 1S manager is not the
L ocal System.

Solution B: Configure the Process Model settings of the AppeonAppPool in 1S manager.
Step 1: Open || S manager.
Step 2: Click AppeonAppPool, and then click Advanced Settings.

Step 3: Change the Process M odel from "NetworkService" to "L ocal System™ as shown in the
following figure.
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Figure 5.5: Process M odel
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The changed setting is as shown in the figure below.
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Figure 5.6: Process Model - Identity
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Cause C: 1S settings should be different according to 32-bit OS or 64-bit OS.
Solution C:

If you are using 32-bit OS, go to I1S manager > Application Pools > AppeonAppPool
> Advanced Settings, in the Advanced Settings window, make sure the 'Enable 32-bit
application' is set to "True'.

If you are using 64-bit OS, go to 1S manager > Application Pools > AppeonAppPool
> Advanced Settings, in the Advanced Settings window, make sure the 'Enable 32-bit
application' is set to 'False'.

Cause D: The config fileis not the machine.config.default (NET* only).

Solution D:

Step 1: Use the machine.config.default to replace the machine.config. Both of them are
located at Windows\Microsoft.NET\framework\v2.0.xxxxx\CONFIG.

Step 2: Login to AEM and do corresponding modification according to the prompits.
Step 3: Delete dl filesin %A ppeon%/AEM/bin/config.
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Step 4: Re-log in to the AEM to make sure the problem is resolved.

Cause E (Figure: Server Error in'/Servlet' Application (configuration error)): The .NET
framework version or the ASP.NET version is not matched with the upgraded A ppeon for
PowerBuilder.

This error probably occurs when you launch AEM or AEM with multiple instances after you
upgrade your Appoen for PowerBuilder 6.x to Appeon for PowerBuilder 6.6.x.

Solution E:

e For 1S 7.0 and later:

Step 1: Open 11S Manager by choosing Start > All Programs > Appeon for
Power Builder 2013 R2 > Appeon Server for .NET > Internet Information Services
(I'S) Manager .

Step 2: Expand your computer (for example, WANGMINGLI-PC (wangmingli-pc
\wangmingli in the following figure), and then click Application Pools.

Figure5.7: Application pools
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Step 3: Select the application pool in the Application Pools panel, and then click Basic
Settingsin the Actions panel. The Edit Application Pool window appears.

In the Edit Application Pool window, select the matched .NET Framework version (.NET
Framework v4.030319) from the NET Frame version dropdown list box, and then click
OK to save the changes.
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Figure5.8: Edit application pool

Edit Application Pool L2 |

AppeonAppPool_AWEE

MET Framework version:

JMET Framework w4.0.30319 -

Managed pipeline mode:

Classic T|

Start application pool immediately

| OK | | Cancel

Step 4: Relaunch your AEM.

e ForllS6.0:

Step 1: Open 11S Manager by choosing Start > All Programs > Appeon for
PowerBuilder 2013 R2 > Appeon Server for .NET > Internet Information Services

(11S) Manager.

Step 2: Expand your computer (for example, WANGMINGLI-PC (wangmingli-pc
\wangmingli in the following figure), click Web Sites, and then select your web site (for
example, web81).
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Figure5.9: I1'S manager

:[, Internet Information Services (I1S) Manager -0l x|
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© ) aspr Permissions
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B ) Web Service Hew
&ll Tasks
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Mew Sindow From Here
Delete
Refresh
Export Lisk, ..
Properties
4| | i3
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|Open5 property sheet Foree

Step 3: Right-click AEM, and then select Properties from the popup menu.

Inthe AEM Properties window, select the matched ASP.NET version (4.030319) from
the ASP.NET version dropdown list box, and then click OK to save the changes.
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Figure5.10: AEM properties

YWirkual Direckary: | Docurents I Directory Security |
HTTF Headers | Custom Errors ASP.NET

S5SP.MET wersion:

Yirtual path:

File lacation: Z:web3 1 appeont AEMIAEMR oL web, config
File creation date: Dake nok available,

File last maodified: Dake nok available,

Edit Configuration. .. |

Ik Cancel apply | Help

Step 4: Repeat Step 3 to specify the ASP.NET version for Appeon and Ser ver let
respectively.

Step 5: Relaunch your AEM.

5.1.4 Object reference not set to an instance of an object

When running AEM, Web page displays the error "Object reference not set to an instance of
an object”, as shown in figure below.
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Figure 5.11: Object reference not set to an instance of an object
& AEM Logon - Windows Internet Explorer =& =]
@\;‘ - ‘& http://localhost/AEM/ = ‘ "l X HLMSMM 2

ﬁ—&[@‘“w Bass I:I—ﬁlv < = v [ Pege v (}Tooks v
. — @l Help
% Appeon Enterprise Managegmre )

General | Seaurity | Privacy | Content | Connections | Programs | Advanced |

Home page
Encounter Unexpected Error  |Encounter Unexpected Error
P! P /’ To create home page tabs, type each address on its own line.
lag]
- hittp://www.hao222.com/indexb. htm?tn=tt98com_ha | anauage Preference
Error Message: Error Message: = E=
7| Lenguage Preference
Object reference not set to an in Object reference not set to an insta Add the languages you use to read websites, listing in order of
[[Usearrent | [ usedeaut ][ usebiank Only add the ones you need, as some characters can
Srowsing history be used to mpersonate websites in other languages.
417 Delets temporary fies, history, cookies, saved passwords, Language:
¥ and web form information,
Move up
[ ockte... ][ seting —r
Search

p Change search defaults. Settings Remove
Tabs

1| Change how webpages are displayed in Settings Prefix and suffix options
o

[£10e notadd ‘www' to the beginning of typed web addresses

Specify the suffix (for example .net) that should be added to
typed web addresses when you press Ctrl +Shift +Enter.

Suffix:

Appearance

[ cors | [ Longuages || Fents | | Accessiity

- Trusted sites | Protected Mode: Off #100% ~

=

(e FTESN WEFe 9

Cause: The language settings of 1E Internet Options is empty.

Solution: Add alanguage to the language settings of 1E Internet Options, as shown in figure
below.

Figure5.12: Language Preference

Language Preference @

Language Preference

Add the languages you use to read websites, listing in order of
preference. Only add the ones you need, as some characters can
be used to impersonate websites in other languages.

Language:
English {United States) [en-U5]

Mave up
Move down

Femove

Prefix and suffix options

[] Do not add "www' to the beginning of typed web addresses

Spedfy the suffix (for example .net) that should be added to
typed web addresses when you press Ctrl + Shift + Enter.

Suffix

I QK | [ Cancel
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5.1.5 Fail to pre-compile AEM
Pre-compiling AEM fails.
Cause & Solution: Refer to Demo Web application failsto cal EJB component.

5.1.6 The AEM Web page cannot be displayed

Unable to access AEM's Web page.

Cause A: EAServer isnot running

Solution A: Verify that EAServer is running and accepting connections
Cause B: The URL for AEM isincorrect

Solution B: The URL format should be http://hostname: portnumber/AEM. Verify that the
hostname is correct and that the portnumber is available. They are specified through the
appeonserver http listener in EAServer Manager.

The appeonserver http listener and the appeonserveriiop listener are created automatically
with Appeon Server installation. If they are not created successfully or not configured
correctly, they need to be manually added or modified.

If the problem is not resolved, please check whether the Jaguar.log is empty (at %JAGUAR
%\bin\ in Windows or $JAGUAR/bin/ in UNIX). If the Jaguar log is empty, refer to Cause C
and Solution C to rectify the problem.

Cause C: there are two possible causes for the problem:
The EAServer hosting AEM is not running correctly.

The application.properties file (at %JA GUARY\Repository\WebA pplication\AEM\WEB-
INF\classes\resources\ in Windows or $JAGUAR/Repository/WebA pplication/AEM/WEB-
INF/classes/resources/ in UNIX) has not been successfully loaded into the Internet Explorer
browser (which usually happensthefirst time AEM is started).

Solution C: follow the steps below to fix the problem.
Step 1: Restart EAServer and verify that it is accepting connections.
Step 2: Verify that at least one of the Appeon Web demo applications can run correctly.

Step 3: Launch AEM with Internet Explorer. If AEM is not loaded successfully, please click
the Refresh button in the browser to load the application.propertiesfile.

5.1.7 Error #500 Servlet jspservlet: ...#

When the user enters the AEM URL in Internet Explorer, an error message box pops up:
"500 Servlet jspservlet: unable to service request: Cannot find message resources under key
org.apache.struts.action.MESSAGE".

Cause: The AEM program cannot access the URL directly (for example,
http://hostname: portnumber/AEM/logon.jsp) without initializing .jsp files.

Solution: Access AEM at the URL http://hostname: portnumber/AEM (for example, http://
localhost: 9988/AEM).

5.1.8 Fail to log into AEM with the default user name and password
Cannot log into AEM with the default user name and password.
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Cause: you may have changed the login username and password of the AEM when you
installed Appeon Server.

Solution: Use the username and password specified when you install Appeon Server.

If you want to restore the default settings, follow the two methods bel ow:

1. Reinstall Appeon Server. During the reinstallation, do not change the login username and
password of AEM.

2. Revise the aem-config.xml filein the "...\Sybase\EA Server\appeon\repository\
%instancename¥o\config\" folder: replacing the 7th line in the file with the line <user
name="Y WRtaw4=" password="Y WRtaW4="/>, then restarting Appeon Server to make
the changes take effect.

5.1.9 Security settings in AEM do not take effect
Cause: Configured Security settingsin AEM incorrectly.

Solution: The following settings in AEM enable application security so that only assigned
users can open the application. Users need to input user name and password when logging
into the application.

Step 1- Goto AEM > Server > Server Security > User Management and add User Name
and Password.

Step 2- Goto AEM > Server > Server Security > Group Management and add Group and
then assign users to the group.

Step 3- Goto AEM > Application > Client Security > User Authentication and click your
application. Select "Security On" in User authentication.

Note: Make sure your settings are configured efficiently and clear the history in Internet
Explorer before opening the application. Restart EA Server and client machine if necessary.

5.2 Appeon Server

5.2.1 Error 10999 - Failed to start new transaction...

Failed to start new transactions when updating the data by using JBoss as the application
server and an error (error 10999) box pops up saying "Failed to start new transaction due to
com.appeon.server.controller.ControllerException: javax.naming.NameNotFoundException:
TransactionServicelL ocal not bound” as shown in the figure below.
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Figure5.13: Error 10999 - failed to start new transaction

| Error 10999 ] |

_"‘-.I Failed to start new transaction due to

& com.appeon.server.controller.ControllerException:
javax.naming.MameMNotFoundException: TransactionServicelLocal not
bound

OK

Cause: Thisisaknown issue for using JBoss 5. Y ou may encounter the following errors
when JBoss is deploying the internal /b component and saving the configuration filesinto
the internal database localDB.script, which will result in gjb deployment failure, during
launching the JBoss. In this situation, you will encounter the above "Error 10999..." error
during updating the datain Appeon for PowerBuilder.

Troubleshooting Page 84



Troubleshooting Appeon Server Appeon® for PowerBuilder® 2013 R2

Caused by: org. hsql db. Hsqgl Excepti on: | ength nmust be specified in type definition:
VARBI NARY

at org. hsqldb.error.Error. error(Unknown Source)

at org. hsqldb.error.Error. error(Unknown Source)

at org. hsql db. Par ser DQL. r eadTypeDef i ni ti on( Unknown Sour ce)
at org. hsql db. Par ser DDL. r eadCol ummDef i ni ti onOr Nul | (Unknown Sour ce)
at org. hsql db. Par ser DDL. conpi | eCr eat eTabl eBody( Unknown Sour ce)
at org. hsql db. Par ser DDL. conpi | eCr eat eTabl e( Unknown Sour ce)
at org. hsql db. Par ser DDL. conpi | eCr eat e( Unknown Sour ce)
at org. hsql db. Par ser Command. conpi | ePart (Unknown Sour ce)
at org. hsql db. Par ser Command. conpi | eSt at ement s( Unknown Sour ce)
at org. hsql db. Sessi on. execut eDi r ect St at enent ( Unknown Sour ce)
at org. hsql db. Sessi on. execut e( Unknown Sour ce)

DEPLOYMENTS | N ERROR:
Depl oynment " <UNKNOWN j boss. j 2ee: j ar=profil eservi ce-
secur ed. j ar, name=Secur ePr of i | eServi ce, servi ce=EJB3>" is in error due to the
follow ng reason(s): ** UNRESCOLVED Denmands 'j boss. ej b: servi ce=EJBTi ner Ser vi ce'
** ** UNRESOLVED Denands 'j ndi: Secur eManagenent Vi ew r enot e-
org.j boss. depl oyers. spi . nanagenent . Managenent Vi ew **

Depl oynent "j boss. ej b: persi st encePol i cy=dat abase, servi ce=EJBTi ner Servi ce" is in
error due to the follow ng reason(s): org.hsql db. Hsql Exception: |ength nust be
specified in type definition: VARBI NARY, **ERROR**

Depl oynment " <UNKNOWN j boss. j 2ee: j ar=profil eservi ce-

secur ed. j ar, name=Secur eManagenent Vi ew, servi ce=EJB3>" is in error due to the
followi ng reason(s): ** UNRESCOLVED Dermands 'j boss. ej b: servi ce=EJBTi ner Servi ce' **

Depl oynment " <UNKNOWN j boss. j 2ee: j ar=profil eservi ce-

secur ed. j ar, name=Secur eDepl oynent Manager, servi ce=EIJB3>" is in error due to the
follow ng reason(s): ** UNRESCOLVED Demands 'j boss. ej b: servi ce=EJBTi ner Servi ce' **

2013-05-14 14:37:58,718 | NFO [org.apache.coyote. httpll. HtpllProtocol] (main)
Starting Coyote HTTP/ 1.1 on http-127.0.0.1-8080

2013-05-14 14:37:58,734 I NFO [org.apache.coyote. ajp. Aj pProtocol] (nmain) Starting
Coyote AJP/ 1.3 on aj p-127.0.0. 1-8009

2013-05-14 14:37:58,734 INFO [org.jboss. bootstrap. nm crocontainer. Server| npl |
(rmain) JBoss (M crocontainer) [5.1.0. GA (build: SVNTag=JBoss_5 1 0 _GA
dat e=200905221053)] Started in 34s:266ns

2013-05-14 14:37:59, 140 I NFO [STDOUT] (Thread-17)

Appeon Server (Appeon for PowerBuil der 2013 Edition) started.

2013-05-14 14:37:59, 140 | NFO [STDOUT] (Thread-17) Edition: Unlicensed Edition
(Appeon)

2013-05-14 14:37:59, 140 I NFO [STDOUT] (Thread-17) Universal Product Key: APFA-

DEWN- NTEN- UNTT- TTTT-TTTT-TTTT

2013- 05-14 14:37:59, 140 I NFO [STDOUT] (Thread-17) Universal Maxi mum Sessions: *

2013-05-14 14:37:59, 140 I NFO [STDOUT] (Thread-17) Universal Maxi mum Depl oyed
Appl i cations: *

2013-05-14 14:37:59, 140 | NFO [STDOUT] (Thread-17) Days Remai ni ng: 45

2013- 05-14 14:37:59, 140 I NFO [STDOUT] (Thread-17) Nunber of CPUs Licensed: *
2013-05-14 14:37:59, 140 INFO [STDOUT] (Thread-17) Server |ID: Kg==

2013-05-14 14:37:59, 140 INFO [STDOUT] (Thread-17) Activation Status: UNACTI VATED
2013-05-14 14:37:59, 140 | NFO [STDOUT] (Thread-17) Support Date:
2012-07-20~2013-07- 20

2013-05-14 14:37:59, 140 INFO [STDOUT] (Thread-17) Custering Option: Yes

2013- 05-14 14:37:59, 140 I NFO [STDOUT] (Thread-17) Nunber of Cores Per CPU. *

2013- 05-14 14:37:59, 140 I NFO [STDOUT] (Thread-17) Type of CPU Licensed: Logic
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Solution: To resolvethis, refer to https://community.jboss.org/message/585994.

5.2.2 JBoss console reports #...Stopped deployment appeonserver.jar...# error

The JBoss server console reports the "...Stopped deployment appeonserver.jar..." error (see
figure below) during the startup process.

Figure5.14: Terminal

Terminal

File Edit View Terminal Tabs Help

B9:59: 18,588 INFO [org.jboss.as.server.controller] (DeploymentScanner-threads -
2) Deployment of "appeonserver.ear" was rolled back with failure message Operat

ion cancelled

09:59:19,043 INFO [org.jboss.as.server.controller] (DeploymentScanner-threads -
2) Deployment of "sqgljdbcd.jar" was rolled back with no failure message

©9:59:19,045 ERROR [org. jboss.as.deployment] (DeploymentScanner-threads - 1) Did
not receive a response to the deployment operation within the allowed timeout p

eriod [60 seconds]. Check the server configurationfile and the server logs to fi

nd more about the status of the deployment.

09:59:21,202 INFO [org.jboss.as.server.deployment] (MSC service thread 1-1) Sto

pped deployment sqljdbcd.jar i1n 2150ms

09:59:26,756 INFO [org.jboss.web] (MSC service thread 1-2) registering web cont

ext: SAFM

B9:59:27,859 INFO [org.jboss.as.server.deployment] (MSC service thread 1-2) Sto

pped deployment appeonserwver.jar in 8791ms

B9:59:27,922 INFO [org.jboss.as.server.deployment] (MSC service thread 1-2) Sto

pped deployment appeonservlets.war in 8854ms

B9:59:27,924 INFO [org.jboss.as.server.deployment] (MSC service thread 1-2) Sto

pped deployment appeon.war in B8856ms

B89:59:29,779 INFO [org.jboss.as.server.deployment] (MSC service thread 1-2) Sto

pped deployment AEM.war in 10718ms

B9:59: 30,246 INFO [org.jboss.as.server.deployment] (MSC service thread 1-2) Sto

pped deployment appeonserver.ear in 11195ms

Cause A: Thereis not enough space |eft on the hard drive. Usually this will be explicitly
indicated by the following message in the log file:

Caused by: java.io.|OException: No space |eft on device

Solution A: Stop JBoss server. Clean up the temporary files under JBoss server (typically,
%JBOSS_HOM E%\standal one\tmp) or clean up the hard drive to get more available space.

Cause B: The deployment has timed out. Usually you will see the following message in the
log file:

"Did not receive a response to the depl oynent operation within the allowed tineout
peri od [ 60 seconds].

Check the server configurationfile and the server logs to find nore about the
status of the depl oynent."

Solution B: Increase the timeout value for deployment in JBoss AS by the following steps:

Step 1: Open the %JBOSS HOM E%\standal one\configuration\standalone.xml filein atext
editor.

Step 2: Locate and modify the "deployment-timeout” setting under the "subsystem™ element.
The default value is 60 seconds.
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<subsystem xm ns="urn: j boss: domai n: depl oynent - scanner: 1. 0" >
<depl oynent - scanner nanme="default" pat h="depl oynent s"
scan-enabl ed="true" scan-
i nterval ="5000" relative-to="jboss.server.base.dir" depl oynent-ti nmeout="600"/>

5.2.3 JBoss console hangs during startup process
The JBoss server console hangs during the startup process.
Solution:

Step 1: Go to the %IJBOSS HOM E%\standal one\depl oyments\ folder and delete any file with
a .failed extension, for example, appeonserver.ear.failed.

Step 2: Clean up the temporary files under the %JBOSS HOM E%\standal one\tmp\ folder.
Step 3: Restart JBoss server.

5.2.4 #Remote connection failed: java.io.lOException: Message data for non-
existent channel#

After you operated on the Transaction Object page in AEM, for example, you clicked the
link of the application name or the Update or Test button on the Transaction Object page,
you will find the following error displayed in the JBoss console or the JBoss server log
file. Thisisabug in JBoss AS 7.0.2 (for more, please see http://community.jboss.org/
message/641888#641888). However, this error will not have any impact to Appeon Server,
therefore, you can simply ignoreit if you confirmed that this error occurs only after you
operate on the AEM >Transactions > Transaction Objects page.

00: 40: 53,301 I NFO [org.xnio.nio] (pool-4-thread-1) XNIO N O I npl enent ati on
Version 3.0.0.Beta3

00: 40: 55,219 ERROR [org.jboss.renoting.renpte] (XNIO NIO Read 1) JBREMD0200:
Renot e connection fail ed:

java.io.| CException: Message data for non-existent channel

00: 41: 06, 290 ERROR [org.j boss.renoting.renpte] (XNIO Nl O Read 5) JBREMD0200:
Renot e connection fail ed:

java.io.| CException: W ndow open for non-existent channel

00: 41: 06, 606 ERROR [org.jboss.renoting.renpte] (XNIO Nl O Read 6) JBREMD0200:
Renot e connection fail ed:

java.io.| CExcepti on: W ndow open for non-existent channel

00:41: 17,287 ERROR [org.jboss.renoting.renpte] (XNIO Nl O Read 8) JBREMD0200:
Renot e connection fail ed:

java.io.| CExcepti on: W ndow open for non-existent channel

5.2.5 AEM cannot access WebSphere data sources when global security is on

If the global security modeis turned on in WebSphere, AEM will not be able to access the
WebSphere data sources.

Solution: Y ou can take the following steps to work around the problem.

Step 1: Go to the %user.install.root%\properties directory (Youser.install.root% indicates the
WebSphere instance installation directory, for example, C:\Program Files\IBM\WebSphere
\AppServer\profiles\AppSrv01\), open the sas.client.props file in text editor, and modify the
following three properties:

» com.ibm.CORBA .loginUserid: set to the WebSphere account username.

» com.ibm.CORBA .loginPassword: set to the WebSphere account password.
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» com.ibm.CORBA .securityServerPort: set to the WebSphere I10P port, if it is not the
default port 2809. This port number is modified by using the BOOTSTRAP_ADDRESS
property in the WebSphere console (as shown below).

Figure 5.15: WebSphere console
(2 Integrated Solutions Console - Windows Intermet Explorer
@_H - e

W G takegroked Schtors Console

Integrated Solitions Consale  Welcome appeon

view: [All tasks -

B Guided Activities
Bl Servare

Application servers > surverd > Ports

< Far fiald halp information,
Spedfies the TCR/IP ports this sarver uses for connactions.

salact & fiald labal or list
m

<2

ou can administar the following resources:

BOOTSTRAP ADDRES: Fsningehae 2803 No assocated transports

| MUTUALAUTH LISTENES ADORESE | fanyingshao 9402 Ho assocated transparts

B Systam sdministration SEIv2 5L SERVERAUTH LISTENCE ADDRESS 3403 Ho assodated transports

B Users and Groups:
Moitoring an d Tuing

${LOCALHOST_NAME} 9633 Ho assodated transports

rt:
fanyingchao s100 fo associated transports
e

i ey s M 0 s Y |

Yimy azigciated
Sangparts

[ i3 @ inteemet | Protected Made: OFF RI00% +

Step 2: Save changes in sas.client.props and then restart WebSphere.

Note: After making the above changes, everytime when a data source is created, you will
need to restart WebSphere so the new data source is accessible to AEM.

If the global security modeis turned off, you will need to remove settings of

com.ibm.CORBA .loginUserid and com.ibm.CORBA .loginPassword from the sas.client.props
file.

5.2.6 Appeon Server is dead when dynamically creating a DataWindow

When dynamically creating a DataWindow, the CPU usage in server reaches 100% and the
server cannot respond unlessiit isrestarted. The log file records nothing after the message:

"[com.appeon.server.command.DynamicDWCommand (execute)] Begin to parse and syntax
from sgl-statement”.

Cause: The Appeon stored procedure "sp_appeon_syntaxfromsqgl” has a parameter
"tableColumnList" with avalue of "varchar(4000)", which limits the total length of all
columns to 4000 characters. If the total length exceeds this limit, the stored procedure will be
trapped in an endless [oop.

Solution:

1) Open the "install_appeon_syntaxfromsgl_XXX" file at %appeonserverd\sgl\dynamicsql,
and locate the following lines of script:

create procedure dbo. sp_appeon_synt axfronsqgl (
@ abl eCol ummLi st var char (4000),

@ abl eLi st var char (2000),

@xtralList varchar(40)="1" )

2) Set the "tableColumnList" parameter to a proper value, such as "varchar(8000)".
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5.2.7 Appeon Server responds to user requests slowly

It takes time to compile at Appeon Web application startup. However, during application
runtime, it seems that Appeon Server still responds slowly.

Cause A: An excess of temporary files or very large Appeon log files can slow down Appeon
Server's performance.

Solution A: Follow the steps below to fix the problem:

Step 1: In AEM, open AEM Console > Server > L ogging, and then check whether the
Never replace log files option is checked. If it is checked, go to the log file directory:

\A ppeon\Devel oper2013R2\Project\ApplicationName\Debug(or Release)\L og\ and manually
delete thelarge log files.

Step 2: Clean up al temporary filesin AEM Console > Server > Resour ces >
Maintenance.

Cause B: A large number of dead sessions or transactions will consume server resources, and
affect performance.

Solution B: Kill the dead sessions and roll back the dead transactionsin AEM Console >
Server > Sessions > Active Transactions.

5.2.8 AEM cannot interface with a particular Appeon Server
Unable to connect to a desired Appeon Server with AEM.

Cause: The Appeon Server has not been added into the Appeon Server Cluster in AEM or
has not been configured correctly.

Solution: Follow the steps below to fix the problem.

Step 1: Verify that Appeon Server has been added to the Appeon Server cluster in AEM
Console > Server > Resour ces > Cluster.

Step 2: Verify the correct IP Address or Machine Name of the Appeon Server has been
entered.

* Usethe actual machine name instead of "localhost" for Machine Name.

* In EAServer Manager, choose EAServer Manager > Servers > AppeonServer Name
> Listeners, and verify that an HTTP (or HTTPS) listener profile has been added with
"Hostname" set as the IP address or machine name of the Appeon Server.

5.2.9 #Failed to load the remote interface# error

After Appeon Server isinstalled and started, AEM cannot start, and the Internet Explorer
givesthe error "Page not found". When launching an Appeon demo application, the Internet
Explorer givesthe error "Failed to load the remote interface”. In Jaguar.log, you will get the
error*Unable to service requests for servlet”.

Cause: EAServer is corrupt and cannot support the running of servlets.

Solution: Uninstall Appeon Server and EA Server, remove the %JAGUARY folder
completely, and then reinstall EA Server and Appeon Server.
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5.2.10 JDBC/ODBC TDS data type discrepancy on SQL Anywhere

With an SAP Sybase ASA/SQL Anywhere database using JDBC, the date, time, and
TimeStamp data types are treated as one DateTime data type.

Cause: ASA/SQL Anywhere does not distinguish date, time, and TimeStamp for JDBC - this
is an unsupported feature. However these data types are fully supported for other database
interfaces, such as ODBC. SAP Sybase recommends using the provided iAnywhere or a
JDBC-ODBC bridge to work around this TDS unsupported feature where JDBC is required.

Solution: Use the iAnywhere JDBC bridge driver supplied with SAP Sybase ASA/SQL
Anywhere 8.0.2 and above. Make sure you apply the latest EBF for the driver so that the
latest bug fixes are installed. Although the SUN JDBC-ODBC bridge driver can also be used
to resolve thisissue, theiAnywhere JDBC driver is highly recommended since it is designed
to provide optimal performance and stability with SAP Sybase databases and Appeon Server.

5.2.11 Empty/Null value update error if SQL Anywhere/ASE

If the Web application uses an SAP Sybase Adaptive Server Enterprise (ASE) database or an
ASA/SQL Anywhere database that is set as ASE-compatible, database updates may fail.

Cause: If the length is O or the value of the datais NULL for any data in a database table
where the data is of astring type, such as varchar or char datatype, the dataretrieved from
the database through a JDBC driver will have alength greater than 0. Rather than a null
value, the data returned will be padded with a series of spaces. Asaresult of this padding, the
database update will fail.

Solution: Y ou can work around thisissue in one of two ways:

1. For SAP Sybase ASA/SQL Anywhere and ASE databases, Appeon recommends that you
do not use a Native-protocol/all-Java JDBC driver. There are a number of JIDBC-ODBC
bridge drivers that can be used, such as those from SUN or the iAnywhere driver. However,
iAnywhere is one of the best performing and most stable bridge drivers available.

2. For SAP Sybase ASA/SQL Anywhere, if it is preferential to use a JDBC driver, you will
need to adjust the database accordingly. Change the SQL Anywhere database setting so it is
set to be incompatible with ASE.

5.2.12 Web application does not run when the database is disconnected by
exception

When the database is disconnected by exception, the Web application stops working. Closing
and re-opening the application does not fix the problem.

Cause: When the database is disconnected by exception, the status of the data source to the
database remains connected in EA Server. When the application is restarted, EAServer will
not try to reconnect the database.

Solution: Any of the following operations should resolve the problem.
1. Restart EAServer
2. Refresh the relevant data source using EA Server Manager

5.2.13 #Table or view not found# error
Fail to open the window that contains DataWindows with DB connection.
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Causes A: The database does not contain the table mentioned in the error message.
Solution A: Search the table in the database and make sure the table does exist.
Cause B: The configuration for the database connection is incorrect.

Solution B: To solve the problem, verify that you have done all the following configuration
steps correctly on Appeon Server machines, Appeon Developer machines, and the Client
machines that plan to run the Web application. Please pay specia attention to step 1, 4, and 8.

Configurations on Appeon Server machines:

Step 1: Set up a data source for connecting to the application database. Make sure the data
source can be pinged successfully.

Step 2: Start the server.
Configuration on Appeon Developer machines
(You can refer to Appeon Developer User Guide for details of the following steps):

Step 3: Load the POWERBUILDER application in PowerBuilder 9 and make sure the full
build of the application is successful.

Step 4: Configure an application profile in the Appeon Developer Configuration window. In
this configuration, make sure the application DB profile is configured correctly.

Step 5: Configure an Appeon Server profile in the Appeon Developer Configuration window,
which connects to "tmk.starshoes.com.mx". Make sure the testing connection is successful.

Step 6: Configure aWeb Server profile in the Appeon Developer Configuration window,
which connects to the server that you installed " Appeon Server Web Component” too. Make
sure the testing connection is successful.

Step 7: Configure a deployment profile in the Appeon Developer Configuration window,
which connects to the configured Appeon Server profile and Web Server profile.

Step 8: Accessto Appeon AEM viathe AEM button in the Appeon Devel oper toolbar, and
set up the transaction object to data source mapping.

Step 9: Deploy your application with the Appeon Deployment Wizard.
Configurations on client machines that runs the Web application:
Step 10: Delete all the temporary files stored in Internet Explorer cache.

Step 11: Delete the Xcelerator plug-in that has been downloaded to the client: delete the
files at \WINNT\Downloaded Program Files (Windows 2000) or \WINDOWS\Downloaded
Program Files (Windows XP or 2003).

Step 12: Verify the Internet Explorer security settings: for the appropriate zone in the
Internet Explorer Security, make sure the security is set to default; if it is Windows XP, after
setting the security to default, we also need to enable the option "Download signed ActiveX

controls’, "Download unsigned ActiveX controls’, "Initialize and script ActiveX controls not
marked as safe”, and "Run ActiveX controls and plug-ins'.

5.2.14 #Table already exists# error

When you execute the SQL file from Appeon using database tools, an error message may pop
up saying, "Table already exists'.
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Cause: The SQL file from Appeon will create five PowerBuilder System Tables. pbcatcol,
pbcatedt, pbcatfmt, pbcattbl, and pbcatvld. If the five tables already exist, the error message

will display.

Solution: s Appeon rebuilds the PowerBuilder System Tables to make sure the stored
procedures from Appeon Server will be successfully created. Y ou can click No on the
message window to use the original system tables, or click Yesto rebuild these tables. Y our
choice will not affect the execution result.

5.2.15 Appeondb is not started when EAServer starts

After the Appeon Server installation, start EA Server/Appeon Server. EA Server/Appeon
Server starts successfully while Appeondb is not started.

Cause & Solution: Refer to Cannot start EA Server Manager.

5.2.16 Fail to ping appeondb data source

When pinging the appeondb data source, no connection is made.

Cause: Pinging appeondb fails because the data source is not configured correctly.
Solution: Follow these steps below to fix the problem.

Step 1: Verify that the Appeondb system DSN exists in the ODBC Data Source
Administrator (Control Panel > Administrative Tools > Data Sour ces (ODBC)).

Figure 5.16: ODBC Data Sour ce Administrator
£10DBC Data Source Administrator EE |

User DSH  System DSM | File DSM I Driversl Trau:ingl Connection F'u:u:ulingl About I

System Data Sources:

| Driver |« Add...
A Adaptive Server Anywhere 8.0
AppeonSample Adaptive Server Anywhere 7.0 Bemove |
AppeonSample? Adaptive Server Anywhere 7.0
AppeonSamplezFarServer  Adaptive Server Arypwhere 8.0 Canfigure... |
AppeonSampleFarSerser  Adaptive Server Anypwhere 8.0
appeantutor Adaptive Server Anywhere 8.0
EAS Demo DB W3 Adaptive Server Anywhere 8.0
EAS Demo DB W4 Adaptive Server Srywhere 700
EAS Demo DB WA Adaptive Server Anywhere 3.0
GlobalCar Microsaft Access Diver [*.mdb]
Jaauar 5VU S amole Adaptive Server Aruwhere 3.0 j
An ODBC Spztem data source stores infarmation abaut how to connect ta
the indicated data provider. & System data source iz vigible to all uzers
an this machine, including MT services.

(] I Cancel | Apply | Help |

Select Configur e to open the data source configuration window.
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Figure5.17: Configure data source

ODBC Configuration for Adaptive Server Anywhere 8 [H |

aoDeC I Login I Datahasel Netwu:-rkl .ﬁ.dvancedl

D ata source name: | —

D escription: I

Izolation |ewvel: I

[T Microsoft applications [Keys in SOLStatistics]

[T Delphi applications
[T Suppress fetch warnings
[ Prevent diiver not capable emors

[T Delay AutcCormmit until statement cloze

Deszcribe Cursar Behavior
’}* MNewver = |f required  Always

Translatar: |<N|:- Tranzlatar:

Select Tranzlator. .. |

T ezt Connection |

F. I Cancel |

Note: AppeonServer.db applies an encrypted password. Test Connection on the ODBC
tab will not be successful since the encrypted password is not available in Data Source

Configuration.
Verify that the Appeondb data source configuration is the same as follows.

» Verify the Appeondb Login (User ID: appeon; Password: empty).
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Figure 5.18: Configure user ID and password

ODBC Configuration for Adaptive Server Anywhere 8 [H |
ODBC Login I Databaze I M etwark I Advanced I

£ Use integrated login

& Supply uszer I and password
Uzer D

[lappean
Pazzwiord: I

[” Encivpt password

F. I Cancel |

* Verify the Appeondb Database (Database file: the full path to %JA GUARY0\appeon\db
\AppeonServer.db).
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Figure5.19: Configurethe database

ODBC Configuration for Adaptive Server Anywhere 8 [H |

I:IDEEI Login Databaze I Netwu:-rkl .ﬁ.dvancedl

Server name:

Start line; I

D atabaze name: |.-L‘-.ppe::nr‘u:||:|

[ atabasze file: I C:%Program FileshdppeontEAServerappe

Browse. .. |

Encryption key: I

¥ Automatically start the database if it izn't running

¥ futomatically shut down database after last disconnect

F. I Cancel |

Step 2: Right-click the appeondb data source in EAServer Manager and select "Properties’ to
open the Connection Cache Properties window.
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Figure5.20: Select Properties
: ‘!H'yh.wr Central — =

Flle Edit Wiew Tools Help

|3 Connection Caches :”\h|* I §|§|| EI J"Ih|‘JXI g
P Svbase Central 1 Detans
*I WD Sacusity Marager Conneclion Caches | Dirbvar Tvpe | Description
=| ﬂ EASerer Manager T
= B8 localhost9ags e ks
& - Aogications E) appeons. 2EiEE JOBC
¥ [ Certificates @ appeons  BefEsh JDBC
B ) Clusters ) Easperr_ Fing oDec
23 Conneclion Caches [E) EASDem JOBC
B- [0 Connaclors &) EASDemo_Jdbcodbe JOBC
H |f.l DL B Jwacache JDBC Jawa Conneclion Cache
B & \dentties ) JuDDISenveICache JDBC
;:; E :T:;S;:n:'::li ] SampleCache ODBC Connecton cache for the Sample
I+] @ Message Savica B SerdetPersistenceCache JOBC Sendet Parsistence Storage Cong
B 0 Packages
B ) Roles
#- ) Securty Profiles
B 0 Gemvars
= G Jaguar
# ([ Serdets
- ] Web applications
4] gLl | |

Display ttem Properties

Verify the properties for the appeondb data source.

» Verify the configuration on the General tab (Server Name: jdbc:odbc:AppeonDB; User
Name: appeon). Make sure that the password keeps the default setting. If you have
modified the Password, the appeondb data source will not work and you will have to
reinstall Appeon Server to restore the default password.
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Figure 5.21: Configure general information

@ Connection Cache Properties

Caonnection Cache Mame: appeondh

Drescription:

| Driveri Cachingl Al I EQLTracingI Advancedl

Database Type: |Lnknown _j

~Database Connection

Serar Marme:

HA ServerMame (optional);

|jdbc:ndbc:ﬁppennDEl

|jdhc:ndhc:ﬁppennDEl

User Mame: |appenn
PEISS'I.I'I.I'I:Ir'Ij: |'.\".\".\".\".\".\".\".’:'.\".\".\".\'t
Refresh | Fing |
(8124 Cancel | Il Help

» Verify the configuration on the Driver tab. Select JIDBC and specify the driver string as

sun.jdbc.odbc.JdbcOdbceDriver.
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Figure5.22: Configure Driver

;ral:unnectiun Cache Properties i ﬂ

Database Driver Type IJDEIC vl

~Connection Libran 1PC

DLL or Class Mame: |5un.jdhc.ndbc.JdchdbcDriver

rConnection Libran =&

DLL or Class Name; |

A DLL MNare: |

(8]t Cancel Ay Help

Step 3: Right-click the appeondb data source in EA Server Manager and select "Ping" to test
the database connection again.

5.2.17 Fail to ping appeonsample data source

When pinging the appeonsample data source, no connection is made.

Cause: Ping of appeonsample fails because the data source is not established correctly.
Solution: Follow the steps below to fix the problem.

Step 1: Verify that the AppeonSampleForServer system DSN exists in the ODBC Data
Source Administrator (Windows Control Panel > Administrative Tools > Data Sour ces
(ODBQ)).
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Figure5.23: System DSN
£ 0DBC Data Source Administrator H |

Usger DSH  Spstem DSN | File D'SM I Driversl Tran::ingl Connection F'n:u:nlingl Abaut I

Systemn Data Sources:

Mame | Driver |« Add...
Appeondb Adaptive Server Anywhere 8.0

AppeonSample Adaptive Server Anywhere 7.0 Remove |
AppeonSample? Adaptive Server Anywhere 7.0

AppeonSampleZForServer  Adaptive Server Anwwhere 3.0 Configure. .. |
R ekl Adaptive Server Arywhere 8.0

appeantukar Adaptive Server Anywhere 8.0

EaS Demo DB W3 Adaptive Server Anywhere 8.0

EAS Demo DB W4 Adaptive Server Anpwhere 7.0

EAS Demo DB WA Adaptive Server Anywhere 3.0

GlobalCar Microzoft dccess Driver [*.mdb)

Jaouar SVU Samole Adaptive Server Aruwhere 8.0 j

An ODEC System data zource stores information about how to connect to
the indicated data provider. A Svstem data source iz vizible to all uzers
an thiz machine, including MT services.

(] I Cancel Smply Help

Select Configure, and click Test Connection on the ODBC tab to check
AppeonSampleForServer connectivity.
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Figure 5.24: Check the data source

ODBC Configuration for Adaptive Server Anywhere 8 [H |

aoDeC I Login I Datahasel Netwu:-rkl .ﬁ.dvancedl

[Data source name: | R T T

D escription: I

Izolation |ewvel: I

[T Microsoft applications [Keys in SOLStatistics]

[T Delphi applications
[T Suppress fetch warnings
[ Prevent diiver not capable emors

[T Delay AutcCormmit until statement cloze

Deszcribe Cursar Behavior
’}* MNewver = |f required  Always

Translatar: |<N|:- Tranzlatar:

Select Tranzlator. .. |

T ezt Connection |

F. I Cancel |

If the Appeondb data source does not exist or the connection test fails, try to manually add/
configure the data source.

» Configure the Appeondb Login (User ID: dba; Password: sql).
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Figure 5.25: Configure user ID and password
ODBC Configuration for Adaptive Server Anywhere 8 [H |
ODBC Login I Databaze I M etwark I Advanced I

£ Use integrated login

& Supply uszer I and password

User [0 I,jba

Pazzwiord: Im

[” Encivpt password

k. I Cancel

» Configure the AppeonSampleForServer Database.
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Figure 5.26: Configure database

ODBC Configuration for Adaptive Server Anywhere 8 [H |

I:IDEEI Login Databaze I Netwu:-rkl .ﬁ.dvancedl

Server name: I.-’-'-.ppeu:unS amnple

Start line: Ieu:un'xShared'\.&SﬂEDE'ﬁWinEE'\dbengE.e:-:e

[ atabaze name: I.-’-'-.ppe::nnS ampleF orServer

[ atabasze file: I ppeontappeonzampletdppeonS ample. db

Browse. .. |

Encryption key: I

¥ Automatically start the database if it izn't running

¥ futomatically shut down database after last disconnect

k. I Cancel

Step 2: Verify that the appeonsample data source exists in EAServer Manager.

Troubleshooting Page 102



Troubleshooting Appeon Server

Appeon® for PowerBuilder® 2013 R2

Figure5.27: Select Properties

+Sybase Central

File Edit View Tools Help

B[] Message Serice
#- (C1 Packages
] Roles
i [ Securty Profiles
[=- ] Semvers

= & Jaguar
- L] Sendets
@ [ Web applications

[ 23 Connection Caches lelsm 2|8 @l o=
s ;‘base Cenral { Details
i S B
+ acurity Managar Sinnatin Caihis TorverTyee T
o B EAserer Manager =
= BB localhost9ga e appecndh JDBC
® (13 Applications -_ m Belcte JOBC
H- [ Certiflcates “e) appeonsampli—= JDBC
B 23 Clusters 6] EASDemo Rafrash opec
3 Connection Caches (HS) EASDema_jC( N0 JDBC
- [ Connectors JDBC
i R JoBC Java Connection Cache
- [ Identities 10BC
e
I_EI I__-I nencer ol SampleCache oDBac Connection cache for the Sample
#- [ Log Profies a ; ;
=) ServletPersistenceCache JOBC Sentet Perzisience Storage Com

- [+ 1Ll

Display tem Properties:

Right-click the appeonsample data source and select "Properties’ to open the Connection

Cache Properties window.

» Check the configuration in the General tab (Server Name:

jdbc:odbc: AppeonSampleForServer; User Name: dba; Password: sql).
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Figure 5.28: Configure general information

;@Eunnectiun Cache Properties N

|| Driverl Cachingl A | EQLTracingl Advancedl

Caonnection Cache Mame: appeonsample

Drescription:

Database Type: |LInknown ll

~Database Connection

Serer Marme:

HA ServerMame (optional);

|jdbc:ndbc:AppennSampleFurSewer

|jdhc:ndhc:AppennEampleFurBewer

UserMame: Idha
Password: |H1r
Refresh | Fing |
(8]t Cancel | Ay Help

» Check configuration in the Driver tab, and verify that the same settings are used. Select

JDBC and specify the driver string as "sun.jdbc.odbc.JdbcOdbcDriver".
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Figure 5.29: Configure Driver

@Eunnectiun Cache Properties _ Ej

Database Driver Type !JDEIC vl

Connection Library 1PC

DLL or Class Mame: |5un.jdhc.ndbc.JdthdbcDriver

rConnection Libran <2

OLL or Class Mame:; I

%A DLL Marme: |

Ok Cancel Apply Help

Step 3: Right-click the appeonsample data source in EA Server Manager and select "Ping” to
test the database connection again.

5.2.18 Fail to ping data sources for SQL Server 2000

Cause A: The data sourceis not configured to use MS SQL Server Native Driver.
Solution A: Use MS SQL Server Native Driver for this application.

Cause B: The Database Host isincorrectly specified.

Solution B: Use Loca host, IP Address and machine name as the input parameter for the
"Database Host".

Cause C: The SQL Server database is not updated enough

Solution C: Upgradeto at least SQL Server 2000 SP3. The latest Service Pack (SP4)
for SQL Server isavailable at http://www.microsoft.com/downl oads/detail s.aspx?
familyid=8e2dfc8d-c20e-4446-99a9-b7f0213f8bc5& displaylang=en.

5.2.19 #com.sybase.jaguar.util.JException: [Microsoft][SQLServer 2000 Driver
for JIDBC]Error establishing socket.#

Cannot get connection for cache and display the error message
"com.sybase.jaguar.util.JException: [Microsoft][ SQL Server 2000 Driver for JDBC]Error
establishing socket".
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Cause: The driver from Microsoft cannot handle windows integrated authentication.
Solution:

Step 1: Make sure that SQL Server is set to mixed authentication. To do this, open enterprise
manager, right click on server/properties.

Step 2: Keeping the server properties dialog up, go to the general tab and push the network
configuration button. Enable TCP/IP (it is disabled by default).

Step 3: Add an SQL Server login account (not a Windows account).
Step 4: Use the login setup in Step 3.

Y ou can find detailed information from the following Website: http://support.microsoft.com/
default.aspx?scid=kb;en-us; 313178

5.2.20 #java.sql.SQLException:[Microsoft][ODBC SQL Server
Driver]Connection is busy with results for another hstmt# Error when using
the Microsoft SQLServer database

The data source can be pinged successfully. The DatawWindows cannot open when you run
the application on the Web. The error messages "java.sgl.SQL Exception:[Microsoft][ODBC
SQL Server Driver]Connection is busy with results for another hstmt” displays on the Web.

Cause: Use the IDBC-ODBC bridge driver when setting up the data source for Microsoft
SQL Server.

Solution: Use the IDBC driver:

1. Before you configure a JDBC data source, there are afew preparations that need to be
done. Refer to Section 4.2.4, “JDBC driver preparation” in Appeon Server Configuration
Guide for J2EE.

2. If you change any setting of the data source, restart EAServer to apply the changes.

5.2.21 Error converting data type varchar to datetime

If the output parameter of a stored procedure is varchar, when the variable of the datetime
type calls the parameter, the following error message displays in the SQLCA Information:
"Error converting data type varchar to datetime".

Cause: The varchar parameter fails to be converted to datetime, because the parameter length
istoo short in the database; for example, varchar(10).

Solution: Modify the code.

Call the varchar parameter with a string variable.

5.2.22 #ORA-01461# error in AEM when test a data source

Failed to test the data sourcein AEM and prompted with "ORA-01461 error”.
Cause: Thisisan oracle JDBC driver error.

Solution: Update to the latest driver released in Oracle Web site.
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5.2.23 #oracle 9i failed: System.Data.OracleClient requires Oracle client
software version 8.1.7 or greater#

Failed to test the data source in AEM and prompted with the error messages "oracle 9i failed:
System.Data.OracleClient requires Oracle client software version 8.1.7 or greater”.

Cause: Oracle 9i Client software requires that the login user have the Authenticated User
privilege to the Oracle Home in the client hosting machine.

Solution: Y ou can follow the instruction below to finish the right grant:
Step 1: Login to Windows as a user with Administrator privileges.

Step 2: Launch Windows Explorer from the Start Menu and navigate to the
ORACLE_HOME folder. Thisistypically the "Ora9i" folder under the "Oracle" folder (i.e.
D:\Oracle\Ora9i).

Step 3: Right-click on the ORACLE_HOME folder and choose the "Properties’ option from
the drop down list. Then the Properties window should appear.
Step 4: Click on the Security tab of the Properties window.

Step 5: Click on Authenticated Users item in the Name list (on Windows XP the Namel list is
called Group or user names).

Step 6: Uncheck the Read and Execute box in the Permissions list under the Allow column
(on Windows XP the Permissions list is called Permissions for Authenticated Users).

Step 7: Re-check the Read and Execute box under the Allow column (thisis the box you just
unchecked).

Step 8: Click the Advanced button and in the Permission Entries list make sure you see the
Authenticated Users listed there with:

Permission = Read & Execute
Apply To = Thisfolder, subfolders and files

Double check the Apply onto drop-down box and make sure it is set to This folder,
subfolders and files.

Step 9: Click the OK button until you close out all of the security properties windows. The
cursor may present the hour glass for afew seconds as it applies the permissions you just
changed to all subfolders and files.

Step 10: Reboot your computer to assure that these changes have taken effect.

5.2.24 Procedure 'appeon_procdataobjects' not found

Web application cannot run properly on the Web and the "Procedure
‘appeon_procdataobjects not found" error is reported in AppeonServer log file.

Cause: A possible cause of the error isyou configured DatawWindow data source in AEM but
forgot to execute corresponding SQL to make this feature take effect.

Solution: Execute corresponding SQL according to the instructionsin the section in
Section 5.4.8.3, “DataWindow Data Cache” in Appeon Server Configuration Guide for .NET
or in Appeon Server Configuration Guide for J2EE.
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5.2.25 EAServer 6.x startup error

The following errors occur when starting EAServer 6.x from the DOS mode.

Figure 5.30:
© default{jdk1.5) =] E3

at com.appeon.Server.runtServer.javaz252)
at com.appeon.server.controller.ThreadirapperImpl.ran{ThreadWrapperInpl.
Javaz22>
at_djava.lano.Thread. run{Thread_java 5953
log4j:ERROR Ignoring configuration file [F:=“Program Files <{x86>-“SyhasesEAServerhH
“hin*..%appeon“repositorystestamndbdbsconf igslogdj.properties].
log4j:WARN Ho appenders could bhe found for logger <com.appeon.sServer.services.co
nf igassistant.Conf igAssistantServicelltils>.
log4j:WARN Please initiali=e the logdj system properly.
Appeon Server started. Version 6.8.8231 .00 on 28808-84-38
Accepting Connections: http:/-testamdbdb:3B0A
Accepting Connections: https:/ testamdbdb:88601
Accepting Connections: https:t/ testamdbdbh:860602

Accepting Connections: http:/~localhost:2988

Server Started

The Management Console can be accessed at http:Astestamdb4h:8888./console
The Management Console can be accessed at https:/stestamdb4b:88081 /console

at com.appeon.server.config.ServerConf igFacade . acquirelogDestination{Ser
verConf igFacade . Javaz412>

at com.appeon.server.config.AppeonConfigy.getLogDestination{AppeonConfig.
JavazZh2>

at com.appeon.server.logy.Loy.getLogParentPath{Log. java:515>

at com.appeon.server.log.Logy.initExceptiontriter{Logy. javaz85>

at com.appeon.server.log.Log.<clinit>*{Log.java:63>

Cause: More than one EA Server 6.x instance is running, and the port that Appeon requiresis
occupied by the running instance, this causes Appeon Server to fail to generate the complete
configuration file during startup.

Solution: Please go to { EAServer6}\appeon\repository\{ instance_name} \config folder and
verify that it contains the following 10 files:

aem-config.xml
aem-mapping.xmi
appeoncache.conf
applications-config.xml
cluster-config.xml
threadqueue.xml
server-config.xml
mapping.xmi
log4j.properties
cluster-mapping.xml

If any of the above filesis missing, please delete the entire { EA Server6} \appeon\repository
\{instance_name}\ folder (including filesin it) and start EAServer again.
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5.2.26 Fail to start Appeon Server on JEUS
Appeon Server cannot be started at the first time.
Cause: The JEUS server is not correctly configured.
Solution:

Step 1: Make sure the node is successfully booted, as shown in the following figure. In the
JEUS Web Manager, select the node name in the JEUS Node Tr ee pane, and then click
Control on the right pane. Select the node name check box in the Boot tab and click OK.

Figure5.31: JEUS Manager - Control

'a Jeus # 21 A - Microsolt Internet Explorer

| Fle Edt View Favorkes Tooks Help 1 i
|Qeack = D - A & @] Psewch Sifavermes & | (- S vl - [ B K |
]ﬂfﬁd'ess ig] http:f localhost: 9744 webadminfapprserace=home :I E:Go “Lm ”H 0snagl: (&

55 JEUS Cluster

(2 testiisong

736) user:administrator start tirme:Monday, January

Configuration

S JEUS Node Tree = Control

JEUS Manager - Control

=5 testisong Chuster Boot | Down | Exit
B Engine Containers Distribetion
B2 xus Manager Resources
&0 xeus Manager Services
#-1 Deploying Java EE Application Modules
-0 2Us Monkoring

Targets
I an

F; & testisong

Figure 5.32: Prompt message

Microsoft Internet Explorer

' "-'., [testlisong] nodes are successfully booked.
LB

Step 2: Make sure the Engine Container is on Running status via clicking the node name >
Engine Containers.
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Figure 5.33: Engine Container
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5.2.27 Status Monitor exits after restarting Appeon Server for WebLogic in
Linux

In Linux environment, when Appeon Status Monitor detects that Appeon Server for
WebL ogic shuts down, it will restart Appeon Server for WebL ogic, but it can only restart
Appeon Server for only one time, after that, Status Monitor will stop running, and cannot
restart Appeon Server for WebL ogic when it shuts down again.

Cause: It isabug of Appeon Status Monitor.

Solution: Modify the $appeon/bin/appeonserverstart.bat file, by changing script
"$WEBLOG C/ st ar t WebLogi c. sh”

To

gnome-term nal —e "$WEBLOG C/ st art WebLogi c. sh"

5.2.28 The data source test will fail if the Shared memory is checked

If you are running a SQL Anywhere network server engine (for example, using dbsrvll.exe
or running a network service), then the ODBC DNS cannot have Shared memory checked or
else the data source test will fail.
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Figure 5.34: Shared memory caused error

CDBC Configuration for SQL Anywhere 11 I.iléj

ODBEC | Login | Database | Network | Advanced

Select the networlc protocols and options.

TCP/IF
Shared memory causes error in
[] Shared memory Appeon data source, even if the
server is on the local machine.
Liveness timeout: {20 | seconds
|dle timeout : 240 = | minutes
Buffer size: 7300 ~| bytes

| Compress network packets

Select the method for encryption of networs packets.
@ Mone

7 Simple

@ TLS Edit...

OK || Cancel || Hel

L= A

Solution: Uncheck the Shared memory checkbox on the Network tab.

5.3 Appeon Server Cluster

5.3.1 Loading application is slow when Appeon Cluster works in virtual
machines

After configuring the Appeon Server cluster to work in virtual machines, it is very slow to
open the Web application from the Web Server.

Cause:

When receiving the requests from the client, the Web Server needs to search for the available
application servers. During thistime if one of the application serversis shut down, then the
Web Server will not search for the next application server until the session times out.
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Solution A (Recommended):

We strongly recommend clustering Appeon Server across physical machines instead of
virtual machines, because physical machine is more stable and faster in performance and
network communication.

Solution B:

If Appeon Server cluster must work in virtual machine, please check and make sure all
application servers are turned on.

5.3.2 Retrieving data is slow when Appeon Cluster works in virtual machines

After configuring the Appeon Server cluster to work in virtual machines, it isvery slow to
retrieve data from the database.

Cause: The slownessis caused by the network card “Broadcom" installed to the host server
and used by the host server to communicate with the virtual machines.

Solution A (Recommended):

We strongly recommend clustering Appeon Server across physical machines instead of
virtual machines; this can avoid communication between the host server and the virtual
machines.

Solution B:

Step 1: Change the network card of the host server from Broadcom to Realtek, such as
Realtek PCle GBE Family.

Step 2: (Optional) Disable the "Large Send Offload" property (if available) to further
improve the network card performance. This property is available for certain network cards
only, not al. See below for detailed steps.

Step 3: (Optional) Change the network card type of the virtual machineto "AMD PCNet
Family" to gain further improvements. See below for detailed steps.

To configure the "Large Send Offload" property, follow steps below:

1) Inthe Local Area Connection Properties window, select Client for Micr osoft
Networ ks, and then click the Configur e button.
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Figure 5.35: Local Area Connection Properties

-
U Local Area Connection Properties ﬁ

Metworking | Sharing

Connect using:
"-:.h Realtek PCle GBE Family Controller

This connection uses the following tems:

2 Client for Microsoft Networks

B} \/Mware Bridge Protocal
Bl 305 Packet Scheduler U
.Q File and Printer Sharing for Microsoft Networks

<& Intemet Protocol Version & (TCP/IPvE)

-2 Intemet Protocol Version 4 (TCP/IPv4)

<& Link-Layer Topology Discovery Mapper 40 Driver

& link-Layer Topology Discovery Responder N
[ Install... ] [ Uninstall ] Properties
[
Description
Allows yourl/\\?mputertu access resources on a Microsoft
nietwork.
|
I [ ok ][ canca ||l

2) Click the Advanced tab, select L arge Send Offload V2 (IPv4) and set its value to
Disabled, and then disable L ar ge Send Offload V2 (1Pv6) in the same way.
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Figure 5.36: Advanced tab

Realtek PCle GBE Family Controller Properties Iﬁ
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To change the network card type of the virtual machineto "AMD PCNet Family" follow
steps below:

For VMWARE 6 and earlier versions:

1) Open the .vmx file under the directory which has the virtue machine installed.

2) Modify the value of ethernetO.virtualDev to "vlance" ethernetO.virtualDev="vlance"; or
directly delete this parameter.

For VMWARE 7 and later versions;

1) Open the .vmx file under the directory which has the virtual machine installed.

2) Add all parameters related to ethernet[n] and pciBridge[n], except

ethernet[n].generatedAddress. Y ou may need to refer to the .vmx file of VMWARE 6 (as
shown below) to find out al the related parameters.

Note: Please do not copy ethernet[n].generatedAddress, because it is used for defining the
MAC address.
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Figure 5.37: Copy address

j Windows Server 2003 Enterprise Edition_vmwareb.vmzx - Notepad
File Edit Format Wiew Help

[=]lE |ms]

config.version = "8"

virtualHw. version = "g&"
scsi0.present = "TRUE"
scsi0.virtualbev = "lsilogic”
memsize = "384"

scsi0:0.present = "TRUE"
scsi0:0.FileName = "windows Server 2003 Enterprise Edition.wvmdk"
idel:0.present = "FALSE"
idel:0.fileName = "auto detect"
idel:0.deviceType = "cdrom-raw"
floppy0. autodetect = "TRUE"
eThernetd. virtualDev = " el000
ethernet0. present = "TRUE"
ethernetl. wakeOnPcktRcv = "FALSE"
usb.present = "FALSE"™
ehci.present = "TRUE"

sound. present = "FALSE"

sound. fileName = "-1"

ks . Al =1 = = Wl

displayName = "windows Server 2003 Enterprise Edition”
guestos = "winnetenterprise”

nvram = "Windows Server 2003 Enterprise Edition.nvram"”
deploymentPlatform = "windows"

virtualHw. productCompatibility = "hosted"
tools.upgrade.policy = "useclobal”

floppy0.present = "FALSE"

isolation.tools. hgfs.disable = "TRUE"

ethernet(. addressType = "generated”

uuid. Tocation = "56 4d c5 88 59 16 8c lc-e2 c7 36 50 a0 18 53 f4"

m
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6 Troubleshooting PowerBuilder and EAServer

This section contains information about PowerBuilder and EA Server issues that may
typically occur when using them with Appeon. If you cannot resolve the problem with this
troubleshooting guide, please contact technical support at http://www.appeon.com/support.

6.1 PowerBuilder issues

6.1.1 Nested reports over five pages do not display

Nested reports longer than five pages cannot be displayed in DataWindows in the deployed
Web application.

Cause: A PowerBuilder limitation.

Solution: SAP Sybase recommends that you view/print the nested reports longer than five
pages in PDF format.

6.1.2 Upgrading to a different Build of PowerBuilder

When updating the PowerBuilder version to another Build, objects in the original
PowerBuilder application occasionally fail to be automatically migrated to a new Build.

Cause: A PowerBuilder limitation.

Solution: Perform a"Full Build" on existing PowerBuilder applications after a Build upgrade
has been made to PowerBuilder.

6.1.3 Data range issue with n-Tier NVOs

If the data used in the PowerBuilder NV O is beyond the range that the corresponding Java
code can support, there will be errors when it is deployed to the Web.

Cause: PowerBuilder NV Os and the generated Java components support different data
ranges. For example, in PowerBuilder, the supported range for an Unsigned Integer is
0-65,535, whereas the corresponding Java component will only support arange no larger than
32,767.

Solution: Use a different data type, or keep the data value within the scope that both
PowerBuilder and Java support.

6.2 EAServer issues

6.2.1 java.io.lOException: Keystore was tampered with, or password was
incorrect

When starting EA Server, an error occurs: java.io.l OException: Keystore was tampered with,
or password was incorrect.

Solution: Go to %JA GUAR%Y\Repository\lnstance\com\sybase\djc\server\A pplicationServer,
for example, C:\Program Files\Sybase\EA Server6\Repository\l nstance\com\sybase\dj c\server
\ApplicationServer, open the instance properties file (for example, EAServer.properties) in a
text editor, and change the password from * to changeit. There are two areas that should be
changed, as shown in the bold text below.
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#l nst ance Properties

#Fri Feb 14 13:33: 05 CST 2014

keySt or ePasswor d=changei t

syst enExcl udeModul es=none

htt pLi st eners=httpl, httpsl, https2, appeon_http

st art Resour ces=none, com sybase. dj c. sql . Dat aSour ce\: t est 2

creat eTabl es=true

iiopListeners=iiopl,iiopsl,iiops2, appeon_iiop

schedul edTasks=Aut oDepl oy, Aut oRef r esh, CheckMenor yUsage, Local Rest art, Local St op
rm Li st eners=rm

excl udeModul es=none

keySt or e=${ dj c. hone}/ Reposi t ory/ Securi ty/ keystore.jks

jtdsLi steners=jtds

trust St ore=${dj c. hone}/ Reposi tory/ Security/truststore.jks

ant . proj ect =defaul t - appl i cati on-servers

start Modul es=al |

servi ceConponent s=Connect or Wor kManager , Hel pSer ver, MBeanSer ver, Jaguar Ser ver
t rust St or ePasswor d=changei t

creat eTabl esOnl ni t =true

6.2.2 #License error: 10999 ...# when starting Appeon Server in 64-bit OS

After installing Appeon Server to EAServer running on 64-bit OS, the following error occurs
when Appeon Server starts.

Figure6.1: Licenseerror

@ M3 Start Server (jdk 1.6) M[=] E3

HITF Listeners: http://STHT:Bﬂﬂﬂ,https://STﬂT:Bﬂﬂl,https://STHT:BBBZ,http://lucall
lho=t:9988

[IOF Listeners: iiop://8TAT:200@.iiops:- ~STAT:2801,iiop=:-/8TAT:=2802 . .ijiop:-~loca
lho=t:9989

Starting services...
Accepting Connections: iiop:s~localhost:92987
Accepting Connections: iiop:--/STAT:20080
Accepting Connections: iiops://STAT:2001
Accepting Connections: iiops://STAT:2002
The Statistics URL is http:-/~8TAT:80880/wsh/run?command=get—statistics
The Management Console can be accesszed at http:~ 7S8TAT:88088. console
The Management Console can be accessed at https://8TAT:8001./console
Accepting Connections: http://STAT:800860
Accepting Connections: https:=//STAT:880601
Accepting Connections: https:=-/-STAT:8862
http:/~localhost 9988
Accepting Connections: Jjtds:/-S5TAT:28085
Server Started
ppeon Server started. Uersion 6.5.8161.88 on 20181111

ppeon Server (6.5.A161.88 edition> failed.

License Error: 189299:Internal error. Please contact the system administrator.

Cause A & Solution A: Same as the error "Cannot find the language resource file
(dblgzhl1l.dll, dblgendd.dil)".

Cause B: EAServer is not running in 64-bit mode.

Solution B: See below for how to configure and run EAServer 6.x on a 64-bit OS.
Step 1: Download and install the 64-bit version of JDK.
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1. Download jdk-1 5 0_15-windows-amd64.exe.

1. Go to http://java.sun.com/products/archive/j2se/5.0 15/index.html.

2. Click "Download JDK", and then click "Yes".
3. Select "Windows x64" platform.

4. Select "l agreeto the Java Development Kit 5.0 Update 15 License Agreement” to
continue.

5. Click "jdk-1 5 0 _15-windows-amd64.exe" and save thefile.
2. Download jdk-6ul0-rc2-bin-b32-windows-amd64-12_sep 2008.exe.

1. Go to http://java.sun.com/javase/downl oads/ea/6u10/6ul0rcDownl oad.jsp#6ul0JDKSs.

2. Click "jdk-6ul0-rc2-bin-b32-windows-amd64-12 sep 2008.exe" and save thefile.

3. Install IDK by running the downloaded file: jdk-1 5 0 15-windows-amd64.exe, and
jdk-6u10-rc2-bin-b32-windows-amd64-12_sep 2008.exe

Suppose the installation directory is %Sybase%\shared\jdk-1_5 0 15, and %Sybase%\shared
\jdk-1_6 _10.

Step 2: Configure the JDK location in set-java-home.bat (or set-java-home.sh in UNIX). For
example,

set DIC_JAVA HOVE 15=%Sybase% shared\jdk-1 5 0 15
or
set DIC _JAVA HOVE_ 16¥%BSybase% shared\j dk-1_6_10 3.

Step 3: Configure the maximum or minimum heap size in djc-set-env.bat (or djc-set-env.shin
UNIX). For example,

set DIC_JVM MAXHEAP=1024M
set DIC JVM M NHEAP=256M

Step 4: If you will always run EAServer in 64-bit mode, set up these flags in local-setenv.bat
(or local-setenv.sh in UNIX). For example,

DIC_RT_DEFAULT=15
DIC_JDK_DEFAULT=15

DIC_ARCH 64=true

Touse JDK 1.6, replace "15" with "16".

Step 5: Start EA Server using the -arch64 flag. For example,

run-server. bat —j dkl5 —rt15 —arch64 -jvntype server
run-server.sh —jdkl5 —rt15 —arch64 -jvntype server (UN X)

or

run-server.bat —jdkl6 —-rt16 —arch64 -jvntype server
run-server.sh —j dk16 —-rt16 —arch64 -jvntype server (UN X)
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6.2.3 Errors occur when calling n-Tier application of EAServer with 64-bit JDK

In the following environment: EAServer 6.3.1.04 with 64-bit JDK + PB 11.5.1 Build 4011,
when calling the n-tier application in PB, the ConnectToServer and Createl nstance functions
return correct values, but when calling the NV O function, the following error occurs.

Error: CORBA System Exception: CORBA UNKNOM at line 19 in clicked event of object
cb_1 of w_main.

When user runsthe "N-Tier Support” feature in the Appeon Code Example demo, the
following error occurs.
Error -1

Execut e conponent failed. Error nessage =
java. lang.refl ect. | nvocati onTar get Excepti on.

Cause: PBVM and component do not support 64-bit Java server.

Solution: Uninstall Appeon Server and EAServer, then install EA Server with 32-bit JDK,
and install the 32-bit version of Appeon for PowerBuilder. When installing EA Server, you
will be offered to install JDK or use an existing local JDK. If you select to install JDK from
EAServer, it will be a 32-bit JDK.

6.2.4 #Cannot find the language resource file (dblgzh11.dll, dblgen11.dll)#

On a 64-bit machine, when starting the 64-bit EA Server which will then automatically start
SAP Sybase ASA/SQL Anywhere, you receive an error related with SAP Sybase ASA/SQL
Anywhere "Cannot find the language resource file (dblgzh11.dll, dblgen11.dll)."

Cause: The error is caused by abug in EAServer. The SAP Sybase ASA/SQL Anywhere
installed by EAServer has an extra sub-folder called client\lib32, and some DLL files (such
asdblgzhll.dll, dblgenl11.dil) were placed to thisfolder instead of the \win32 folder (\win32
iswherefiles are normally placed by the SAP Sybase ASA/SQL Anywhere independent
setup program). However, when EAServer is starting, it calls files under \win32, not under
client\lib32, when it cannot find files under \win32, it reports the error.

Solution: Copy the DLL files from the \ASA110\client\lib32 folder (not \lib64 folder,
though \lib64 folder also exists, but copying files from it cannot resolve the error) to the
\ASA110\win32 folder.

6.2.5 #Connection failed:...# error when installing EAServer in a 64-bit OS

When installing EAServer 6.3.1 in a 64-bit Windows 2008 OS, error occurs: " Connection
failed: dbicu libraries are required but not installed" or "Connection failed: Cannot convert
between requested character sets'GBK' and 'UTF-8".

Figure 6.2: dbicu librarieserror

eror x|

IIQZ' Connection failed: dbicu libraries are required but not installed
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Figure 6.3: Character error

Error

. = | Connection failed: Cannot convert between requested character sets
'GBK' and 'UTF-&'

Ok

Solution: Add the following two values to the Path environment variable: %JAGUAR%Y%
\ASA110\client\lib32; %JAGUARY\ASA110\client\lib64.

6.2.6 Cannot start EAServer Manager
Fail to start EAServer Manager.

Cause: EAServer Manager will not start when the CLASSPATH and/or PATH system
environment variables are too long. The EAServer batch files (serverstart.bat, jagmagr.bat,
etc.) configure the CLASSPATH environment variable. The Appeon installation program
adds several entries to these path variables, which can make it too long for EAServer
Manager to handle on some system configurations. When the CLASSPATH variableis over
260 characters, the batch files may fail, preventing EAServer Manager from starting properly.

Solution: There are three workarounds, the user can select one:

1. Usually the EAServer installation path is " C:\Program Files\Sybase\EA Server". If the
path is shortened (for example, "D:\EAServer"), the CLASSPATH variable length will be
reduced.

2. Use the Control Panel to edit the user and system CLASSPATH variables, and remove
unnecessary entries:

Step 1: In Windows launch System Properties from the Control Panel and navigate to the
Advanced tab.

Step 2: Click Environmental Variables, and find the CLASSPATH variable.

Step 3: Edit the CLASSPATH variable and reduce the length of the string to less than 260
characters.

It is recommended that you backup the Variable Value for the CLASSPATH before
modifying the variable, as this allows you to restore it later.

Step 4: Restart the computer.
3. Create a batch file for setting the CLASSPATH to include the necessary classes:

Step 1: Create a batch file called user_setenv.bat in the EAServer bin directory (%JAGUAR
%\bin). %JAGUAR% indicates the EA Server installation directory, for example, C:\Program
Files\Sybase\EA Server\.
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Step 2: Inthisfile, set the CLASSPATH to include only those classes that you require and
that are not added to CLASSPATH in EAServer batch files.

For more information, refer to Sybase's EAServer Troubleshooting Guide available at http://
sybooks.sybase.conv/nav/base.do.

6.2.7 Starting EAServer fails
Unable to start EAServer.

Cause: The Message Serviceis configured in EAServer, but the message service database is
not running.

Solution: Either start the message service database, or disable the message service. For more
information, refer to the EAServer user documentation.

For more information, refer to Sybase's EAServer Troubleshooting Guide available at http://
sybooks.sybase.conmv/nav/base.do.

6.2.8 EAServer cannot start with the prompt that #the system 'admin’ password
has not yet been set#

Cause: You must set avalid password for EAServer 6.1, otherwise, errors will occur when
EAServer 6.1 is started, because EA Server 6.1 does not allow null password.

Figure 6.4: System password error message

> default(jdk1.5)

he system 'admin’ password has not yet heen set.
Please set it wsing the following command:

"C:vProgran Files™AppeonsEAServershinsset-adnin-password.bat”

hen start the server again.

Solution: Take the following steps to set password for EAServer 6.1.

Step 1: Run the following command in the DOS window. Note %EA Server% stands for the
installation path of the EAServer.
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%EA Server%\bin\set-admin-password.bat
Step 2: Input a password that has at |east six characters combining both letters and numbers.

Step 3: Make sure you get the following message saying that the password is set successfully,
as shown in the following figure.

Figure 6.5: Password changed message

e Ch\WINDOWS' sy stem32) crnd.exe

Hicrosoft Windows [Version 5.2.37981)
(C) Copyright 1985-2083 Microsoft Corp.

C:sDocuments and Settings“Adminisztrator"G:isProgran Files“Appeon:ERServershin‘se
t-adrin-passward.bat"

New Password:

Uerify New Password:

The new password does not match the verification paszsword.

Pazsword not changed for username 'admninBsystenm’.

C:xDocuments and Settings“Administrator>”'C:Program Files“Appeon:EfAServersbin’ze
t-adrnin—pazsword.hat"

New Password:

Uerify New Passvord:

Pazzword changed for username 'adminPsysten’.

C:xDocuments and Settings™dministrator?

6.2.9 #Create appeon component failed# error

None of the Datawindows can be retrieved successfully when running the Appeon demos.
The error message is displayed as " Create appeon component failed".

Cause: Installing the XML option or EJB option for ASE sets alicense restriction to
EAServer. If the XML option or EJB option for ASE isinstalled, when EAServer is started,
it shows " Sybase Enterprise Application Server (ASE Edition)"; also the Imgrd.log file in the
SySAM directory lists ASE_EJB as an included option.

Solution: Remove the ASE XMLMGMT key from the SySAM license manager and then
restart the manager.

6.2.10 Pinging data source fails when using the ASA/SQL Anywhere JDBC
driver

A data sourceis created but fails to function and creates an error beginning with "Ping of
Data Source failedj-" The database uses SAP Sybase ASA/SQL Anywhere; iAnywhere
JDBC-ODBC Bridge Driver is used for the data source.

Cause: The ASA/SQL Anywhere JDBC driver and EA Server possibly fail to locate the
dbjodbc8.dll file.

Solution: Follow the suggested steps to rectify your problem.
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Step 1: Upgrade ASA/SQL Anywhere to ASA/SQL Anywhere 8.0.2 build 4361 or ASA/SQL
Anywhere 9.

Step 2: Navigate to \Sybase\SQL Anywhere 8\java\jodbc.jar, and copy the jodbc.jar file to the
%JAGUARY)\javallib folder (Windows) or $JAGUAR/javallib (UNIX).

Step 3: Navigate to \Sybase\SQL Anywhere 8\win32\dbjodbc8.dIl, and copy the dbjodbc8.dll
fileinto the directory: \Sybase\Shared\jdkversion\ire\bin\. Jdkversion indicates which version
of JDK isused, for example, jdk1.2.2_10, jdk1.3.1 06, or jdk1.4.1 03.

Step 4: Restart EAServer.

Step 5: (Assuming that ase_odbc is the data source which is set up in ODBC
manager and used to connect to ASE database) The ServerName will be similar to
"jdbc:odbc:dsn=ase_odbc"

For more information, refer to Sybase's EAServer Troubleshooting Guide available at http://
sybooks.sybase.com/nav/base.do.

6.2.11 Support for non-JDBC drivers
The Web application requires support for non-JDBC drivers.

Cause: Please refer to Sybase's EAServer Troubleshooting Guide available at http://
sybooks.sybase.com/nav/base.do.

Solution: Appeon Server uses JDBC. Y ou can also use Appeon Server with ODBC through
JDBC viatheiAnywhere, Merant, and Sun drivers.

Appeon Server supports ASE & Oracle Native Drivers through n-Tier Appeon Server
Components by simply:

Step 1: Create an ASE or Oracle Native Data Source.
Step 2: Code a POWERBUILDER NVO that connects to the Native Data Source.

Step 3: Pass an Appeon Server result set or returning arguments to the Client web application
and back viathe Appeon DataWindow/DataStore GetFull State, SetFull State, GetChanges,
and SetChanges. In string format instead of BLOB format since JavaScript does not support
the BLOB format.

For information about other possible solutions, refer to Sybase's EAServer Troubleshooting
Guide.

6.2.12 Failed to create new data sources

Failed to create a new data source in Sybase Management Console, typically prompted
with the following error message "An error occurred while creating the new data source.
Exception was:javax.management.M BeanException.”

Cause: The JDBC driver configuration that you performed before the data source creation
cannot automatically take effect if the EAServer isrunning as service.

Solution A: Use the foreground EA Server which runs in the console window.
Step 1: Stop the EAServer service from Control Panel > Administrative Tools > Services.
Step 2: Start the EA Server from the Start button or using command line.
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Step 3: Configure the data source again.
Solution B: Reinstall the EAServer service to make the JDBC configuration take effect.
Step 1: Stop the EAServer service

Step 2: Uninstall the EA Server service. Change to the EAServer bin subdirectory, and run
service [-servicename service] -remove command, substituting the service name for service.
For example,

C:\ Program Fi | es\ Sybase\ EAServer\ bi n servi ce -servi cenane EAServer -renove

Step 3: Install the EAServer service. Stay in the bin folder and run the following command
line,and run service [-servicename service] -install command. For example,

C:\ Program Fi | es\ Sybase\ EAServer\ bi n servi ce -servi cenanme EAServer -install

Solution C: Manually configure the JDBC driver in the classpath parameter in winservice.ini
file. Take configuring oracle JDBC driver as an example.

1. Goto Administrative Tools > Services.

2. Find your EA Server service and open the Properties window. Y ou can find the service ini
file path from Path to executable. For example,

""D:\ Program Fi | es\ Sybase\ EASer ver 6\ bi n\j sl . exe" -ini "D:\Program
Fi | es\ Sybase\ EASer ver 6\ bi n\. ./ confi g/ w nservi ce_EAServer.ini""

3. Open the INI file directory and add the path of the "ojdbcl4.jar" file to the corresponding
line. For example,

paraml5 = c:\eas\eas61014\bin\..\|ib\eas-server-14.jar;c:\eas\eas61014
\bin\..\lib;c:\eas\eas61014\bin\..\ant\lib\ant.jar;

:\eas\ eas61014\ Shared\ jdk1.4.2_10\lib\tools.jar;

:\eas\ eas61014\bin\..\Iib\fips\jdkl4\sslplus_nio.jar;

:\eas\ eas61014\ bin\..\lib\fips\jdkl4\sslplus.jar;

:\eas\ eas61014\ bin\..\Iib\fips\jdkl4\EccpressoFl PSJica.j ar;

:\eas\ eas61014\ bin\..\lib\fips\jdkl4\EccpressoFlPS.jar;

d:\j aguar\ Power Bui | der\ pbj dbc12105. j ar; c: \ eas\ eas61014

\ Power Bui | der\ pbj dbc12100. j ar;

c:\ eas\ eas61014\ Power Bui | der\ pbej bcl i ent 100. j ar; c: \ eas\ eas61014

\bin\..\genfiles\javal\cl asses;
c:\eas\eas61014\bin\..\lib\ext\jconn3.jar;c:\eas\eas61014

\bin\..\lib\ext\jTDS3.j ar;

c:\eas\eas61014\ bin\. .\l i b\ ext\ pbej bclient100.j ar;
c:\eas\eas61014\ bin\..\li b\ ext\pbej bclient105.jar;c:\eas\eas61014

\'bin\..\Iib\ext\pbjdbc12100.j ar;

c:\eas\eas61014\ bin\. .\l i b\ ext\ pbj dbc12105.j ar; c:\eas\eas61014

\bin\..\Ilib\ext\ojdbcl4.jar

O 0000
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7 Error Messages

7.1 Error Message Formats

Appeon for PowerBuilder can send error messages, informational messages, warnings,
notices, and prompts when you perform the Web deployment and run the Appeon Web
applications. The messages will contain the following parts:

» Error number

A five-digit number that uniquely identifies the message.

* Priority

A one- or two-digit number that indicates the severity of the error condition.

* Error message
A string that contains information about the condition that generated the message.

» Possible Cause

A string that contains information about the possible cause for the error.

* Solution

A string that contains information about the solution. But not all of the errors return the
solution.

7.1.1 Error Message Numbers and Descriptions

An error message number is unique in identifying an error message and the error message
description reflects the problem. Some error message description includes placeholders for
information (such as object names) to be inserted in the error message when it is displayed.

In the Error Message column of the error table, a percent sign (%) followed by a character
serves as a placeholder; the specific datais supplied when the error message is generated. The
notation %d is a placeholder for a number; %ls (or %.*1s) is a placeholder for a string. For
example, the actual error message displayed for error 00053 might be:

Remove the garbage control %1 in the %2 object.

When you report an error to Appeon technical support engineers, it isimportant to include
error numbers, object types, and object names. Otherwise, it can be difficult and time-
consuming for the support engineers to render assistance in resolving the error message.

7.1.2 Error Message Priority

The priority of an error message provides an indication of severity level of problem that
Appeon has encountered. Appeon divides errorsinto 4 levels according to their severity:

Table7.1: Error message properties
Error Level Severity Description

0 Not severe. The error has little impact to the functions of the application.
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Error Level Severity Description

1 Quite severe. The error is caused by incorrect configuration, and affects
the running of the application. For example, no data source is set for the
application.

2 Very severe. The error is caused by incompatibility with Appeon product.
For example, the specification of invalid Web URL.

10 Most severe. The error reflects a bug in the Appeon product.

7.2 Errors

7.2.1 Error 00001-09999
Table7.2: Error list

Errors  Priorities Error Messages

00001 1 Appeon Server profile nameis empty.

00002 1 Appeon Server nameis empty.

00003 1 Appeon Server port is empty.

00004 1 Appeon Server port isout of range.

00005 1 Failed to parse the source code. Line: %1

00006 1 AEM URL isempty.

00007 1 Deployment user name is empty.

00008 1 Data source name is empty.

00009 1 Data source name already exists.

00010 1 The database server is empty.

00011 1 Transaction object name is empty.

00012 1 No database type is specified for the transaction object.
00013 1 No data source is specified for the transaction object.
00014 1 Web server profile name is empty.

00015 1 Web server name is empty.

00016 1 Web server port is empty.

00017 1 Web server port isout of range.

00018 1 Web root is empty.

00019 1 The FTP server isempty.

00020 1 The Web server profile name already exists.

00021 1 FTP Port isincorrect.

00022 1 FTP Port isinvalid.

00023 1 No selected ODBC data source.

00024 1 Failed to log into application server.

00025 2 Failed to get detailed information of the specified cache.
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Errors Priorities Error Messages

00026 2 Failed to add the transaction object.

00027 2 Failed to edit the transaction object.

00028 2 Failed to delete the data source.

00029 2 Failed to add the data source.

00030 2 Failed to edit the data source.

00031 1 Duplicate transaction object name.

00032 2 Failed to get the cache list from the application server.

00051 1 Failed to get object %1 from the memory stack.

00052 1 The child object %1 of %2 cannot find the parent object %3jaeEae

00053 2 Remove the garbage control %1 in the %2 object.

00054 1 Cannot find the container object %2 for %1.

00055 1 Cannot find %1 data type of %2 variable in %3.

00056 2 Cannot find the function object in the template using event ID %1.

00057 1 Failed to get Appeon Server information. Please verify Appeon
Server is running.

00901 1 Cannot connect to DSN. The database server is %1.

00902 1 Failed to get syntax of %1 Datawindow in %2.

00904 1 Failed to load the file: %1.

00905 1 Failed to save thefile: %1.

00906 1 Y ou need to configure a proper DB profile for the application before
deployingit.

01001 1 Failed to generate %1 %2.

01002 1 Failed to %1 %2.

01003 1 Failed to analyze %1 %?2.

01004 1 It is unsupported to analyze %1 %2.

01005 1 Configuration for Web service object (%1) isincorrect.

01006 1 Error in loading XML file %1.

02002 2 Failed to initialize Appeon Server.

02003 1 Failed to instantiate Appeon Server.

02004 1 Exception: Format returned from Appeon Server isincorrect.

02005 1 Error in deploying %1 file.

02006 1 Failed to delete Web files.

02007 1 Cannot connect to the Web server: %1.

02010 1 Error in generating the WAR file.

02011 1 Unable to find the destination directory.

02012 1 Cannot connect to Appeon Server: %1.
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Errors Priorities Error Messages

02013 1 Cannot open the connection.

03001 1 File%lisinvalid.

03002 1 File %1 is not found.

03003 1 Invalid registry information!

03004 1 Flow module is already |oaded.

03501 1 Cannot find the PBL file.

03502 1 PBL files have been changed. Please re-deploy the application under
the debug mode.

03503 1 Filesin the Web server are not updated. Please re-deploy the
application under the debug mode.

03504 1 The default Web server is not started. Please start Web server.

03505 1 The default Appeon Server is not started. Please start Appeon
Server.

03506 1 Web server configuration settings error. Please check and correct the
Settings.

03507 1 Appeon Server configuration settings error. Please check and correct
the settings.

03508 1 No access rights to the Web server. Please check the Web server
permission settings.

03509 1 One or more files do not match. Please re-deploy the application
under the debug mode.

03510 1 Another Appeon Developer tool is running.

03511 1 The application deployed in the Encrypted mode cannot be
debugged.

04001 1 Failed to load the DLL file %1.

04002 1 Cannot find the SRD file %1.

04003 1 Cannot get Web server information from the ADTConfig.xml file.

04004 1 Cannot get Appeon Server information from the ADTConfig.xml
file.

04005 10 Failed to open Deploy.dll. Caused failure to load the deploy module.

04006 10 Failed to instantiate the deploy module.

09999 1 (Display the system error message.)

7.2.2 Error 10001-15055

Table7.3: Error list
Errors  Priorities Error Messages

10001 1 Cannot find the transaction object named %1 in sessions. Please
verify that the request is correct before send it out.
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Errors Priorities Error Messages

10014 2 Internal error. Please contact the system administrator.

10015 2 Error in connecting to AppeonDB.

10016 2 The running Appeon Server does not support the Appeon Xcelerator
deployment option in this version (version %1).

10501 2 Session isterminated by the Appeon system.

10502 2 Session isterminated by AEM.

10504 The Web application you attempt to run was removed from the
server. It cannot be run.

10505 2 Transaction has timed out. The transaction isrolled back: %1.

10506 2 Session failed.

10507 1 The server statusis %1.

10999 1 Keyword not supported: 'dsn'.

10508 1 Session has timed out.

11001 1 Cannot find the cluster service provider!

11002 0 Error in reading the cluster service provider configuration file!

11006 1 A fatal IOException occurred when retrieving the status of the server
%]1.

11007 The Appeon configuration file cannot be empty!

11008 A fatal 10Exception occurred when retrieving the configuration file
from the remote server: %1.

11009 0 A ClassNotFoundException occurred when casting the remote
Appeon configuration file content to a String array.

11010 0 An unexpected exception occurred when replicating Appeon
configuration files!

11011 0 A FileNotFoundException occurred when constructing the
FileOutputStream: %1.

11012 0 A SecurityException occurred when denying write accessto thefile:
%]1.

11013 1 A fatal I0Exception occurred when writing %1 to the local disk.

11014 0 An unexpected exception occurred and caused failure to write
Appeon configuration files to the local disk!

11015 1 A fatal I0Exception occurred when communicating with servlet /0.

11016 0 An unexpected Exception occurred and caused failure to read the
local Appeon configuration files!

11017 1 A fatal I0Exception occurred when reading the specified file: %1.

11020 0 A fatal 10Exception occurred when synchronizing the method: %1.
The remote server caled is: %2.
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Errors Priorities Error Messages

11021 0 An unexpected exception occurred and caused failure to synchronize
the method: %1.

11022 1 A fatal I0Exception occurred when synchronizing method: %1!

11023 0 A ClassNotFoundException occurred when synchronizing method:
%]1.

11024 0 An unexpected exception occurred and caused failure to synchronize
method: %1.

11025 1 A fatal I0Exception occurred when calling the specified remote
server: %l.

11026 0 An unexpected exception occurred and caused the ClusterNotify
thread to stop!

11027 1 An unexpected exception occurred and resulted in failure to retrieve
status of the server: %1.

11028 10 Application server connection error!

11029 10 Appeon Server isin the process to start. Please wait...

11030 10 The cluster list is empty. Failed to get the cluster information.

11501 0 Failed to clear the cluster configuration information from the

specified server %1!

11502 0 Failed to get session information from the specified server %1.
11503 0 Failed to get transaction information from the specified server %1.
11508 0 The Appeon Server is already configured in AEM.

11509 1 AEM could not interface with the specified Appeon Server. Please
verify that your Appeon Server isrunning and that the settings are
correct.

11510 0 The specified server has aready been in another cluster.

11511 1 Failed to synchronize AEM settings on the following clustered

servers. %l. Please restart or remove these servers to ensure the
cluster runs normally!

11512 0 Error occurred when updating AEM settings on the local machine.
Please read the log for more details.

11513 0 Please add the | P address or name of the local Appeon Server first!
11514 0 Please enter the IP address or machine name of the Appeon Server.
11515 0 Please enter the port number of the Appeon Server.

11516 0 Please input avalid port number with arange from 0 to 65535.
11517 0 I P address or machine name cannot be localhost or 127.0.0.1!

11518 0 Please remove the local Appeon Server from the cluster last!

11519 0 The interval should be a positive integer, greater than 0 and less than

2147483648.
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Errors Priorities Error Messages

11520 0 Y ou must select one option between "Enable Remote Backup™" and
"Enable Local Backup".

11521 1 Errors occurred when synchronizing AEM configuration information
to the specified remote server: %1. The method is. %2.

11522 1 Errors occurred in calling the remote method. The method is; *; the
remote server is: *

11523 2 It exceeds the CPU count in the license.

11524 2 The license of the remote Appeon Server does not match with the
license on the local server.

11525 2 The license of the remote Appeon Server is not a cluster version.

12001 10 Failed to get the transaction information from the Appeon Server
configuration file (transaction object name = %1). Please make sure
you have configured this transaction object in AEM correctly.

12006 1 Failed to load the cluster configuration information from filel

12007 1 Failed to save the cluster configuration information into file!

12008 0 Application nameisnull.

12009 0 Property %1 has already been defined.

12010 0 Argument cannot be null or empty string.

12011 1 Error occurred when loading the application configuration file!

12012 1 Error occurred when loading the server configuration information!

12013 1 Error occurred when loading %1 file!

12014 1 Error occurred when reading the mapping file: %1!

12015 0 ServerConfig object isnull.

12016 0 ApplicationsConfig is null.

12017 1 Errors occurred when writing the server-config.xml.

12018 1 Errors occurred when writing the application-config.xml.

12019 1 Errors occurred when loading application configuration!

12020 1 Failed to load the ServerConfig object!

12021 1 Failed to load the ThreadQueues Config object from file %1!

12022 1 Failed to load the mapping object of cluster-mapping.xml.

12025 1 The selected application %1 does not exist in the Appeon Server.

12026 2 The application number exceeds the license limit %1.

12501 10 Post datais null!

12502 10 Session is not found!

12503 10 Cannot read the Msg's total!

12504 10 Call parseAndExecuteCommand: Cannot read FuctionType!

12505 2 Authority is required!
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Errors Priorities Error Messages

12506 10 The input function type (%1) isinvalid. No code can be found to
match this type!

12507 10 %1 Cannot read the parameter count!

12508 10 %1: Parameter count mismatch!

12509 10 %1: Cannot read the parameter length!

12510 10 %1: Cannot read the Parameter value!

12511 10 Appeon Server isin the process to start. Please wait...

13001 0 The original DataWindow parameters are not compatible with the
client parameters.

13002 0 Unsupported stored procedure syntax: %1.

13003 10 Unsupported PowerBuilder data type (type=%1).

13004 0 Cannot find the specified argument %1 in the argument list.

13005 0 Stored procedure syntax cannot be empty or null.

13006 0 Failed to analyze the stored procedure syntax, due to %1.

13007 0 Register parameter error: index = %1, jdbcType = %2, value = %3.

13008 0 Client parameter of the UpdateBlob statement cannot be null.

13009 0 Both the PB type and JDBC type of the parameter areinvalid.

13010 10 DataObject name cannot be empty.

13011 0 This column's data type %1 requires the use of an embedded SQL
Statement.

13012 0 User SQL cannot have parametersin Verify SQL Command.

13013 2 Failed to parse the result meta of the Select statement, due to %1.

13014 2 Failed to parse parameter meta of stored procedure, due to %1

13015 10 Failed to get Datawindow SQL from Appeon Server (Application =
%1, DataObject = %2, DBType = %3). Please make sure you have
deployed your application correctly.

13016 10 Cannot find the following embedded SQL in AppeonDB:
ApplicationName =%1 and SQLKey =%2.

13017 10 The value of Application Nameisempty or null.

13018 10 The value of Datawindow Name is empty or null.

13019 10 The value of DWSyntaxString is empty or null.

13020 10 Call an unused method.

13021 10 Errorsin deleting all Datawindows.

13022 1 The application %L1 is being deployed by another user.

13023 10 The value for SglKey cannot be empty or null.

13024 10 The value for embedded SQL cannot be empty or null.
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Errors Priorities Error Messages

13025 2 Cannot find the following DatawWindow syntax in AppeonDB:
ApplicationName =%1 and DataWindowName =%2.

13026 2 Parameter error: the value for %1 is empty or null.

13027 10 Unsupported database type. The DBMS code is %1.

13028 2 Blob or Clob variable for UpdataBlob cannot be empty.

14001 2 License has expired on %1.

14002 2 Unable to validate license key "%1". The number has exceeded the
limit of your current license.

14003 2 Error in validating license signature!

14004 2 Missing licensefile.

14005 2 Invalid software license file %1.

14006 2 Unable to validate the current license file.

14009 2 Error in validating hash code!

14016 2 Thelicense fileinstalled to the machine hosting Appeon Server
allows only %1 CPU(s), but %2 CPUs are detected.

14017 2 Appeon Server is configured for the network card with physical
address %1, but the network card on the Appeon Server is %2.

14018 2 Y our Appeon Server %1-day trial license expired on %2.

14019 2 Cannot connect to AppeonDB. Appeon Server failed to start.

14020 2 The application cannot be run because the product license
information cannot be found.

14021 2 An error occurred when validating the license for cluster version.

14022 2 Server failed to start, because the CPU number exceeds the license
limit.

14023 2 The remote Appeon Server is not a cluster version.

14024 2 The license of the remote Appeon Server does not match with the
license of the local server.

14025 2 Thelicensein useisfor the %1 platform.

14026 2 The licenseis not for the application server %1.

14027 2 The current operating system is %1. But the license isfor the
platform other than Windows, Solaris, Al X, Red-Linux, and HP-
Unix.

14028 2 The remote Appeon Server isacluster version.

14501 10 System error.

14502 1 The specified HTTP header does not exist.

15001 2 Failed to connect to EA Server. Please check connection settings.

15002 2 Data source name cannot be null.

15003 2 Failed to add/modify data source.
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15004 2 Failed to get the specified data source information.
15005 2 Failed to delete the specified data source.

15006 2 Failed to refresh the specified data source.

15007 2 Failed to get all data source names.

15008 2 Failed to connect to WebL ogic. Please check the connection settings.
15009 2 Failed to add the data source.

15010 2 Failed to modify the data source.

15011 2 Failed to get the specified data source information.
15012 2 Failed to delete the specified data source.

15013 2 Failed to refresh the specified data source.

15014 2 Failed to get all data source names.

15015 2 Failed to test the data source.

15016 2 Failed to test the data source.

15017 2 Failed to import NV O components.

15018 2 Failed to export NVO components.

15019 2 Failed to get all EAServer packages.

15020 2 Failed to get all components from the specified package.
15021 2 Failed to delete the specified component.

15022 2 Failed to import the AEM configuration settings.

15023 2 Failed to export the AEM configuration settings.

15051 2 Failed to add the transaction object.

15052 2 Failed to delete the transaction object.

15053 2 Failed to modify the transaction object.

15054 2 Failed to get all transaction objects.

15055 2 Failed to get the specified transaction object information.

7.2.3 Error 20001-20035

Table7.4: Error list

Errors  Priorities Error Messages

20001 2 RegMultiString, RegLink and RegBinary data are unsupported in the
server execution mode of RegistryGet. For more help, please consult
the Appeon Help.

20002 2 RegMultiString data are unsupported in the client execution mode
of RegistryGet. For more help, please consult the Appeon User
Documents.
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20003 2 RegMultiString data are unsupported in the client execution mode
of RegistrySet. For more help, please consult the Appeon User
Documents.

20004 2 The thread pool settings cannot have a value less then zero or avalue

exceeding the maximum allowed number. For more help, please
consult the Appeon User Documents.

20005 2 The specified variable type isincorrect. For more help, please
consult the Appeon User Documents.

20006 2 The class hame of the object to be created does not exist. For more
help, please consult the Appeon User Documents.

20007 2 No transaction object is specified when declaring cursor or stored
procedure. For more help, please consult the Appeon user document.

20008 2 when declaring cursor or stored procedure, DynamicStagingArea
object is not instantiated. For more help, please consult the Appeon
user document.

20009 2 Y ou are not logged into the mail system yet! For more help, please
consult the Appeon user document.

20010 2 Transaction object is not connected. For more help, please consult
the Appeon user document.

20011 2 Transaction object is already connected. It cannot be connected
again. For more help, please consult the Appeon user document.

20012 2 Menu fileisinvalid. Failed to create the file! For more help, please
consult the Appeon user document.

20013 2 Cannot create the WSDL Reader object. For more help, please
consult the Appeon user document.

20014 2 Failed to load the WSDL file. For more help, please consult the
Appeon user document.

20015 2 Cannot get the Service definition from the WSDL file. For more
help, please consult the Appeon user document.

20016 2 Cannot get the Port definition from the WSDL file. For more help,
please consult the Appeon user document.

20017 2 Cannot get the Operation definition from the WSDL file. For more
help, please consult the Appeon user document.

20018 2 Cannot get the Part definition from the WSDL file. For more help,
please consult the Appeon user document.

20019 2 Cannot get the definition of SoapClient from the WSDL file. For

more help, please consult the Appeon user document.

20020 2 Failed to initialize SoapClient. For more help, please consult the
Appeon user document.

20021 2 Failed to load DLL file. For more help, please consult the Appeon
user document.
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20023 2 DataWindow description file does not exist. For more help, please
consult the Appeon user document.

20024 2 Failed to parse the DataWindow description file. For more help,
please consult the Appeon user document.

20025 2 Failed to apply data memory. For more help, please consult the
Appeon user document.

20026 2 Failed to parse SyntaxFromSQL. For more help, please consult the
Appeon user document.

20027 0 Cannot find the image file. For more help, please consult the Appeon
user document.

20028 2 Print error. For more help, please consult the Appeon user document.

20029 2 Failed to create RichText Datawindow. Incorrect information of
RichText control in the local system. For more help, please consult
the Appeon user document.

20030 2 Cannot parsethe invalid RTF file. For more help, please consult the
Appeon user document.

20031 2 Information of InputField in RichText Datawindow isincomplete.
For more help, please consult the Appeon user document.

20032 2 Failed to print RichText DataWindow. No default printer in the local
machine. For more help, please consult the Appeon user document.

20033 2 Print Preview failed. No default printer in the local machine. For
more help, please consult the Appeon user document.

20034 2 InputField information does not match the Datawindow column
information. For more help, please consult the Appeon user
document.

20035 2 Settings of InputField location are incorrect. Need to adjust the
location. For more help, please consult the Appeon user document.

7.2.4 Solutions

7.2.4.1 Error 00001

Priorityl

Error Message

Appeon Server profile name is empty.

Possible Cause

When configuring the Appeon Server profile, no profile nameis provided.

7.2.4.2 Error 00002

Priorityl
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Error Message
Appeon Server name is empty.
Possible Cause

When configuring the Appeon Server profile, no machine name or | P address of the Appeon
Server is provided.

7.2.4.3 Error 00003

Priorityl

Error Message

Appeon Server port is empty.

Possible Cause

When configuring Appeon Server profile, no Appeon Server port is provided.

7.2.4.4 Error 00004

Priorityl

Error Message

Appeon Server port isout of the valid range.

Possible Cause

The specified Appeon Server port is not between 1 and 65535.

7.2.4.5 Error 00005

Priorityl

Error Message

Failed to parse the source code. Line: %1
Possible Cause

The PBL list added to the Appeon configuration isincomplete, or the object is defined in the
PBD file.

Solution

1) Verify that the application was full built in the PowerBuilder IDE and no errors were
reported. 2) Verify that the PBL list added to the Appeon Developer > Appeon Profile
Configuration window is complete. 3) Verify that no reference is made to the object
defined in PBD.

7.2.4.6 Error 00006

Priorityl

Error Message
AEM URL isempty.
Possible Cause
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When configuring the Appeon Server profile, the AEM URL is empty.
Solution
Please input the correct URL.

7.2.4.7 Error 00007

Priorityl

Error Message

Deployment user name is empty.
Possible Cause

When configuring the Appeon Server profile, the deployment security is enabled, but no
deployment username is provided.

7.2.4.8 Error 00008

Priorityl

Error Message

Data source name is empty.

Possible Cause

When configuring the data source, no data source name is specified.

7.2.4.9 Error 00009

Priorityl

Error Message

Data source name already exists.
Possible Cause

When configuring the data source, the provided data source name aready existsin the
Appeon Server.

7.2.4.10 Error 00010

Priorityl

Error Message

The database server is empty.

Possible Cause

When configuring the transaction object, no database server address is provided.

7.2.4.11 Error 00011

Priorityl
Error Message
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Transaction object name is empty.
Possible Cause
When configuring the transaction object, the transaction object name is not provided.

Solution
Please input the correct name of the transaction object.

7.2.4.12 Error 00012

Priorityl
Error Message
No database type is specified for the transaction object.

Possible Cause
When configuring the transaction object, no database type is specified for it.

7.2.4.13 Error 00013

Priorityl
Error Message
No data source is specified for the transaction object.

Possible Cause
When configuring the transaction object, no data source is assigned to it.

7.2.4.14 Error 00014

Priorityl
Error Message
Web server profile name is empty.

Possible Cause
When configuring the Web server profile, no profile name is specified.

7.2.4.15 Error 00015

Priorityl
Error Message
Web server name is empty.

Possible Cause
When configuring the Web server profile, no machine name or | P address of the Web server

is specified.
7.2.4.16 Error 00016

Priorityl

Troubleshooting Page 139



Error Messages Appeon® for PowerBuilder® 2013 R2

Error Message

Web server port is empty.

Possible Cause

Web server port is not specified when configuring the Web server profile.
Solution

Specify avalid Web server port.

7.2.4.17 Error 00017

Priorityl
Error Message
Web server port isout of range.

Possible Cause
When configuring the Web server profile, the specified port is not between 1 and 65535.

7.2.4.18 Error 00018

Priorityl
Error Message
Web root is empty.

Possible Cause
When configuring the Web server profile, the local file transfer is selected, but no Web root

IS specified.
7.2.4.19 Error 00019

Prioritylv
Error Message
The FTP server is empty.

Possible Cause
When configuring the Web server profile, the FTP file transfer is selected, but no FTP server

Is specified.
7.2.4.20 Error 00020

Priorityl
Error Message
The Web server profile name already exist.

Possible Cause
When configuring the Web server profile, the provided profile name already exists.
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7.2.4.21 Error 00021

Priorityl

Error Message

FTP Port isincorrect.

Possible Cause

The FTP Port was not specified when configuring the Web server profile.
Solution

Specify avalid FTP port.

7.2.4.22 Error 00022

Priorityl

Error Message
FTP Port isinvalid.
Possible Cause

When configuring the Web server profile, the specified FTP port is not between 0 and
65535.

Solution
Specify avalid port ranging from 0~65535.

7.2.4.23 Error 00023

Priorityl

Error Message

No selected ODBC data source.

Possible Cause

No data source is selected when configuring the ODBC interface.
Solution

Select a data source from the list.

7.2.4.24 Error 00024

Priorityl

Error Message

Failed to log into application server.

Possible Cause

The user name and password used to connect to the application server are incorrect.
Solution

Provide the correct user name and password.
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7.2.4.25 Error 00025

Priority2

Error Message

Failed to get detailed information of the specified cache.

Possible Cause

Failed to get the detailed information of the specified cache from the application server.

7.2.4.26 Error 00026

Priority2

Error Message

Failed to add the transaction object.

Possible Cause

Failed to add a transaction object in the application server.

7.2.4.27 Error 00027

Priority 2

Error Message

Failed to edit the transaction object.

Possible Cause

Failed to edit a transaction object in the application server.

7.2.4.28 Error 00028

Priority 2

Error Message

Failed to delete the data source.

Possible Cause

Failed to delete a data source in the application server.

7.2.4.29 Error 00029

Priority 2

Error Message

Failed to add the data source.

Possible Cause

Failed to add a data source in the application server.

7.2.4.30 Error 00030

Priority 2
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Error Message

Failed to edit the data source.

Possible Cause

Failed to edit a data source in the application server.

7.2.4.31 Error 00031

Priority 1

Error Message

Duplicate transaction object name.

Possible Cause

A transaction object with the same name already exists.
Solution

Save the new transaction object with a different name.

7.2.4.32 Error 00032

Priority 2

Error Message

Failed to get the cache list from the application server.

Possible Cause

1) The network connection is unstable. 2) The application server shuts down.

7.2.4.33 Error 00051

Priority 1

Error Message

Failed to get object %1 from the memory stack.
Possible Cause

1) Appeon Developer failed to export the object. 2) The PBL list added to the Appeon
Developer configuration window isincomplete or the object is defined in the PBD file,
which causes the object to be ruined.

Solution

1) Verify that the application was full built in the PowerBuilder IDE and no errors were
reported. 2) Verify that the PBL list added to the Appeon Developer | Appeon Profile
Configuration window is complete. 3) Verify that the script makes no reference to the object
defined in the PBD file.

7.2.4.34 Error 00052

Priority 1
Error Message
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The child object %1 of %2 cannot find the parent object %3.
Possible Cause

The PBL list added to the Appeon Developer configuration isincomplete or the script makes
reference to the object defined in the PBD file.

Solution

1) Verify that the application was full built in the PowerBuilder IDE and no errors were
reported. 2) Verify that the PBL list added to the Appeon Developer | Appeon Profile
Configuration window is complete. 3) Verify that the script makes no reference to the object
defined in the PBD file.

7.2.4.35 Error 00053

Priority 2

Error Message

Remove the garbage control %1 in the %2 object.
Possible Cause

PowerBuilder object contains some garbage objects. Appeon Developer will automatically
remove these garbage objects. Thisisonly a prompt. It will not affect the parsing result, and
you can disregard it.

7.2.4.36 Error 00054

Priority 1

Error Message

Cannot find the container object %2 for %1.
Possible Cause

1) Appeon Developer failed to export the object. 2) The PBL list added to the Appeon
Developer configuration window isincomplete or the script makes reference to the object
defined in the PBD file.

Solution

1) Verify that the application was full built in the PowerBuilder IDE and no errors were
reported. 2) Verify that the PBL list added to the Appeon Developer | Appeon Profile
Configuration window is complete. 3) Verify that the script makes no reference to the object
defined in the PBD file.

7.2.4.37 Error 00055

Priority 1

Error Message

Cannot find %1 datatype of %2 variable in %3.
Possible Cause

The PBL list added to the Appeon Developer configuration window isincomplete or the
script makes reference to the object defined in the PBD file.
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Solution

1) Verify that the application was full built in the PowerBuilder IDE and no errors were
reported. 2) Verify that the PBL list added to the Appeon Developer > Appeon Profile
Configuration window is complete. 3) Verify that the script makes no reference to the
object defined in the PBD file.

7.2.4.38 Error 00056

Priority 2

Error Message

Cannot find the function object in the template using event 1D %1.
Possible Cause

The event ID is not defined in the Appeon Developer template.

7.2.4.39 Error 00057

Priority 1

Error Message

Failed to get Appeon Server information.

Possible Cause

1) Appeon Server is not started. 2) Appeon Server Profile was configured incorrectly.
Solution

1) Start Appeon Server. 2) Verify that the Appeon Server Profile is configured correctly.

7.2.4.40 Error 00058

Priority 1

Error Message

Cannot find %1's ancestor object %2.
Possible Cause

The PBL list added to the Appeon Developer configuration window isincomplete or the
script makes reference to the object defined in the PBD file.

Solution

1) Verify that the application was full built in the PowerBuilder IDE and no errors were
reported. 2) Verify that the PBL list added to the Appeon Developer > Appeon Profile
Configuration window is complete. 3) Verify that the script makes no reference to the
object defined in the PBD file.

7.2.4.41 Error 00059

Priority 1
Error Message
Cache name ""%1"" containsillegal characters.
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Possible Cause

Cache name can only contain a combination of letters, underscores ("_"), dot ("."), and
numbers.

7.2.4.42 Error 00060

Priority 1

Error Message

The database port for the data source exceeds the valid range.
Possible Cause

The port must range from 0 to 65535.

7.2.4.43 Error 00901

Priority 1

Error Message

Cannot connect to DSN. The database server is %l.

Possible Cause

Failed to connect to the database configured for the application.
Solution

Configure the database connection settings correctly and make sure that the connection test
Is successful.

7.2.4.44 Error 00902

Priority 1

Error Message

Failed to get syntax of %1 DatawWindow in %2.
Possible Cause

1) There are syntax errorsin DataWindow. 2) The PBL file version does not match the
specified PowerBuilder version.

Solution

1) Full build the application in the PowerBuilder IDE. 2) Fix the syntax errorsin
DataWindow. 3) Verify that the PBL file version is the same as the specified PowerBuilder
version.

7.2.4.45 Error 00904

Priority 1

Error Message

Failed to load thefile: %1.
Possible Cause
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1) Thefileformat is corrupt or the file isincomplete. 2) The login account has no read
permission on thefile.

Solution

1) Delete the file and re-deploy the application. 2) Assign the read permission to the current
login user.

7.2.4.46 Error 00905

Priority 1

Error Message

Failed to save thefile: %1.

Possible Cause

1) No disk spaceisavailable. 2) The current login user has no write permission on the file.
Solution

1) Prepare enough disk space. 2) Assign the write permission to the current login user.

7.2.4.47 Error 00906

Priority 1

Error Message

Y ou need to configure a proper database connection for the application before deploying it.
Possible Cause

The application connects to databases and uses DataWindows, but no database connection is
configured.

Solution
Configure aproper DB profile in the application profiles configuration page.

7.2.4.48 Error 01001

Priority 1

Error Message

Failed to generate %1 %2.

Possible Cause

This error is caused by another error which occurred previously.
Solution

Please check the log file and fix the previous error.

7.2.4.49 Error 01002

Priority 1
Error Message
It is unsupported to generate %1 %2.
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Possible Cause

PowerBuilder source code contains some Appeon unsupported features.
Solution

Remove or workaround the Appeon unsupported features in the source code.

7.2.4.50 Error 01003

Priority 1

Error Message

Failed to analyze %1 %?2.
Possible Cause

The PBL list added to the Appeon Developer configuration window isincomplete or the
script makes reference to the object defined in the PBD file.

Solution

1) Verify that the PBL list added to the Appeon Developer | Appeon Profile Configuration
window is complete. 2) Verify that the script makes no reference to the object defined in the

PBD file.

7.2.4.51 Error 01004

Priority 1

Error Message

It is unsupported to analyze %1 %?2.

Possible Cause

The PowerBuilder object contains Appeon unsupported features.

Solution

View the unsupported features in the UFA report and remove or workaround them.

7.2.4.52 Error 01005

Priority 1

Error Message

Configuration for Web service object (%1) isincorrect.
Possible Cause

1) The Web service was not configured. 2) The WSDL file, service or port for the Web
server was configured incorrectly.

Solution
Specify the correct settings for Web service, including the WSDL file, service and port.

7.2.4.53 Error 01006

Priority 1
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Error Message
Error in loading XML file %1.
Possible Cause

The user erroneously modified or deleted the RuleTemplate.xml file under the Appeon
Developer directory.

Solution
Please reinstall Appeon Developer.

7.2.4.54 Error 02002

Priority 2

Error Message

Failed to initialize Appeon Server.

Possible Cause

Failed to open the adtconfig.xml file. adtconfig.xml is corrupt or modified manually.

7.2.4.55 Error 02003

Priority 1

Error Message

Appeon Server configuration isincorrect.

Possible Cause

adtconfig.xml is corrupt or manually modified.

Solution

Please re-configure the Appeon Server Profile in Appeon Developer.

7.2.4.56 Error 02004

Priority 1

Error Message

Format returned from Appeon Server isincorrect.

Possible Cause 1:

The Appeon Server version and the Appeon Developer version are not the same.
Solution 1:

Please use Appeon Server and Appeon Developer of the same version.

Possible Cause 2:

Certain DatawWindow syntax has not been deployed successfully. This happens only for
very large applications with an excessive number of DataWindow SQL (say over 10,000) or
embedded SQL (say over 3,000).

Solution 2:
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Step 1: Adjust the value of the following parameters in the AppeonDev.ini file (located
under C:\Program Files\Appeon\Devel oper2013R2\ and will be copied to the "bin" folder of
application package by Appeon Package Wizard):

[ Depl oyConfi g]

Bat chDWsynLen= 10000000
Bat chDWSynNurm= 200

Bat chDW5gl Nurm= 500

Bat chESgl Num=500

BatchDWSynL en specifies the length (in byte) of the DatawWindow syntax, which when
reached the deployment tool will commit to Appeon Server at one time.

BatchDWSynNum specifies the number of DataWindow syntax, which when reached the
deployment tool will commit to Appeon Server at one time.

BatchDWSglNum specifies the number of Datawindow SQL, which when reached the
deployment tool will commit to Appeon Server at one time.

BatchESgINum specifies the number of embedded SQL, which when reached the
deployment tool will commit to Appeon Server at one time.

By increasing the value of the above parameters (typically BatchDWSgINum and
BatchESgINum) according to the number of DataWindow SQL and embedded SQL used
in your application, thiswill reduce the server calls so it eliminates the chance of failing
to commit certain syntax. If you have no idea of the number of Datawindow SQL and
embedded SQL, you can increment the value by 200 each time and then full deploy the
application to seeif this error disappears.

Step 2: Modify the [1S web.config xml file.

Go to C:\Inetpub\wwwroot\appeon\AEM, and add the following code to the web.config
XML file. By default, the value of the Execution Timeout is 100 seconds, and the value
of the Max Request Length is4096K. Y ou can use larger values for these two properties
according to the specific needs.

<system.web>

<htt pRunti me executi onTi meout ="30000" naxRequestLength = "102400" />

<httpHandlers>

Restart the 11S server to make this change take effect.

7.2.4.57 Error 02005

Priority 1

Error Message

Error in deploying %l file.
Possible Cause

1) Thefileis not generated or deleted. 2) A file with the same name already existsand is
read-only. 3) Thefileisin use.
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Solution

Full deploy the application with the "Full Application Deployment™ option in Appeon
Developer.

7.2.4.58 Error 02006

Priority 1

Error Message

Failed to delete Web files.
Possible Cause

1) Thefiles on the Web server were modified to be Read-only. 2) The administrator
changed the permission. 3) The Web server is being used. 4) The Application Profile for this
application is removed.

Solution

Check that the Web files exist and are not read-only, and that the Web server is not being
used and the application profile is not removed from Appeon Devel oper.

7.2.4.59 Error 02007

Priority 1

Error Message

Cannot connect to the Web server: %1.
Possible Cause

1) The Web server 1P, port, user name or password is incorrect. 2) The Web server Web root
isempty.

7.2.4.60 Error 02010

Priority 1

Error Message

Error in generating the WAR file.

Possible Cause

Appeon Developer is corrupted. Please reinstall Appeon Developer.

7.2.4.61 Error 02011

Priority 1

Error Message

Unable to find the destination directory.
Possible Cause

Cannot write to the Web server. Please contact the administrator and grant proper rights to
the login user.
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7.2.4.62 Error 02012

Priority 1

Error Message

Cannot connect to Appeon Server: %l.
Possible Cause

1) The server name, port or password isincorrect. 2) The Deployment Security setting in
AEM is enabled.

Solution

Please check that the Appeon Server server name and port. If deployment security in AEM
is enabled, you must also check the deployment username and password.

7.2.4.63 Error 02013

Priority 1

Error Message

Connection to Appeon Server is terminated.
Possible Cause

If the number of DataWindows exceeds 4000, deploying the DataWindow syntax under
Windows X P may encounter connection failure. Appeon Developer will resume the
connection after this error and the running of the Web application will not be affected.

Solution
Reducing the number of DatawWindows to less than 2000 can totally eliminate this problem.

7.2.4.64 Error 03001

Priority 1

Error Message

File %1 isinvalid.

Possible Cause

Thefileis destroyed or the file format isincorrect.
Solution

1) Re-deploy the application using the "Full Application Deployment™ option in Appeon
Developer. 2) Reinstall Appeon Developer.

7.2.4.65 Error 03002

Priority 1

Error Message

File %1 is not found.
Possible Cause
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The specified file does not exist.
Solution

1) Re-deploy the application using the "Full Application Deployment™ option in Appeon
Developer. 2) Reinstall Appeon Developer.

7.2.4.66 Error 03003

Priority 1

Error Message

Invalid registry information!
Possible Cause

The registry information isincorrect. For example, the format isincorrect, or the registry
information isincomplete.

Solution
Reinstall Appeon Developer.

7.2.4.67 Error 03004

Priority 1

Error Message

Flow module is already |oaded.

Possible Cause

The flow module cannot be loaded repeatedly.

Solution

Close the program that is loading the flow module and then start the program again.

7.2.4.68 Error 03501

Priority 1

Error Message

Cannot find the PBL file.

Possible Cause

The PBL files have been deleted or moved to a different location.
Solution

L ocate the correct PBL files and re-deploy the application.

7.2.4.69 Error 03502

Priority 1
Error Message
PBL files have been changed. Please re-deploy the application under the debug mode.
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Possible Cause

The PBL files on the local machine have been changed. But the filesin the Web server are
not changed correspondingly and the debug information is not updated with these changes.

Solution
Re-deploy the application under the debug mode.

7.2.4.70 Error 03503

Priority 1
Error Message

Filesin the Web server are not updated. Please re-deploy the application under the debug
mode.

Possible Cause

The PBL files on the local machine have been changed. But the filesin the Web server are
not changed correspondingly and the debug information is not updated with these changes.

Solution
Re-deploy the application under the debug mode.

7.2.4.71 Error 03504

Priority 1

Error Message

The default Web server is not started. Please start Web server.
Possible Cause

Web server isnot started.

Solution

Start Web server.

7.2.4.72 Error 03505

Priority 1

Error Message

The default Appeon Server is not started. Please start Appeon Server.
Possible Cause

Appeon Server isnot started.

Solution

Start Appeon Server.

7.2.4.73 Error 03506

Priority 1
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Error Message
Web server configuration settings error. Please check and correct the settings.
Possible Cause

The port or name settings in the Web server configuration file isincorrect. Please check the
settings and test them.

Solution
Correct the configuration settings for the Web server.

7.2.4.74 Error 03507

Priority 1
Error Message
Appeon Server configuration settings error. Please check and correct the settings.

Possible Cause

The port or name settings in the Appeon Server configuration file isincorrect. Please check
the settings and test them.

Solution
Correct the configuration settings for the Appeon Server.

7.2.4.75 Error 03508

Priority 1
Error Message
No access rights to the Web server. Please check the Web server permission settings.

Possible Cause

The current user account cannot write to the Web server. Please use a different user account
or grant Write permission to the current user.

Solution
Enable the Write permission in the Web server.

7.2.4.76 Error 03509

Priority 1

Error Message

One or more files do not match. Please re-deploy the application under the debug mode.
Possible Cause

The debug information on the local machine do not match with the deployed file or other
unknown errors.

Solution
Deploy the application again under the debug mode.
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7.2.4.77 Error 03510

Priority 1

Error Message

Another Appeon Developer tool is running.

Possible Cause

When Appeon Debugger is started, it detects that another Appeon Developer tool is running.
Solution

Close the other Appeon Developer tool and start the Appeon Debugger again.

7.2.4.78 Error 03511

Priority 1

Error Message

The application deployed in the Encrypted mode cannot be debugged.
Possible Cause

When the application is deployed in the Encrypted mode, it cannot be debugged using the
Appeon Debugger.

Solution
Select the Debug mode and deploy the application again.

7.2.4.79 Error 04001

Priority 1
Error Message
Failed to load the DLL file %1.

Possible Cause
Appeon Developer is destroyed. Please reinstall Appeon Developer.

7.2.4.80 Error 04002

Priority 1

Error Message

Cannot find the SRD file %1.

Possible Cause
The SRD file for the DatawWindow failed to generate.

7.2.4.81 Error 04003

Priority 1
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Error Message
Cannot get Web server information from the ADTConfig.xml file.
Possible Cause
The Web server information in the ADTConfig.xml fileis ruined.

7.2.4.82 Error 04004

Priority 1

Error Message

Cannot get Appeon Server information from the ADTConfig.xml file.
Possible Cause

The Appeon Server information in the ADTConfig.xml is ruined.

7.2.4.83 Error 04005

Priority 10

Error Message

Failed to open Deploy.dll, hence failed to load the deploy module.
Possible Cause

The Deploy.dll file does not exist or the file is corrupt.

Solution

Replace with the correct Deploy.dll file. Or reinstall Appeon Developer.

7.2.4.84 Error 04006

Priority 10

Error Message

Failed to initialize the deploy module.

Possible Cause

The EonDeploy.dll fileis not found or the file is corrupt.
Solution

Reinstall Appeon Developer.

7.2.4.85 Error 09999

Priority 1
Error Message
Possible Cause

The error messages returned from Windows OS, such as, Insufficient storage space,
Insufficient memory, etc.
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7.2.4.86 Error 10001

Priority 1

Error Message

Cannot find the transaction object named %1 in the current session.
Possible Cause

The transaction object is not configured in AEM.

Solution

Configure the transaction object in AEM. Refer to Appeon Server Configuration Guide for
detailed instructions.

7.2.4.87 Error 10014

Priority 2

Error Message

Internal error. Please contact the system administrator.
Possible Cause

1) The network environment is unstable, causing data to be incomplete and data protocol
errors. 2) Other unknown errors.

Solution

Contact the administrator and check the Appeon Server log files for detailed error
information. Or send the log files to Appeon technical support engineers.

7.2.4.88 Error 10015

Priority 2

Error Message

Error in connecting to AppeonDB.
Possible Cause

The JDK versionisnot 1.3 or above.
Solution

Check that the JDK version is 1.3 or above.

7.2.4.89 Error 10016

Priority 2

Error Message

The running Appeon Server does not support Web applications deployed in this version
(version = 9%1).

Possible Cause

The Appeon Server version and Appeon Developer version used to deploy the Web
application is not the same.
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Solution

1) Use the Appeon Developer of the same version to deploy the application and use the
Appeon Server of the same version to run it. 2) Reinstall Appeon 5.0 for PowerBuilder.

7.2.4.90 Error 10017

Priority 2

Error Message

Failed to connect to data source: %1. The causeis. %2.
Possible Cause

1) The database driver does not exist or the version isincorrect. 2) The settings for
connection URL or the driver are incorrect. 3) The user name and password is incorrect.

Solution

1) Check that the database driver exists and the version is compatible. 2) Check in the user
documents provided by the database driver vendor that the settings for URL and driver are
correct. 3) Check that the user name and password are correct. Specially check the cases and
spaces.

7.2.4.91 Error 10501

Priority 2

Error Message

Session is terminated by the Appeon system.

Possible Cause

The session has timed out. The session is inactive for the specified amount of time.
Solution

Specify a proper timeout period in AEM > Application > Timeout settings. A proper
timeout period would be 1.5 to 3 times of the operation interval.

7.2.4.92 Error 10502

Priority 2

Error Message

Session isterminated by AEM.

Possible Cause

The session isdeleted in AEM by the system administrator.
Solution

Click Refresh in the |E toolbar and log in to the application again.

7.2.4.93 Error 10504

Priority 2
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Error Message

The Web application you attempt to run was removed from the server. It cannot be run.
Possible Cause

1) The application has been removed from the server. 2) The system is being updated.

7.2.4.94 Error 10505

Priority 2

Error Message

Transaction has timed out. The transaction is rolled back: %1.
Possible Cause

Transaction has timed out, due to along transaction execution time.
Solution

1) Modify the source code and reduce the transaction execution time. 2) Increase the
transaction timeout period in AEM. However, if the timeis set too long, the performance
will slow down because the database will be locked for alonger time.

7.2.4.95 Error 10506

Priority 2

Error Message

Session failed. Please run the application again.

Possible Cause

1) The server isrestarted. 2) The session has timed out.

Solution

Please click Refresh on the |E toolbar and log in to the application again.

7.2.4.96 Error 10507

Priority 1

Error Message

The server statusis %1.

Possible Cause

Server is still in the process of starting.
Solution

Please wait until server turnsits status to "running".

7.2.4.97 Error 10508

Priority 1
Error Message
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Session has timed out.

Possible Cause

The session has been idle for a specified amount of time.
Solution

Increase the session timeout period in AEM, but do not set it too long. A long existing
Session may cause security problems.

7.2.4.98 Error 10999

Priority 1

Error Message

Keyword not supported: 'dsn'.

Possible Cause

Thisissueisaknown issue for using ODBC driver.
Solution

Toresolve this, go to AEM, and then change the ODBC driver to the Native Driver for SQL
server 2000/2005 in Appeon Server.

7.2.4.99 Error 11006

Priority 1

Error Message

A fatal I10Exception occurred when retrieving the status of the server %1.
Possible Cause

1) Cannot have 1/0O communication with the remote server using HTTP. 2) Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) If both network and Appeon Server are working, send the
log files on the local and remote machines to Appeon technical support engineers.

7.2.4.100 Error 11007

Priority O

Error Message

The Appeon configuration file cannot be empty!

Possible Cause

The configuration file retrieved from the remote server is empty, due to afile transfer error.
Solution

1) Check that the network connection works normally. 2) Check that the Appeon Server is
running. 3) If both network and Appeon Server are working, send the log files on the local
and remote machines to Appeon technical support engineers.
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7.2.4.101 Error 11008

Priority 1
Error Message

A fatal |OException occurred when retrieving the configuration file from the remote server:
%1.

Possible Cause

1) Cannot have 1/0 communication with the remote server using HTTP. 2) Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) If both network and Appeon Server are working, send the
log files on the local and remote machines to Appeon technical support engineers.

7.2.4.102 Error 11009

Priority O

Error Message

Failed to read the Sting array in the configuration file from the remote server.
Possible Cause

Cannot construct the object using the stream.

Solution

1) Check that the network can be connected. 2) Check that Appeon Server is running. 3)
If both network and Appeon Server are working, send the log files on the local and remote
machines to Appeon technical support engineers.

7.2.4.103 Error 11010

Priority O

Error Message

An unexpected exception occurred when replicating Appeon configuration files!
Possible Cause

Failed to replicate the local configuration file due to an unknown error.
Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) If both network and Appeon Server are working, send the
log files on the local and remote machines to Appeon technical support engineers.

7.2.4.104 Error 11011

Priority O
Error Message
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Cannot find the file: %1.
Possible Cause
The specified file does not exist on the server.

7.2.4.105 Error 11012

Priority O

Error Message

An exception occurred when denying write access to the file: %1.

Possible Cause

Thisisararely occurred exception caused by enabling the Java security.

Solution

Please send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.106 Error 11013

Priority 1

Error Message

A fatal |OException occurred when writing %1 to the local disk.
Possible Cause

An [OException occurred when reading or writing the specified file.

Solution

1) Check that the specified file is not read-only. If it isread-only, reset it. 2) Please send the
log files to the Appeon technical support engineers.

7.2.4.107 Error 11014

Priority O
Error Message

An unexpected exception occurred and caused failure to write Appeon configuration filesto
the local disk!

Possible Cause
An unknown error occurred when writing the specified file to the local disk.

Solution
Please send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.108 Error 11015

Priority 1
Error Message
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A fatal 10Exception occurred when communicating with serviet 1/0.
Possible Cause

Cannot have I/O communication with the remote server through HTTP.
Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) Send the log files on the local machine and the remote
server to the Appeon technical support engineers.

7.2.4.109 Error 11016

Priority O
Error Message

An unexpected exception occurred and caused failure to read the local Appeon configuration
files!

Possible Cause

An unknown error occurred when reading the local configuration file.

Solution

Please send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.110 Error 11017

Priority 1

Error Message

An |OException occurred when reading the file: %1.

Possible Cause

An |OException occurred when reading the local configuration file.

Solution

Please send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.111 Error 11020

Priority O

Error Message

An error occurred when synchronizing the method: %1. The remote server caled is. %2.
Possible Cause

1. Cannot have I/O communication with the remote server using HTTP. 2. Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1. Check that the server is running and can be connected. 2. Check that Appeon Server
residing in the server is started. 3. If both network and Appeon Server work correctly, send
thelog files on the local and the remote servers to the Appeon technical support engineers.
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7.2.4.112 Error 11021

Priority O

Error Message

An unexpected exception occurred and caused failure to synchronize the method: %1.
Possible Cause

An unknown error occurred when synchronizing the AEM configuration settings on the
local Appeon Server to the remote Appeon Servers.

Solution
Send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.113 Error 11022

Priority 1

Error Message

A fatal |OException occurred when synchronizing method: %1!
Possible Cause

1) Cannot have 1/0 communication with the remote server using HTTP. 2) Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1) Check that the server isrunning and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) If both network and Appeon Server work correctly, send
the log files on the local and the remote servers to the Appeon technical support engineers.

7.2.4.114 Error 11023

Priority O

Error Message

A ClassNotFoundException occurred when synchronizing method: %1.
Possible Cause

Cannot construct the object by using the stream from Servlet.

Solution

Send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.115 Error 11024

Priority O

Error Message

An unexpected exception occurred and caused failure to synchronize method: %1.
Possible Cause

An unknown error occurred when synchronizing sessions on the local Appeon Server from
the remote Appeon Servers.
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Solution
Send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.116 Error 11025

Priority 1

Error Message

A fatal I0Exception occurred when calling the specified remote server: %1.
Possible Cause

1) Cannot have I/0 communication with the remote server using HTTP. 2) Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) If both network and Appeon Server work correctly, send
the log files on the local machine and the remote server to the Appeon technical support
engineers.

7.2.4.117 Error 11026

Priority O

Error Message

An unexpected exception occurred and caused the ClusterNotify thread to stop!
Possible Cause

An unknown error terminated the HTTP communication.

Solution

Send the Appeon Server log files to the Appeon technical support engineers.

7.2.4.118 Error 11027

Priority 1

Error Message

An unexpected exception occurred and resulted in failure to retrieve status of the server: %1.
Possible Cause

An unknown exception caused the failure to get the server status.

Solution

Please send Appeon Server log files to the Appeon technical support engineers for in-depth
investigation.

7.2.4.119 Error 11028

Priority 10
Error Message
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Application server connection error!

Possible Cause

The network is disconnected. Or the application server is shut down.

Solution

Check that the network can be connected, and application server can be accessed.

7.2.4.120 Error 11029

Priority 10

Error Message

Appeon Server isin the process to start. Please refresh the page | ater.
Possible Cause

Appeon Server isin the "processto start” state, not in the "running” state.
Solution

Wait until Appeon Server turnsto the "running" state.

7.2.4.121 Error 11502

Priority O

Error Message

Failed to get session information from the specified server %1.
Possible Cause

1) Cannot have 1/0O communication with the remote server using HTTP. 2) Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) If both network and Appeon Server work correctly,
send the log files on the local and the remote machines to the Appeon technical support
engineers.

7.2.4.122 Error 11503

Priority O

Error Message

Failed to get transaction information from the specified server %1.

Possible Cause

1) Cannot have I/O communication with the remote server using HTTP. 2) Exceptions
occurred when calling methods in the remote server, causing failure to return data.
Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) Send the log files on the local machine and the remote
server to the Appeon technical support engineers.
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7.2.4.123 Error 11509

Priority 1
Error Message

AEM could not interface with the specified Appeon Server. Please verify that your Appeon
Server isrunning and that the settings are correct.

Possible Cause

1) Cannot have I/0 communication with the remote server using HTTP. 2) Exceptions
occurred when calling methods in the remote server, causing failure to return data.

Solution

1) Check that the server is running and can be connected. 2) Check that Appeon Server
residing in the server is started. 3) Send the log files on the local machine and the remote
server to the Appeon technical support engineers.

7.2.4.124 Error 11512

Priority O
Error Message

Error occurred when updating AEM settings on the local machine. Please read the log for
more details.

Possible Cause

1) Cannot update the AEM new settings to the server because the configuration file is read-
only. 2) Cannot read or write the file because the file is corrupt.

Solution

1) Remove the Read-only property of filesin the %A ppeon Server%\AEM\config folder. 2)
Send the log files to the Appeon technical support engineers.

7.2.4.125 Error 11514

Priority O

Error Message

Please enter the | P address or machine name of the Appeon Server.
Possible Cause

The IP address or machine name of the Appeon Server is not specified.
Solution

Input the | P address or machine name of the Appeon Server.

7.2.4.126 Error 11515

Priority O
Error Message

Troubleshooting Page 168



Error Messages Appeon® for PowerBuilder® 2013 R2

Please enter the port number of the Appeon Server.
Possible Cause

The port number of the Appeon Server is not specified.
Solution

Input the port number of the Appeon Server.

7.2.4.127 Error 11516

Priority O

Error Message

Please input avalid port number with arange from 0 to 65535.
Possible Cause

The specified port number is out of the invalid range.

7.2.4.128 Error 11517

Priority O

Error Message

I P address or machine name cannot be localhost or 127.0.0.1!
Possible Cause

I P address or machine name cannot be localhost or 127.0.0.1!
Solution

Please input the IP address or machine name.

7.2.4.129 Error 11519

Priority O
Error Message

The interval should be a positive integer, greater than 0 and less than 2147483648.

Possible Cause

The specified interval isinvalid.

Solution

Input the interval between 0 and 2147483648.

7.2.4.130 Error 11520

Priority O
Error Message

Y ou must select one option between "Enable Remote Backup" and "Enable Local Backup".

Possible Cause
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If Heartbeat Backup is selected, you must select between "Enable Remote Backup" and
"Enable Local Backup"

Solution
Select "Enable Remote Backup™ or "Enable Local Backup"

7.2.4.131 Error 11521

Priority 1
Error Message

Errors occurred when synchronizing AEM configuration information to the specified remote
server: %1. The method is: %2.

Possible Cause

1) Cannot communicate with the remote server using HT TP protocol. 2) Exceptionsin
calling methods in the remote server. Data cannot be returned.

Solution

1) Verify that the target server is running and can be connected. 2) Verify that the Appeon
Server residing on the target server isrunning. 3) If both network and Appeon Server work
correctly, send log files for the local machine and the target server to the Appeon technical
support engineers for in-depth investigation.

7.2.4.132 Error 11522

Priority 1

Error Message

Errors occurred in calling the remote method. The method is: *; the remote server is: *
Possible Cause

1) Cannot communicate with the remote server using HT TP protocol. 2) Exceptionsin
calling methods in the remote server. Data cannot be returned.

Solution

1) Verify that the target server is running and can be connected. 2) Verify that the Appeon
Server residing on the target server isrunning. 3) Send log files for the local machine and
the target server to the Appeon technical support engineers for in-depth investigation.

7.2.4.133 Error 11523

Priority 2

Error Message

It exceeds the CPU count in the license.
Possible Cause

The number of CPUs on the current machine exceeds the CPU count specified in the license
file.

Solution
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Please purchase a new license with more CPUs.

7.2.4.134 Error 11524

Priority 2

Error Message

The license of the remote Appeon Server does not match with the license on the local server.
Possible Cause

The license of the remote Appeon Server does not match with the license on the local server.
Solution

Replace the license file in the remote Appeon Server with the license file on the local server.

7.2.4.135 Error 12001

Priority 10
Error Message

Failed to get the transaction information from the Appeon Server configuration file
(transaction object name = %1). Please make sure you have configured this transaction
object in AEM correctly.

Possible Cause

1) Transaction object is not configured in AEM. 2) The configuration file is corrupt.
Solution

Re-configure the transaction object in AEM.

7.2.4.136 Error 12008

Priority O

Error Message

Application nameis null.

Possible Cause

The value of application name passed to the method is null.
Solution

1) Check that the network can be connected. 2) Restart Appeon Server. 3) If the error still
occurs, send the log files to the Appeon technical support engineers.

7.2.4.137 Error 12009

Priority O

Error Message

Property %1 has already been defined.
Possible Cause
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The application name passed to the method already exists.
Solution

1) Check that the newly added application does not have the same name with the existing
application. 2) The network can be connected. 3) Restart Appeon Server. 4) If the error still
occurs, send the log files to the Appeon technical support engineers.

7.2.4.138 Error 12010

Priority O

Error Message

Argument cannot be null or empty string.
Possible Cause

The argument passed to the method is empty.
Solution

1) Check that the network can be connected. 2) Restart Appeon Server. 3) If the error still
occurs, send the log files to the Appeon technical support engineers.

7.2.4.139 Error 12011

Priority 1

Error Message

Error occurred when loading the application configuration file!

Possible Cause

Error occurred when loading the application configuration from the configuration file.
Solution

Check that ApplicationsConfig is not corrupt and the format is correct. Deleteit if itis
corrupt or the format is incorrect.

7.2.4.140 Error 12012

Priority 1

Error Message

Error occurred when loading the server configuration information!

Possible Cause

Error occurred when loading the server configuration from the configuration file.
Solution

Check that ServerConfig is not corrupt and the format is correct. Delete it if it is corrupt or
the format isincorrect.

7.2.4.141 Error 12013

Priority 1
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Error Message

Error occurred when loading %1 file!

Possible Cause

Error occurred when loading the server configuration from the configuration file.
Solution

1. Check that ServerConfig exists and is not corrupt. If it does not exist or it is corrupt, copy
it from the other clustered machine. 2. Send the log files to the Appeon technical support
engineers.

7.2.4.142 Error 12015

Priority O

Error Message

ServerConfig object isnull.

Possible Cause

The argument passed to the method is empty.
Solution

1) Check that the network can be connected. 2) Restart Appeon Server. 3) If the error still
occurs, send the log files to the Appeon technical support engineers.

7.2.4.143 Error 12016

Priority O

Error Message

ApplicationsConfig is null.

Possible Cause

The argument passed to the method is empty.
Solution

1) Check that the network can be connected. 2) Restart Appeon Server. 3) If the error still
occurs, send the log files to the Appeon technical support engineers.

7.2.4.144 Error 12017

Priority 1

Error Message

Errors occurred when writing the ServerConfig file.
Possible Cause

The ServerConfig fileis corrupt.

Solution

Check that thefileisintact. If it is corrupt, deleteit.
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7.2.4.145 Error 12018

Priority 1

Error Message

Errors occurred when writing the ApplicationsConfig file.
Possible Cause

The ApplicationsConfig fileis corrupt.

Solution

Check that the fileisintact. If it is corrupt, delete it.

7.2.4.146 Error 12019

Priority 1

Error Message

Errors occurred when loading the application configuration.

Possible Cause

Exceptions occurred when loading the application configuration from the file.
Solution

1) Check that thefileis not read-only. Reset it if it isread-only. 2) Send the log filesto the
Appeon technical support engineers.

7.2.4.147 Error 12020

Priority 1

Error Message

Failed to load the ServerConfig object!

Possible Cause

Errors occurred when loading the server configuration from the configuration file.
Solution

1. Check that ServerConfig exist and is not corrupt. If it does not exist or it is corrupt, delete
it. 2. Send the log files to the Appeon technical support engineers.

7.2.4.148 Error 12021

Priority 1

Error Message

Failed to load the ThreadQueues Config object from file %1!

Possible Cause

Errors occurred when loading the ThreadQueues configuration from the configuration file.
Solution
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1. Check that ServerConfig exist and is not corrupt. If it does not exist or it is corrupt, copy
it from the other clustered machine. 2. Send the log files to the Appeon technical support
engineers.

7.2.4.149 Error 12025

Priority 1

Error Message

The selected application %1 does not exist in the Appeon Server.

Possible Cause

1) The Web application is undeployed. 2) The Web application is manually removed.

7.2.4.150 Error 12026

Priority 2

Error Message

The application number exceeds the license limit %1.

Possible Cause

The application number exceeds the maximum number allowed in license.
Solution

Purchase avalid Appeon for PowerBuilder edition.

7.2.4.151 Error 12027

Priority O

Error Message

Error: AEMConfig is empty.

Possible Cause

The parameter passed into the method is empty.

Solution

Send the log files to the Appeon technical support engineers.

7.2.4.152 Error 12028

Priority 1

Error Message

Failed to write the web.config file.
Possible Cause

web.config is corrupt.

Solution
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Check that the web.config fileisintact. If it is corrupt, deleteit.

7.2.4.153 Error 12029

Priority O

Error Message

ConnectionCacheConfig is empty.

Possible Cause

Errorsin passing the internal parameters.

Solution

Send the log files to Appeon technical support engineers.

7.2.4.154 Error 12030

Priority 1

Error Message

Errorsin writing the data-source.config file.
Possible Cause

The data-source.config file is corrupt.
Solution

Deletethefileif it is corrupt.

7.2.4.155 Error 12501

Priority 10

Error Message
Post datais null!
Possible Cause

Network exceptions caused the data passed by Appeon Developer to be empty.

Solution

1) Re-deploy the application using Appeon Developer. 2) Check that the network is stable.

7.2.4.156 Error 12502

Priority 10

Error Message
Session is not found!
Possible Cause

1) The Appeon Developer version is different from the Appeon Server version. 2) An

invalid user calls the server interface.
Solution
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Check that the Appeon Developer version and the Appeon Server version are the same.

7.2.4.157 Error 12503

Priority 10
Error Message
Cannot read the Msg's total!

Possible Cause

The data format passed by Appeon Developer isincorrect, because 1) The network error
occurred. 2) The Appeon Developer version and the Appeon Server version are different.

Solution
1) Check that the network is stable. 2) Check that the Appeon Developer version and the
Appeon Server version are the same.

7.2.4.158 Error 12504

Priority 10

Error Message

Call parseAndExecuteCommand: Cannot read FuctionType!
Possible Cause

The data format passed by Appeon Developer isincorrect, because 1) The network error
occurred. 2) The Appeon Developer version and the Appeon Server version are different.

Solution

1) Check that the network is stable. 2) Check that the Appeon Developer version and the
Appeon Server version are the same.

7.2.4.159 Error 12505

Priority 2

Error Message
Authority is required!
Possible Cause

1) Deployment username and password were not configured in Appeon Developer. 2) The
Appeon Developer version and the Appeon Server version are different.

Solution

1) Check that the deployment user name and password are correctly configured in Appeon
Developer. 2) Check that the Appeon Developer version and the Appeon Server version are

the same.

7.2.4.160 Error 12506

Priority 10
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Error Message
The input function type (%1) isinvalid. No code can be found to match this type!
Possible Cause

The dataformat passed by Appeon Developer isincorrect, because 1) The network error
occurred. 2) The Appeon Developer version and the Appeon Server version are different.

Solution
1) Check that the network is stable. 2) Check that the Appeon Developer version and the
Appeon Server version are the same.

7.2.4.161 Error 12507

Priority 10

Error Message

%1 Cannot read the parameter count!
Possible Cause

The data format passed by Appeon Developer isincorrect, because 1) The network error
occurred. 2) The Appeon Developer version and the Appeon Server version are different.

Solution
1) Check that the network is stable. 2) Check that the Appeon Developer version and the
Appeon Server version are the same.

7.2.4.162 Error 12508

Priority 10
Error Message
%1: Parameter count mismatch!

Possible Cause

The data format passed by Appeon Developer isincorrect, because 1) The network error
occurred. 2) The Appeon Developer version and the Appeon Server version are different.

Solution

1) Check that the network is stable. 2) Check that the Appeon Developer version and the
Appeon Server version are the same.

7.2.4.163 Error 12509

Priority 10
Error Message
%1 Cannot read the parameter length!

Possible Cause

The data format passed by Appeon Developer isincorrect, because 1) The network error
occurred. 2) The Appeon Developer version and the Appeon Server version are different.
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Solution
1) Check that the network is stable. 2) Check that the Appeon Developer version and the
Appeon Server version are the same.

7.2.4.164 Error 12510

Priority 10
Error Message
%1: Cannot read the Parameter value!

Possible Cause

The data format passed by Appeon Developer isincorrect, because 1) The network error
occurred. 2) The Appeon Developer version and the Appeon Server version are different.

Solution
1) Check that the network is stable. 2) Check that the Appeon Developer version and the
Appeon Server version are the same.

7.2.4.165 Error 12511

Priority 10

Error Message

Appeon Server isin the process to start. Please refresh the page | ater.
Possible Cause

Appeon Server is starting. AEM cannot be accessed.

Solution

Please wait until Appeon Server is started.

7.2.4.166 Error 13001

Priority O
Error Message
The original Datawindow parameters are not compatible with the client parameters.

Possible Cause

The number of the original DataWindow parametersis different from the number of the
client parameters.

Solution

1) Check that the network can be connected. 2) Check that Appeon Server is started and
works properly. 3) If the error still occurs, send the Appeon log files and SQL statementsto
the Appeon technical support engineers.

7.2.4.167 Error 13002

Priority O
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Error Message

Unsupported stored procedure syntax: %!1.

Possible Cause

1) Errorsin parsing the stored procedure. 2) The stored procedure syntax is unsupported.
Solution

Make sure that none of the following script is used: 1) execute sp_test
to_date( :Is date), :li_id; // Argument contains functions 2) execute sp_test
"2001-02-12", :li_id + 100 ; // Argument contains expressions

7.2.4.168 Error 13003

Priority 10

Error Message

Unsupported PowerBuilder data type: %1.
Possible Cause

Unsupported PowerBuilder data typeis used.
Solution

1) Comment out the data type in the PowerBuilder source code. 2) Send thelog filesto the
Appeon technical support engineers.

7.2.4.169 Error 13004

Priority O

Error Message

Cannot find the specified argument %1 in the argument list.
Possible Cause

When parsing the argument position in SQL statement, Appeon Developer failed to match
the SQL argument name with the argument name passed by the Appeon Xcelerator.

Solution

1) Check that the network is connected. 2) Check that Appeon Server is started and works
properly. 3) If the error still occurs, send the Appeon log files and SQL statements to the
Appeon technical support engineers.

7.2.4.170 Error 13005

Priority O

Error Message

Stored procedure syntax cannot be empty or null.

Possible Cause

The stored procedure syntax passed by Appeon Xcelerator is empty or null.
Solution
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Check whether the stored procedure is empty in the PowerBuilder source code. If itis
empty, it must be caused by an Appeon internal error, please send the Appeon log files and
SQL statements to the Appeon technical support engineers.

7.2.4.171 Error 13006

Priority O

Error Message

Failed to analyze the stored procedure syntax, due to %1.

Possible Cause

The stored procedure syntax isinvalid or the syntax format is incorrect.
Solution

1) Verify that the stored procedure syntax is correct 2) Verify that the stored procedureis
supported by Appeon.

7.2.4.172 Error 13007

Priority O

Error Message

Register parameter error: index = %1, jdbcType = %2, value = %3.
Possible Cause

The unsupported data type causes failure to register the parameter.
Solution

1) Check that the parameter type is supported by Appeon. 2) If the parameter typeis
supported, ask the Appeon technical support engineers for help.

7.2.4.173 Error 13008

Priority O

Error Message

Client parameter of the UpdateBlob statement cannot be null.
Possible Cause

The network is unstable or the Appeon Serve encountered exceptions which caused data
lost.

Solution

1) Check the network is connected. 2) Check that Appeon Server is started and works
properly. 3) If the error still occurs, send the log files to the Appeon technical support
engineers.

7.2.4.174 Error 13009

Priority O
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Error Message
The PB type of the parameter isinvalid.
Possible Cause

1) The stored procedure does not exist in the database. 2) The stored procedure parameter
uses instance variables.

7.2.4.175 Error 13010

Priority 10

Error Message

DataObject name cannot be empty.

Possible Cause

Appeon Server failed to get the DataObject name.
Solution

1) Check that the PowerBuilder source code is correct. 2) Check that the network is
connected. 3) Check that Appeon Server is starting and works properly.

7.2.4.176 Error 13011

Priority O

Error Message

This column's data type %1 requires the use of an embedded SQL statement.
Possible Cause

The column in the SQL statement used to dynamically create a Datawindow contains
unsupported data type.

Solution

Check that the column data type can be used to create DataWindows and ensure that it can
be executed in the PowerBuilder

7.2.4.177 Error 13012

Priority O

Error Message

User SQL cannot have parametersin Verify SQL Command.
Possible Cause

When using SetSQL Select in the DataWindow to modify the SQL statement, SetSQL Select
cannot contain parameters.

7.2.4.178 Error 13013

Priority 2
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Error Message

Failed to parse the result meta of the Select statement, due to %1.

Solution

Please contact the Appeon technical support engineers and provide them with the log files.

7.2.4.179 Error 13014

Priority 2

Error Message

Failed to parse parameter meta of stored procedure, due to %1
Solution

Please send log files to the Appeon technical support engineers.

7.2.4.180 Error 13015

Priority 10
Error Message

Failed to get DataWindow SQL from Appeon Server (Application = %1, DataObject = %2,
DBType = %3). Please make sure you have deployed your application correctly.

Possible Cause

Failed to get Datawindow SQL from AppeonDB, possibly because 1) AppeonDB is shut
down or failed to work. 2) The Datawindow has not been deployed correctly. View the
deploy log for the error. 3) The database type used by the PowerBuilder application and the
database type used by the Web application are not the same.

Solution

1) Check that AppeonDB is started and works properly. 2) Check that the DatawWindow was
deployed successfully. 3) Check that the database type selected for deployment in Appeon
Developer and the database type selected for running in AEM are the same.

7.2.4.181 Error 13016

Priority 10

Error Message

Cannot find the following embedded SQL in AppeonDB: ApplicationName =%1 and
SQLKey =%2.

Possible Cause 1

The AppeonDB database is closed or failed to work.

Solution 1

Verify that AppeonDB works correctly.

Possible Cause 2
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The embedded SQL has not been deployed successfully. This happens only for very large
applications with an excessive number of DatawWindow SQL (say over 10,000) or embedded
SQL (say over 3,000).

Solution 2

Step 1: Adjust the value of the following parameters in the AppeonDev.ini file (located

under C:\Program Files\Appeon\Devel oper2013R2\ and will be copied to the "bin" folder of
application package by Appeon Package Wizard):

[ Depl oyConfi g]

Bat chDWSynLen= 10000000
Bat chDWSynNurme 200

Bat chDW5gl Nurme= 500

Bat chESql Num=500

BatchDWSynL en specifies the length (in byte) of the DatawWindow syntax, which when
reached the deployment tool will commit to Appeon Server at one time.

BatchDW SynNum specifies the number of DataWindow syntax, which when reached the
deployment tool will commit to Appeon Server at one time.

BatchDW SglNum specifies the number of DataWindow SQL, which when reached the
deployment tool will commit to Appeon Server at one time.

BatchESgINum specifies the number of embedded SQL, which when reached the
deployment tool will commit to Appeon Server at one time.

By increasing the value of the above parameters (typically, BatchDWSglNum and
BatchESgINum) according to the number of DataWindow SQL and embedded SQL used
in your application, thiswill reduce the server calls so it eliminates the chance of failing
to commit certain syntax. If you have no idea of the number of Datawindow SQL and
embedded SQL, you can increment the value by 200 each time and then full deploy the
application to seeif this error disappears.

Step 2: Modify the I1S web.config xml file.

Go to C:\Inetpub\wwwroot\appeon\AEM, and add the following code to the web.config
XML file. By default, the value of the Execution Timeout is 100 seconds, and the value
of the Max Request Length is4096K. Y ou can use larger values for these two properties
according to the specific needs.

<system.web>
<htt pRunti me executi onTi meout ="30000" naxRequestLength = "102400" />

<httpHandlers>

Restart the 11S server to make this change take effect.

7.2.4.182 Error 13017

Priority 10
Error Message
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The value for Application Name is empty or null.

Possible Cause

The Application Name argument passed from the client is empty.

Solution

Check that the application name and the deployment configuration are correct.

7.2.4.183 Error 13018

Priority 10

Error Message

The value of Datawindow name is empty or null.

Possible Cause

The Datawindow Name argument passed from the client is empty.
Solution

1) Check that the DataWindow settings in Appeon Developer are correct. 2) Check that
Appeon Developer deployment process is successful. 3) Check that the network connection
is stable. 4) Check that Appeon Server is running and works properly.

7.2.4.184 Error 13019

Priority 10

Error Message

The value for DWSyntaxString is empty or null.

Possible Cause

The DWSyntaxString parameter values passed from the client are empty.
Solution

1) Check that the DB settings in Appeon Developer are correct. 2) Check that Appeon
Developer deployment process is successful. 3) Check that the network connection is stable.
4) Check that Appeon Server is running and works properly.

7.2.4.185 Error 13020

Priority 10

Error Message

Call an unused method.
Possible Cause

Call an obsolete method.

7.2.4.186 Error 13021

Priority 10
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Error Message
Errorsin deleting al Datawindows.
Possible Cause

Cannot delete the DatawWindow syntax, possibly because 1) The AppeonDB database is
closed. 2) The parameter passed by Appeon Developer isincorrect.

Solution

1) Check that the network connection is stable. 2) Check that Appeon Server is running and
works correctly.

7.2.4.187 Error 13022

Priority 1

Error Message

The application %1 is being deployed by another user.

Possible Cause

Another user is deploying an application with the same name to the same Appeon Server.
Solution

Please wait until the deployment is finished. If you want to terminate the deployment, delete
the deployment session in AEM.

7.2.4.188 Error 13023

Priority 10

Error Message

The value for SglKey cannot be empty or null.
Possible Cause

The SQL Key passed from the client is empty.
Solution

1) Check that the Appeon Developer deployment process is successful. 2) Check that the
network connection is stable. 3) Check that Appeon Server isrunning and works correctly.

7.2.4.189 Error 13024

Priority 10

Error Message

The value for embedded SQL cannot be empty or null.
Possible Cause

Embedded SQL passed from the client is empty.
Solution

1) Check that the Appeon Developer deployment process is successful. 2) Check that the
network is stable. 3) Check that Appeon Server is running and works properly.
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7.2.4.190 Error 13025

Priority 2
Error Message

Cannot find the following Datawindow syntax in AppeonDB: ApplicationName =%1 and
DatawindowName =%2.

Possible Cause

1) The AppeonDB database is closed. 2) The passed application name and SQLKey is
incorrect.

Solution

1) Check that the Appeon Developer deployment is successful. 2) Check that the network
is stable. 3) Check that Appeon Server is running and works properly. 4) If the error still
persists, ask the Appeon technical support engineers for help.

7.2.4.191 Error 13026

Priority 2

Error Message

Parameter error: the value for %1 is empty or null.
Possible Cause

The first parameter passed from the client is empty. The application name, version type etc.
cannot be empty.

Solution

1) Check that the Appeon Developer deployment is successful. 2) Check that the network
is stable. 3) Check that Appeon Server isrunning and works properly. 4) If the error till
persists, ask the Appeon technical support engineers for help.

7.2.4.192 Error 13027

Priority 10

Error Message

Unsupported database type. The DBMS code is %1.
Possible Cause

Possibly because the database type dynamically set in PowerScript does not conform to the
Appeon conventions.

Solution
Refer to the Appeon Help for how to dynamically set database type.

7.2.4.193 Error 13028

Priority 2
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Error Message
Blob or Clob variable for UpdataBlob cannot be empty.
Possible Cause

There is no parameter passed from the client or the passed parameter is null when executing
the UpdataBlob statement.

Solution
Verify that the argument is not empty or null.

7.2.4.194 Error 14001

Priority 2

Error Message

License has expired on %1.

Possible Cause

Tria license has expired.

Solution

Please contact Appeon to purchase a proper license.

7.2.4.195 Error 14002

Priority 2
Error Message

Unableto validate license key "%1". The number has exceeded the limit of your current
license.

Possible Cause
The session number has exceeded the limit specified in the license file.
Solution

Kill other active sessions to make the session number within the license limit or contact
Appeon to purchase a more powerful edition.

7.2.4.196 Error 14003

Priority 2

Error Message

Error in validating license signature!
Possible Cause

License signature validation failed. The authorization file may be modified manually, or
incorrect authorization fileis used.

Solution
Please reinstall Appeon.
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7.2.4.197 Error 14004

Priority 2

Error Message

Missing licensefile.

Possible Cause

The license fileis missing. The license file has been moved or deleted.
Solution

1. Pleasereinstall Appeon. 2. Please apply for anew license.

7.2.4.198 Error 14005

Priority 2

Error Message

Invalid software license file %1.

Possible Cause

1. Thelicense.appeon fileis empty. 2. The license.appeon fileis corrupt.
Solution

1. Check that license.appeon exists in the appeon\AEM\bin folder (eg. C:\Inetpub\wwwroot
\appeon\AEM) 2. Update the license file. 3. Please reinstall Appeon.

7.2.4.199 Error 14006

Priority 2

Error Message

Unable to validate the current license file.

Possible Cause

1. Thelicensefileis corrupt. 2. The licensefileis not for this Appeon version.
Solution

1. Please reinstall Appeon Server. 2. Update the licensefile.

7.2.4.200 Error 14009

Priority 2

Error Message

Error in validating hash code!
Possible Cause

The Appeon fileis corrupt.
Solution

Please reinstall Appeon.
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7.2.4.201 Error 14010

Priority 2

Error Message

The user (%1) has no access rights to the application (%2).

Possible Cause

The user's access rights to the application were restricted in AEM by the administrator.
Solution

Onthe AEM > Application > Client Security page, assign the user with proper rights to
access the application.

7.2.4.202 Error 14016

Priority 2
Error Message

The license file installed to the machine hosting Appeon Server allows only %1 CPU(s), but
%2 CPUs are detected.

Possible Cause

The CPU number on the machine exceeds the maximum allowed number in the license file.
Solution

Please contact Appeon to obtain an appropriate license or remove the extra CPUs.

7.2.4.203 Error 14017

Priority 2
Error Message

Appeon Server is configured for the network card with physical address %1, but the network
card on the Appeon Server is %2.

Possible Cause

The network card on the Appeon Server does not match with the network card settings in the
licensefile.

Solution
Please contact Appeon to obtain an appropriate license.

7.2.4.204 Error 14018

Priority 2

Error Message

Y our Appeon Server %1-day trial license expired on %2.
Possible Cause

Thetrial license has expired.

Solution
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Please contact Appeon and purchase a proper license.

7.2.4.205 Error 14019

Priority 2

Error Message

Cannot connect to AppeonDB. Appeon Server failed to start.
Possible Cause

1. AppeonDB failed to start.

2. Severa AppeonDB (a SQL Anywhere database) will be started as servicesin EAServer
5.5 Unix or Linux inaLAN. However, it is not allowed to start multiple SQL Anywhere
services asthe same namein aLAN.

Solution
1. Restart Appeon Server and check whether errors are reported in the log files.

2. (EAServer 5.5 Unix/Linux only) Modify appeondb.sh; appeonSampledb.sh;
appeonSample2db.sh at the $EA Server$/bin folder, so to change the service name followed
after the "-n" parameter to a different one.

For example
/loriginal content

if [ "X$JAGUAR ASA9" != "X" ]; then
if [ -f $JAGUAR ASA9/ bi n/ asa_config.sh ];then
$IAGUAR_ASA9/ bi n/ asa_confi g. sh
fi
$IJAGUAR_ASA9/ bi n/ dbsrv9 -x tcpip\(serverport=6200\) -n appeonserver "$JAGUAR/
appeon/ db/ AppeonSer ver . db"
elif [ "X$JAGUAR ASA8" != "X" ]; then
if [ -f $JAGUAR ASA8/ bi n/ asa_config.sh ];then
$IAGUAR_ASA8/ bi n/ asa_confi g. sh
fi
$JAGUAR_ASA8/ bi n/ dbsrv8 -x tcpip\(serverport=6200\) -n appeonserver "$JAGUAR/
appeon/ db/ AppeonSer ver . db"
elif [ "X$JAGUAR ASA7" = "X" ]; then
if [ -f $JAGUAR ASA7/ bi n/ asa_config.sh ];then
$IAGUAR_ASA7/ bi n/ asa_confi g. sh
fi
$JAGUAR_ASA7/ bi n/ dbsrv7 -x tcpip\(serverport=6200\) -n appeonserver "$JAGUAR/
appeon/ db/ AppeonSer ver . db"
elif [ "X$JAGUAR ASAQQ" != "X" ]; then
if [ -f $JAGUAR ASA90/ bi n/ asa_config.sh ];then
$IAGUAR_ASA90/ bi n/ asa_confi g. sh
fi
$IJAGUAR_ASA90/ bi n/ dbsrv9 -x tcpip\(serverport=6200\) -n appeonserver "$JAGUAR/
appeon/ db/ AppeonSer ver . db"
elif [ "X$JAGUAR ASA80" != "X" ]; then
if [ -f $JAGUAR ASA80/ bi n/ asa_config.sh ];then
$IAGUAR_ASA80/ bi n/ asa_confi g. sh
fi
$JAGUAR_ASA80/ bi n/ dbsrv8 -x tcpip\(serverport=6200\) -n appeonserver "$JAGUAR/
appeon/ db/ AppeonSer ver . db"
fi

/Imodified content
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If [ "X$JAGUAR ASAQ" I= "X" ]; then
if [ -f $IJACUAR _ASA9/ bi n/ asa_config.sh ];then
$IJAGUAR_ASA9/ bi n/ asa_confi g. sh
fi
$IAGUAR_ASA9/ bi n/ dbsrv9 -x tcpi p\(serverport=6200\) -n appeonserverl "3$JAGUAR/
appeon/ db/ AppeonSer ver . db"
elif [ "X$JAGUAR ASA8" != "X" ]; then
if [ -f $IJACUAR _ASA8/ bi n/ asa_config.sh ];then
$JAGUAR_ASA8/ bi n/ asa_confi g. sh
fi
$IJAGUAR_ASA8/ bi n/ dbsrv8 -x tcpi p\(serverport=6200\) -n appeonserverl "3$JAGUAR/
appeon/ db/ AppeonSer ver . db"
elif [ "X$JAGUAR ASA7" !="X" ]; then
if [ -f $JAGUAR _ASA7/ bi n/asa_config.sh ];then
$IJAGUAR_ASA7/ bi n/ asa_confi g. sh
fi
$IJAGUAR_ASA7/ bi n/ dbsrv7 -x tcpip\(serverport=6200\) -n appeonserverl "3$JAGUAR/
appeon/ db/ AppeonSer ver . db"
elif [ "X$JAGUAR ASA9Q" != "X" ]; then
if [ -f $IJAGUAR _ASA90/ bi n/ asa_config.sh ];then
$IJAGUAR_ASA90/ bi n/ asa_confi g. sh
fi
$IJAGUAR_ASA90/ bi n/ dbsrv9 -x tcpip\(serverport=6200\) -n appeonserverl
"$JAGUAR/ appeon/ db/ AppeonSer ver . db"
elif [ "X$JAGUAR ASA80" != "X" ]; then
if [ -f $IJAGUAR _ASA80/ bi n/ asa_config.sh ];then
$IJAGUAR_ASAB0/ bi n/ asa_confi g. sh
fi
$JAGUAR_ASA80/ bi n/ dbsrv8 -x tcpip\(serverport=6200\) -n appeonserverl
"$JAGUAR/ appeon/ db/ AppeonSer ver . db"
fi

7.2.4.206 Error 14020

Priority 2

Error Message

The application cannot be run because the product license information cannot be found.
Possible Cause

Cannot find the licensefile.

Solution

Check that the license file exists in the Appeon Server installation directory.

7.2.4.207 Error 14022

Priority 2

Error Message

Server failed to start, because the CPU number exceeds the license limit.
Possible Cause

The CPU number exceeds the maximum allowed number in the license.
Solution

Purchase a new license with larger CPU number.
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7.2.4.208 Error 14024

Priority 2

Error Message

The license of the remote Appeon Server does not match with the license of the local server.
Possible Cause

The license files on the remote Appeon Server and the local Appeon Server do not match.
Solution

Replace the license on the remote Appeon Server with the license on the local server.

7.2.4.209 Error 14025

Priority 2

Error Message

Thelicensein use isfor the %1 platform.

Possible Cause

Use an incorrect license file. For example, use alicense for UNIX in Windows.
Solution

Please contact Appeon to have the correct license.

7.2.4.210 Error 14026

Priority 2

Error Message

The licenseis not for the application server %1.
Possible Cause

Use an incorrect licensefile.

Solution

Please contact Appeon for the correct license.

7.2.4.211 Error 14027

Priority 2

Error Message

The current operating system is %1. But the license is for the platform other than Windows,
Solaris, AlX, Red-Linux, HP-Unix.

Possible Cause

The current platform is Windows, Solaris, Al X, Red-Linux, or HP-Unix. But the licenseis
not for this platform.

Solution
Please contact Appeon for the correct license.
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7.2.4.212 Error 14028

Priority 2
Error Message
The remote Appeon Server is acluster version.

Possible Cause

The license on the local server is not for cluster version, while the license on the remote
Appeon Server isfor cluster version.

Solution

To use the Appeon cluster functionality, al serversin the cluster must use the same license.
Y ou can replace the local license with the remote license, so all servers use the license

for cluster version. If you do not want to use the Appeon cluster functionality, replace the
remote license with the local license, so all servers use the license for single server version.

7.2.4.213 Error 14029

Priority 10

Error Message

The current user has no permission to write the local licensefile.

Possible Cause

The current login account does not have write permission to files under the system folder.
Solution

Ask the administrator to assign proper rights to the current account or log in to the system
using another account with proper rights.

7.2.4.214 Error 14030

Priority 10
Error Message
The local license file has been destroyed.

Possible Cause

Failed to access the local license file, probably because the file does not exist or the user has
no permission to accessit.

Solution

Ask the administrator to assign proper rights to the current account or log in to the system
using another account with proper rights.

7.2.4.215 Error 14031 (.NET only)

Priority 1
Error Message
The license datainitialize failed.
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Possible Cause

Fail to initialize Appeon licensefileif the proper permission of using .Net framework and
[1S server isnot set.

Solution
Step 1: Execute the command line in a Windows prompt window:

C:\ W NDOAS\ M cr osof t . NET\ Framewor k\ 2. 0. **** aspnet _regiis -ga users
C:\ W NDOWE\ M crosof t. NET\ Framewor k\ 2. 0. **** aspnet _regiis -i

Step 2: Grant proper rights to the Internet Guest Account and 11S Process Account so to
mani pul ate the Web Root folder.

1. Right click the C:\Inetpub\wwwroot folder, select the Propertiesitems and select the
Security tab page;

2. Add I1S_WPG group if it isnot listed in the box "Group or user names’;

3. Grant Full Control permission to the IIS_WPG group.

7.2.4.216 Error 14032

Priority 2
Error Message

Failed to obtain the Server ID. Y our Appeon Server will stop working in % days. Please
seek technical support in % days to resolve thisissue.

Possible Cause
There are two reasons below:

1. Appeon Server failed to find the network interface card address due to the malfunction of
the network interface card.

2. The network interface card address and the address in the license file don't match.

Solution

Please check whether the network interface card address and the address in the license
file match. If they don't match, please send the network interface card address to Appeon
technical support so that they can create a new license for you.

7.2.4.217 Error 14033

Priority 2

Error Message

Failed to obtain the Server ID. % days remain to fix the problem.
Possible Cause

There are two reasons below:

1. Appeon Server failed to find the network interface card address due to the malfunction of
the network interface card.
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2. The network interface card address and the address in the license file don't match.

Solution

Please check whether the network interface card address and the address in the license
file match. If they don't match, please send the network interface card address to Appeon
technical support so that they can create a new license for you.

7.2.4.218 Error 14501

Priority 10
Error Message
System error.
Possible Cause

1. The application configuration is incorrect. 2. Thefileis corrupt or the disk spaceis
insufficient.

Solution

1. Check that no Appeon files are missing. Refer to Appeon Help for instructionsiif you
need to configure the application settings again. 2. Reinstall Appeon Server. 3. Check that
the available disk spaceis over 100 M.

7.2.4.219 Error 14502

Priority 1

Error Message

The specified HTTP header does not exist.
Possible Cause

An incorrect parameter value is specified.
Solution

Verify that the parameter value is correct.

7.2.4.220 Error 15002

Priority 2

Error Message

Data source name cannot be null.
Possible Cause

Data source name is empty.
Solution

Specify the data source name.

7.2.4.221 Error 15003

Priority 2
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Error Message

Failed to add/modify data source.

Possible Cause

The format of the configuration file for storing the data source information was destroyed.
Solution

Remove the configuration file of the data source.

7.2.4.222 Error 15004

Priority 2

Error Message

Failed to get the specified data source information.

Possible Cause

The format of the configuration file for storing the data source information was destroyed.
Solution

Remove the configuration file of the data source.

7.2.4.223 Error 15005

Priority 2

Error Message

Failed to delete the specified data source.

Possible Cause

The format of the configuration file for storing the data source information was destroyed.
Solution

Remove the configuration file of the data source.

7.2.4.224 Error 15006

Priority 2

Error Message

Failed to refresh the specified data source.

Possible Cause

The format of the configuration file for storing the data source information was destroyed.
Solution

Remove the configuration file of the data source.

7.2.4.225 Error 15007

Priority 2
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Error Message
Failed to get all data source names.
Possible Cause

The format of the configuration file for storing the data source information was destroyed.

Solution
Remove the configuration file of the data source.

7.2.4.226 Error 15009

Priority 2

Error Message

Failed to add the data source.

Possible Cause

The specified data source settings are incorrect.
Solution

Check that the input data source settings are correct.

7.2.4.227 Error 15010

Priority 2

Error Message

Failed to modify the data source.

Possible Cause

The specified data source settings are incorrect.
Solution

Check that the input data source settings are correct.

7.2.4.228 Error 15011

Priority 2

Error Message

Failed to get the specified data source information.
Possible Cause

The specified data source settings are incorrect.
Solution

Check that the input data source settings are correct.

7.2.4.229 Error 15012

Priority 2
Error Message
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Failed to delete the specified data source.
Possible Cause

The specified data source settings are incorrect.
Solution

Check that the input data source settings are correct.

7.2.4.230 Error 15013

Priority 2

Error Message

Failed to refresh the specified data source.
Possible Cause

The specified data source settings are incorrect.
Solution

Check that the input data source settings are correct.

7.2.4.231 Error 15016

Priority 2

Error Message

Failed to test the data source.

Possible Cause

The specified data source settings are incorrect.
Solution

Check that the input data source settings are correct.

7.2.4.232 Error 15020

Priority 2
Error Message

Failed to get al components from the specified package.

Possible Cause

Exceptions occurred when getting all components from the specified package. Appeon

Server may encounter runtime errors.
Solution

1. Check that the input package settings are correct. 2. Contact the Appeon Server
administrator and make sure that Appeon Server runs correctly.

7.2.4.233 Error 15021

Priority 2
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Error Message
Failed to delete the specified component.
Possible Cause

Exceptions occurred when deleting the specified component. Appeon Server may encounter
runtime errors.

Solution

1. Check that the input component settings are correct. 2. Contact the Appeon Server
administrator and make sure that Appeon Server runs correctly.

7.2.4.234 Error 15022

Priority 2

Error Message

Failed to import the AEM configuration settings.
Possible Cause

1) ApplicationsConfig does not exist. 2) ApplicationsConfig has an incorrect file format. 3)
ApplicationsConfig does not contain the settings for the current application.

Solution
Check that the application is correctly configured in AEM.

7.2.4.235 Error 15023

Priority 2

Error Message

Failed to export the AEM configuration settings.
Possible Cause

1) ApplicationsConfig does not exist. 2) ApplicationsConfig has an incorrect file format. 3)
ApplicationsConfig does not contain the settings for the current application.

Solution
Check that the application is correctly configured in AEM.

7.2.4.236 Error 15051

Priority 2

Error Message

Failed to add the transaction object.
Possible Cause

1. ApplicationsConfig has an incorrect XML format. 2. ApplicationsConfig does not contain
the information for the current application.

Solution
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1. Check that the ApplicationsConfig fileis correct and intact. If the fileis corrupt, deleteit.
2. Provide the log files to the Appeon technical support engineers.

7.2.4.237 Error 15052

Priority 2

Error Message

Failed to delete the transaction object.

Possible Cause

ApplicationsConfig has an incorrect XML format.
Solution

1. Check that the ApplicationsConfig file is correct and intact. If the fileis corrupt, deleteit.
2. Provide the log files to the Appeon technical support engineers.

7.2.4.238 Error 15053

Priority 2

Error Message

Failed to modify the transaction object.
Possible Cause

1. ApplicationsConfig has an incorrect XML format. 2. ApplicationsConfig does not contain
the information for the current application.

Solution

1. Check that the ApplicationsConfig file is correct and intact. If the fileis corrupt, delete it.
2. Provide the log files to the Appeon technical support engineers.

7.2.4.239 Error 15054

Priority 2

Error Message

Failed to get all transaction objects.

Possible Cause

ApplicationsConfig has an incorrect XML format.
Solution

1. Check that the ApplicationsConfig file is correct and intact. If thefileis corrupt, deleteit.
2. Provide the log files to the Appeon technical support engineers.

7.2.4.240 Error 15055

Priority 2
Error Message
Failed to get the specified transaction object information.
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Possible Cause
ApplicationsConfig has an incorrect XML format.
Solution

1. Check that the ApplicationsConfig fileis correct and intact. If the fileis corrupt, deleteit.
2. Provide the log files to the Appeon technical support engineers.

7.2.4.241 Error 20001

Priority 2
Error Message

RegMultiString, RegLink and RegBinary data are unsupported in the server execution mode
of RegistryGet. For more help, please consult the Appeon Help.

Possible Cause

RegMultiString, RegLink and RegBinary data are unsupported in the server execution mode
of RegistryGet.
Solution

Use the supported data types, such as RegString, RegExpandString, RegUL ong,
RegUL ongBigEndian, to save the data.

7.2.4.242 Error 20002

Priority 2
Error Message

RegMultiString data are unsupported in the client execution mode of RegistryGet. For more
help, please consult the Appeon User Documents.

Possible Cause
RegMulti String data are not supported in the client execution mode of RegistryGet.
Solution

Use the supported data types, such as RegString, RegExpandString, RegULong,
RegULongBigEndian, or RegBinary, to save the data.

7.2.4.243 Error 20003

Priority 2
Error Message

RegMultiString data are unsupported in the client execution mode of RegistrySet. For more
help, please consult the Appeon User Documents.

Possible Cause
RegMulti String data are not supported in the client execution mode of RegistrySet.
Solution

Use the supported data types, such as eRegString, eRegExpandString, eRegUL ong,
eRegUL ongBigEndian, eRegBinary, or RegLink to save the data.
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7.2.4.244 Error 20004

Priority 2
Error Message

The thread pool settings cannot have a value less then zero or a value exceeding the
maximum allowed number. For more help, please consult the Appeon User Documents.

Possible Cause
The thread number configured in AEM isinvalid.
Solution

Configure a proper thread number in AEM. Refer to Appeon Server Configuration Guide
for help.

7.2.4.245 Error 20005

Priority 2
Error Message

The specified variable typeisincorrect. For more help, please consult the Appeon User
Documents.

Possible Cause

When creating the proxy object, the variable type is not set to CORBA or NonVisual Object.
Solution

Specify the variable type to CORBA or NonVisual Object when creating the proxy object.

7.2.4.246 Error 20006

Priority 2
Error Message

The class name of the object to be created does not exist. For more help, please consult the
Appeon User Documents.

Solution

1) Check that class name exists. 2) Check that the component was successfully deployed to
the server.

7.2.4.247 Error 20007

Priority 2

Error Message

No transaction object is specified when declaring cursor or stored procedure. For more help,
please consult the Appeon user document.

Possible Cause

1) The transaction object is not specified in the PowerBuilder source code. 2) The Appeon
Developer deployment contains errors.
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Solution

1) Verify that the transaction object is specified in the PowerBuilder source code. 2) Verify
that the Appeon Developer deployment is successful.

7.2.4.248 Error 20008

Priority 2
Error Message

when declaring cursor or stored procedure, DynamicStagingArea object is not instantiated.
For more help, please consult the Appeon user document.

Possible Cause

When using Dynamic SQL Format 4, make sure to instantiate the DynamicStagingArea
object before declaring the cursor or stored procedure.

7.2.4.249 Error 20009

Priority 2
Error Message

Y ou have not been logged into the mail system yet! For more help, please consult the
Appeon user document.

Possible Cause

Use functions in the Mail Session object when you have not been logged into the system or
login failed.

Solution
Use the MailLogon function to log in to the system.

7.2.4.250 Error 20010

Priority 2
Error Message

Transaction object is not connected. For more help, please consult the Appeon user
document.

Possible Cause
Commit or Rollback a transaction when the transaction object is not connected.
Solution

1) Check that the transaction object is connected. 2) Check that the transaction object is
configured in AEM.

7.2.4.251 Error 20011

Priority 2
Error Message
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Transaction object is aready connected. It cannot be connected again. For more help, please
consult the Appeon user document.

Possible Cause

Transaction object has already connected with the database whileit is used to connect to the
database again.

Solution

Modify the PowerBuilder source code and avoid using a transaction object to connect the
database repeatedly.

7.2.4.252 Error 20012

Priority 2
Error Message

Menu fileisinvalid. Failed to create the file! For more help, please consult the Appeon user
document.

Possible Cause

The menu fileisnot avalid XML file. It may be corrupt. The Loadxml function failed to
work.

Solution

1) Check that the menu fileisavalid XML file. 2) Refer to Appeon Help and verify that no
unsupported features are used. 3) Re-generate the application and fix the errorsiif there are
any.

7.2.4.253 Error 20013

Priority 2
Error Message

Cannot create the WSDL Reader object. For more help, please consult the Appeon user
document.

Possible Cause

1) SoapToolkit3.0 isnot installed. 2) Memory isinsufficient.

Solution

1) Install SoapToolkit3.0. 2) Close the other programs to release memory.

7.2.4.254 Error 20014

Priority 2

Error Message

Failed to load the WSDL file. For more help, please consult the Appeon user document.
Possible Cause

1) The specified WSDL file does not exist. 2) The network is unstable.

Solution
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1) Check that the WSDL fileis configured before deployment. 2) Check that the WSDL
file residesin the corresponding folder on Web server after deployment. 3) Check that the
network connection is stable.

7.2.4.255 Error 20015

Priority 2
Error Message

Cannot get the Service definition from the WSDL file. For more help, please consult the
Appeon user document.

Possible Cause
1) The WSDL file content isinvalid 2) The WSDL file isincomplete.
Solution

1) Check that the WSDL fileis correct. 2) Re-deploy the application using Appeon
Developer.

7.2.4.256 Error 20016

Priority 2
Error Message

Cannot get the Port definition from the WSDL file. For more help, please consult the
Appeon user document.

Possible Cause
1) The WSDL file content isinvalid. 2) The WSDL fileisincomplete.
Solution

1) Check that the WSDL fileis correct. 2) Re-deploy the application using Appeon
Developer.

7.2.4.257 Error 20017

Priority 2
Error Message

Cannot get the Operation definition from the WSDL file. For more help, please consult the
Appeon user document.

Possible Cause
1) The WSDL file content isinvalid. 2) The WSDL fileisincomplete.
Solution

1) Check that the WSDL fileis correct. 2) Re-deploy the application using Appeon
Developer.

7.2.4.258 Error 20018

Priority 2
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Error Message

Cannot get the Part definition from the WSDL file. For more help, please consult the
Appeon user document.

Possible Cause
1) The WSDL file content isinvalid. 2) The WSDL fileisincomplete.
Solution

1) Check that the WSDL fileis correct. 2) Re-deploy the application using Appeon
Developer.

7.2.4.259 Error 20019

Priority 2
Error Message

Cannot get the definition of SoapClient from the WSDL file. For more help, please consult
the Appeon user document.

Possible Cause

SoapToolkit3.0 was not installed.
Solution

Install SoapToolkit3.0.

7.2.4.260 Error 20020

Priority 2

Error Message

Failed to initialize SoapClient. For more help, please consult the Appeon user document.
Possible Cause

1) The specified WSDL file does not exist. 2) The specified WSDL file contains incorrect
values. 3) The network is unstable.

Solution

1) Check that the WSDL file exists and is correct. 2) Check that the WSDL fileis
configured before deployment. 3) Check that the network connection is stable.

7.2.4.261 Error 20021

Priority 2

Error Message

Failed to load DLL file. For more help, please consult the Appeon user document.
Possible Cause

1) The DLL fileswere not deployed when the application was deployed. 2) The DLL file
was not downloaded to the correct location.

Solution
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1) Check that the DLL files are configured for deployment before deploying the application.
2) Manually copy the file to the correct location.

7.2.4.262 Error 20023

Priority 2
Error Message

DataWindow description file does not exist. For more help, please consult the Appeon user
document.

Possible Cause

The Datawindow description file does not exist or the DatawWindow description file was
removed.

Solution

Re-deploy the application and ensure that the DatawWindow description file is correctly
deployed.

7.2.4.263 Error 20024

Priority 2
Error Message

Failed to parse the DataWindow description file. For more help, please consult the Appeon
user document.

Possible Cause

The Datawindow template is not of the correct version or the DatawWindow description file
IS corrupt.

Solution
Check that the Appeon Developer deployment reports no errors.

7.2.4.264 Error 20025

Priority 2

Error Message

Failed to apply data memory. For more help, please consult the Appeon user document.
Possible Cause

There are many running programs which occupy large amount of memory. The memory left
isinsufficient for applying the data memory.

Solution
Close the other programs.

7.2.4.265 Error 20026

Priority 2
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Error Message

Failed to parse SyntaxFromSQL. For more help, please consult the Appeon user document.
Possible Cause

The stored procedure for the corresponding database has not been installed.

Solution

Check that the stored procedure for the corresponding database has been correctly installed
before dynamically creating the DatawWindow. For detailed instructions, refer to Appeon
Server Configuration Guide for .NET or Appeon Server Configuration Guide for J2EE.

7.2.4.266 Error 20027

Priority O

Error Message

Cannot find the image file. For more help, please consult the Appeon user document.
Possible Cause

1) Theimage file was not correctly uploaded to the server. 2) The image file cannot be
found on the specified local directory.

Solution

1) Check that the image file location settings in Appeon Developer are correct and that the
image file exists on the local machine. 2) Redeploy the application using Appeon Developer.

7.2.4.267 Error 20028

Priority 2

Error Message

Print error. For more help, please consult the Appeon user document.

Possible Cause

No printer isinstalled on the local machine or the default printer does not work.
Solution

Check that the printer works correctly.

7.2.4.268 Error 20029

Priority 2
Error Message

Failed to create RichText Datawindow. Incorrect information of RichText control in the
local system. For more help, please consult the Appeon user document.

Possible Cause

The riched20.dll file does not exist in the system32 folder or riched20.dll is not registered.
Solution

Check that the riched20.dll file existsin the system32 folder and has been registered.
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7.2.4.269 Error 20030

Priority 2

Error Message

Cannot parsethe invalid RTF file. For more help, please consult the Appeon user document.
Possible Cause

The format file information in the source code of RichText Datawindow has been manually
modified.

Solution

Re-create the RichText DataWindow. Avoid manually changing the RTF file in the source
code.

7.2.4.270 Error 20031

Priority 2
Error Message

Information of InputField in RichText DataWindow is incomplete. For more help, please
consult the Appeon user document.

Possible Cause

The InputField information in the source code of RichText Datawindow has been manually
modified.

Solution

Re-create the RichText DataWindow. Avoid manually changing the RTF text in the source
code.

7.2.4.271 Error 20032

Priority 2
Error Message

Failed to print RichText DataWWindow. No default printer in the local machine. For more
help, please consult the Appeon user document.

Possible Cause

No printer isinstalled on the local machine or no default printer is set.
Solution

Set aprinter as the default printer on the local machine.

7.2.4.272 Error 20033

Priority 2
Error Message

Print Preview failed. No default printer in the local machine. For more help, please consult
the Appeon user document.
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Possible Cause

No printer isinstalled on the local machine or no default printer is set.
Solution

Set aprinter as the default printer on the local machine.

7.2.4.273 Error 20034

Priority 2
Error Message

InputField information does not match the Datawindow column information. For more help,
please consult the Appeon user document.

Possible Cause

The InputField information in the source code of the RichText DataWindow has been
manually modified.

Solution

Re-create the RichText DataWindow and avoid manually changing the InputField name in
RTF in the source code.

7.2.4.274 Error 20035

Priority 2
Error Message

Settings of InputField location are incorrect. Need to adjust the location. For more help,
please consult the Appeon user document.

Possible Cause

The InputField location in the source code of RichText Datawindow has been manually
modified. Thisisan invalid operation.

Solution

Re-create the RichText DataWindow. Avoid manually changing the element location of
RTF documents in the source code.

7.2.4.275 Error 20037

Priority 2
Error Message

Failed to write to the INI file! Verify that the current user account has access to the
Windows system directory. For more help, please consult the Appeon user document.

Possible Cause
The current user account has no access right to the Windows system directory.
Solution

Use an account with proper rightsto log in to the Windows or ask the administrator to
assign proper rights to the current account.
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7.2.4.276 Error 20038

Priority 2
Error Message

RegMultiString, RegLink and RegBinary datais not supported in server execution mode of
RegistrySet. For more help, please consult the Appeon user document.

Possible Cause

RegMultiString, RegLink and RegBinary datais not supported in server execution mode of
RegistrySet.

Solution
Change the server execution mode to the client mode in AEM.
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8 Technical Support

If your Appeon for PowerBuilder copy isdirectly purchased from Appeon Corporation,
please contact our Technical Support at support@appeon.com for help. Please be prepared to
provide the following files listed in the following table to Appeon Technical Support. This

will aid debugging.

Table 8.1: Filesfor technical support

File Type File Name

Application Server
Configuration File

For EAServer:

<EASERV ER>\Repository\I nstance\com\sybase\dj c\server
\ApplicationServer\{ INSTANCE_NAME} .properties

<EASERVER>\\bin\run_server.bat
<EASERVER>\\bin\djc-setenv.bat
For WebL ogic:
<WL_Domain>\setEnv.sh
<WL_Domain>\startWebL ogic.sh
<WL_Domain>\config.xml

<WL_Domain> indicates the domain path of WebL ogic
server.

For WebSphere:
<WAS HOME>\startServer.sh

<WAS HOME> indicates the home directory of WebSphere
server.

For JEUS:

<JEUS HOME>\bin\jeus.properties.cmd

<JEUS HOME>\jeus.cmd

<JEUS HOM E>\datasources.xml

<JEUS HOME> indicates the installation path of JEUS.
For JBoss:

<JBOSS HOME>\bin\run.bat

<JBOSS HOME>\bin\run.conf

<JBOSS HOME>\bin\service.bat

All XML filesin the <JIBOSS HOME>\server
\<instancename>\conf folder.

<JBOSS HOME> indicates the home path of the JBoss AS.

Application server log file

For EAServer:
<EASERVER>\logs\ {INSTANCE_NAME} .log
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File Type File Name

For WebL ogic:

<WL_Domain>\mydomain.log and all <WL_Domain>
\mydomain.log* files

* indicates the sequence number of the log files.
For WebSphere:

All filesinthe <WAS _HOME>\logs\serverl folder
For JEUS:

All filesin the <JEUS HOME>\logs folder.

For JBoss:

All filesin <IJBOSS HOM E>\server\<instancename>\log
folder.

Appeon Server configuration
file

For Appeon Server installed to EAServer, WebL ogic,
WebSphere, JBoss or JEUS:

All filesin the <appeonserver>\repository\<instancename>
\config folder.

For Appeon Server installed to 11S:
All filesin the <appeonserver>\AEM\config folder.

<appeonserver> indicates the Appeon Server installation
path.

Appeon Server log file

For Appeon Server installed to EAServer, WebLogic,
WebSphere, JBoss or JEUS.

All filesin the <appeonserver>\repository\<instancename>
\log folder.

For Appeon Server installed to |1S:
All filesin the <appeonserver>\AEM\L og folder.

<appeonserver> indicates the Appeon Server installation
path.

Appeon Server Repository
DB

For Appeon Server installed to EAServer:
<appeonserver>\db\A ppeonServer.db

For Appeon Server installed to WebL ogic, WebSphere,
JBossor JEUS:

<appeonserver>\repository\<instancename>\db
\appeondb.script

For Appeon Server installed to 11S:
All filesin the <appeonserver>\AEM\db folder.
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File Type File Name
<appeonserver> indicates the Appeon Server installation
path.

Appeon licensefile Appeon Server installed to EAServer, WebL ogic,

WebSphere, JBoss, and JEUS:
<appeonserver>\license.appeon

For 1IS:

<appeonserver>\AEM\bin\license.appeon

Web Server configuration file| httpd.conf

Web Pagefile Web Server path\application name\window name.htmi

Web Server path\application name\window name.js

Web Server path\application name\all Datawindows on
window.xml

Note: If the window named includes inheritance, then also
supply all ancestors.html and ancestors.jsfiles.

PowerBuilder exported PowerBuilder application path\exported window name.srw
source codefile

PowerBuilder application path\exported Datawindow
names.srd

Note: Exported windows should include exported ancestor
windows and exported ancestor user objects.
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Index

Symbols
"ADT isaready running" error, 19
"Are you sure you want to navigate away
from this page?' warning message, 57
"Automation server could not create object”
error on some clients, 49
"Bad interpreter: No such file or directory”
error, 16
"Cannot find the language resource file
(dblgzh11.dil, dblgenl1l.dil)", 119
"com.sybase.jaguar.util.JException:
[Microsoft][ SQL Server 2000 Driver for
JDBC]Error establishing socket.”, 105
"Component Not Registered” error, 24
"Connection failed:..." error when installing
EAServer in a64-bit OS, 119
"Could not Initialize JavavM!", 56
"Create appeon component failed" error, 122
"Create Session failed", 46
"DLL function call crashed" error when
launching an Appeon setup program, 1
"EonToolset60 Load resource failed”, 59
"Error converting data type A to B", 66
"Error launching LoadConfig", 21, 29
"Error loading ADTODbjectList.xml", 21
"Error loading command string”, 21, 31
"Error occurred while creating an object
instance" on the status box, 57
"Error opening DLL Library adtxml.dll for
external function" Error, 23
"Error: Failure in adding an application to
[Server Name]", 32
"Error: Failure in exporting XML file", 28
"Error: Unable to upload INI file", 33
"Exception at: CString CparseEngine...", 30
"Fail to analyze application" and "Fail to
analyze Menu Object A in the B application”
Errors, 31
"Failed to get Datawindow syntax from
Appeon Server", 56
"Failed to get resource from Appeon Server"
error, 39
"Failed to invoke remote procedure” error, 48
"Failed to load the remote interface” error, 89
"Failed to transfer command”, 30

"Java.sgl.SQL Exception:[Microsoft][ODBC
SQL Server Driver]Connection is busy with
results for another hstmt " Error when using
the Microsoft SQL Server database, 106
"License error: 10999 ..." when starting
Appeon Server in 64-bit OS, 117

"Load application failed", 48

"Object doesn't support this property or
method" Error, 49

"ORA-01461" error in AEM when test a data
source, 106

"oracle 9i failed: System.Data.OracleClient
requires Oracle client software version 8.1.7
or greater, 107

"Predefined error_message pfc_dwdberror”,
57

"Remote connection failed:
java.io.lOException: Message data for non-
existent channel", 87

"Script Debugger Component Not Found"
error, 24

"Script Debugger Disabled" error, 24
"Stack overflow error”, 56

"Table already exists" error, 91

"Table or view not found" error, 90

"The XML page cannot be displayed" when
opening a UFA report, 21

"This application has requested the Runtime
to terminate it in an unusual way" error,
when you deploy or analyze an application,
23

"Unable to cast object of type 'System.String'
to type 'System.Byte[]™, 33

"Unable to validate current licensefile.
Please reinstall Appeon Server", 41

A
AEM cannot access WebSphere data sources
when global security ison, 87
AEM cannot interface with a particul ar
Appeon Server, 89
AEM Web page cannot display or cannot
display correctly inIE 9, 72
An item which usually requires one click
must be clicked twice to be selected, 71
Appeon Debugger, 23
Appeon Developer Configuration, 21
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Appeon Developer toolbar does not respond
when run by a non-administrator, 19
Appeon File Server Installation Incomplete,
16

Appeon Performance Analyzer continually
popping up, 67

Appeon Server, 83

Appeon Server Cluster, 111

Appeon Server is dead when dynamically
creating a Datawindow, 88

Appeon Server responds to user requests
slowly, 89

Appeondb is not started when EA Server
starts, 92

ASA/SQL Anywhere engine crashes when
you insert datainto AppeonDB, 70

ASE Chained mode issue, 68

B
Blob data cannot be correctly manipulated if
it over 4AMB, 65

C
Cannot log into AEM in IE 10, 72
Cannot start EAServer Manager, 120
Cannot update Transaction Objects for
WebL ogic servers, 53
Corrupt Chinese characters are displayed in a
Datawindow, 50

D
Data missing in some DataWindows, 63
Data operation, 60
Datarange issue with n-Tier NVOs, 116
Database lock, 62
DatawWindows do not respond, 63
Demo Web application failsto call EJB
component, 58
Demo Web applications do not load in
Internet Explorer, 43
Deployment Performance, 25
Display errors, 50
Distributed DataWindows are not displayed,
50
DropDownDataWindow value incorrectly
selected, 57
DropDownListBox does not display
completely, 51

E
EAServer 6.x startup error, 108
EAServer cannot be started after Appeon
Server install, 15
EA Server cannot start with the prompt that
"the system ‘admin' password has not yet
been set”, 121
EAServer issues, 116
Empty/Null value update error if SQL
Anywhere/ASE, 90
Enable 32-bit .NET framework on 64-bit
Windows, 12
Error "500 Servlet jspserviet: ...", 82
Error "Connect EAServer failed" when
loading Appeon demo applications, 45
Error "Could not read object”, 31
Error "Create instance failed" when loading
n-Tier NVO Web applications, 45
Error 00001-09999, 126
Error 10001-15055, 128
Error 10999 - Failed to start new
transaction..., 83
Error 10999 - Keyword not supported: ‘dsn’,
53
Error 1155, 1
Error 14004 "The licensefileismissing"”, 17
Error 1607 or 1628, 1
Error 20001-20035, 134
Error 404 - File or directory not found, 54
Error converting data type varchar to
datetime, 106
Error Message Formats, 125
Error Message Numbers and Descriptions,
125
Error Message Priority, 125
Error occurs when running Distributed
DataWindow in Appeon Code Examples
Demo, 58
Errors occur when calling n-Tier application
of EAServer with 64-bit JDK, 119
Exiting Appeon Developer completely after
an error, 20
Extra space or padding between MDI client
area and toolbar, 52

F
Fail tolog into AEM with the default user
name and password, 82
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Fail to parse the result meta of the Select
statement, 65

Fail to ping appeondb data source, 92

Fail to ping appeonsample data source, 98
Fail to ping data sources for SQL Server
2000, 105

Fail to pre-compile AEM, 82

Fail to start Appeon Server on JEUS, 109
Fail to update data, 65

Fail to update DataWindows with newly
entered Korean characters, 66

Fail to update dynamically generated
Datawindow, 65

Failed to create new data sources, 123
Failed to deploy applications, 25

Failed to deploy applicationsin server
console, 26

Failed to deploy Web applications in 64-bit
JEUS server, 27

Failed to initialize Appeon Weblibrary
Component, 43

Failed to install the Download Center plug-
in, 41

Failed to manually download Appeon
ActiveX, 42

Failure in Incremental Deployment, 29
Feature Analysis, 21

Feature Analysis and deployment freezes, 31
Feature analysis or deployment comesto a
standstill, 23

Frequently Asked Questions, 17

Full accessrightsto I1S Web root, 10

H
How much better is the performance when
multiple instances are used?, 18
How to bind server instance to CPU?, 17
How to create EAServer instances?, 17
How to install Appeon Server to multiple
EAServer instances?, 17
How to locate problematic objectsin an
application, 27
How to solve the messy code issue when
retrieving datain Oracle, 67
How to start the server instance?, 18
Http 404 not found error occurs when using
WebSphere as the Application Server, 54

I
|E 7 reports "Internet Explorer cannot open
the Internet site. Operation aborted.” Error,
39
| E 8 crashes under Windows XP, 38
|E browser failsto open Web applications,
44
|E shows "done" status and then stays blank,
34
11S6.0, 3, 14
[1IS7.00r 7.5, 2,12
[1S configuration, 2
Install Appeon File Server, 16
Install Appeon Server to .NET IIS, 2
Install Appeon Server to EAServer, 15
Install Appeon Server Web Component, 16
InstallShield Errors, 1

J
JBoss console hangs during startup process,
87
JBoss console reports #...Stopped
deployment appeonserver.jar...# error, 86
JDBC/ODBC TDS data type discrepancy on
SQL Anywhere, 90

L
Launch Web applications, 34
Loading AEM, 72
L oading application is slow when Appeon
Cluster worksin virtual machines, 111

M
Manipulation on BLOB filesfor Adaptive
Server Enterprise (ASE), 64
Manipulation on BLOB filesfor ASE and
SQL Anywhere, 64
Manipulation on BLOB files for SQL
Anywhere, 64
MDI windows do not display in full, 51

N
Nested reports over 50 rows do not display,
51
Nested reports over five pages do not
display, 51, 116

O
Object reference not set to an instance of an
object, 80
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Others, 67

P
Pinging data source fails when using the
ASA/SQL Anywhere JDBC driver, 122
PowerBuilder issues, 116
Procedure "appeon_procdataobjects’ not
found, 107

R
Receiving "Server busy" error, 57
Retrieved data does not display in
Datawindows, 60
Retrieving datais slow when Appeon Cluster
works in virtual machines, 112
Runtime issues, 53

S
Security settingsin AEM do not take effect,
83
SelectBlob and UpdateBlob have different
results for non-binary fields, 66
Server Error in'/Servlet' Application, 72
Server NV O cannot be activated when the
Web application is running, 70
Source Code Export process aborts with a
fatal error, 27
Special charactersin URL cause missing
parameters when being redirected, 71
Starting EAServer fails, 121
Status Monitor exits after restarting Appeon
Server for WebLogic in Linux, 110
Support for non-JDBC drivers, 123

T
Task 1: Application Source Code Export, 27
Task 2: Application File Generation, 29
Task 3: Application Deployment, 32

Testing connection fails during DB Type
Profile configuration, 21

Text displaysin large size and is cut off, 53
Text does not display or text is grayed out,
51

The AEM Web page cannot be displayed, 82
The data source test will fail if the Shared
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